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   About This Guide

This guide describes how to install and use the client components of 
OnePoint Messenger™, a multimedia messaging application from 
Baypoint Innovations that consolidates voice mail, fax, e-mail, and 
compound messages in one Microsoft Exchange™ mailbox.  You can 
access this mailbox from a telephone or a PC running Windows 95™, 
Windows 98™, or Windows NT™.  On a PC, you can use a compati-
ble version of Microsoft Outlook™ or a compatible Web browser 
(see Chapter 2, page 43).

How to Use This Guide

This manual is written for the end user.  It also contains instructions 
that will be useful to the installer of the client components of 
OnePoint Messenger.

If you are an end user, see Chapter 1 (page 19) for an overview of the 
features that are explained in each chapter.  See also the “Where to Go 
from Here” heading that appears below (and at the end of every chap-
ter) for chapter summaries.  In Acrobat, blue text, such as in the chap-
ter contents list above, indicates hyperlinks that you can click to jump 
to the referenced spot.

NOTE: OnePoint Messenger has many optional features, such as 
text-to-speech, paging notification of unified messages, and Web 
access to your mailbox.  Ask your system administrator what features 
are enabled for you.

Section Page

How to Use This Guide 15

Conventions Used in This Guide 16

Other Documentation 16

Where to Go from Here 18
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If you are the installer, you can use the instructions in Chapter 2 
(page 43) to install OnePoint Messenger on each user’s PC.  Also, see 
the OnePoint Messenger Installation Guide.

If you are the administrator, you can use this guide as a resource to 
answer users’ questions about OnePoint Messenger.  It is not intended 
as a substitute for Microsoft Outlook and Web browser documenta-
tion or for the OnePoint Messenger Administrator Guide.

Conventions Used in This Guide

The word “press” is used with keyboard commands, and the key 
names are shown in brackets, with initial capitals, such as “Press 
[Enter].”

Menu names, menu commands, and button names are shown in bold.  
For example, “From the File menu, choose Save.”

The word “select” is used to identify options in a dialog box.  Gener-
ally, you would click something in the dialog, such as an item in a list 
or a radio button, but you usually can select the item by navigating to 
it with keys—usually the Tab key.

Italic type indicates titles of publications and variables.

Typeface in Commands

For statements in command syntax format, small monospace 
type like this indicates the characters you should type, and italic 
type designates the variables that you are to replace with other infor-
mation.  For example, in the following command, you type the word 
“install” but replace “drive” and “directory” with the names of the 
drive and directory you’re using:

\\(drive)\(directory)\install

Other Documentation

The OnePoint Messenger documentation set includes:

• This OnePoint Messenger User Guide

• OnePoint Messenger Quick Reference Card for the telephone

• Online help and training cards; see the next section.

• Documentation for installers and administrators
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Getting Online Help

OnePoint Messenger has online help for each of its three mail clients:

• The “desktop” OnePoint Messenger (Outlook and Unified Fax 
Printer) help is described in “Getting Online Help” on page 62 in 
Chapter 3.  See also “Using Windows WinHelp for Online Help” 
on page 212 in Appendix B.

• The Web Client interface, described in Chapter 4 (page 103), pro-
vides links to two sets of HTML-based online help, one for 
Microsoft’s Outlook Web Access, and one for the OnePoint Mes-
senger Web Client additions that provide unified messaging.

• The OnePoint Messenger Telephone User Interface (TUI) pro-
vides some help; press [00] in each TUI menu.  Details on using 
the TUI are contained in Chapter 7 (page 165).

To open a set of “training cards”, online help for the most com-
mon tasks using OnePoint Messenger on Outlook:

Click the Windows Start button, then choose Programs, then 
OnePoint Messenger, then Help.

Note that the last item in the training card list is a link to the full 
online help for OnePoint Messenger on Outlook.

Contacting Mitel Technical Publications

The Mitel Technical Publications and Media Development Group 
maintains this document.  We welcome your questions and sugges-
tions—notes on spelling and grammatical errors, comments on read-
ability, and suggestions for improvements.  Please reference the 
document number that appears on the back of the cover page. Send 
your comments to:

techpubs@mitel.com
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Where to Go from Here

NOTE: This heading appears at the end of each chapter to give you a 
preview of the remaining chapters.

• For a general overview and definitions of terms used in the  
OnePoint Messenger product suite, see Chapter 1, “What 
OnePoint Messenger Can Do for You” on page 19.

• To install OnePoint Messenger on your PC, see Chapter 2, 
“Installing OnePoint Messenger Client Components” on page 43.

• To use OnePoint Messenger to send and receive voice messages 
and other mail through Outlook, see Chapter 3, “Using OnePoint 
Messenger with Outlook” on page 61.

• To use OnePoint Messenger on the World Wide Web with             
Internet Explorer™ and Netscape™ to receive and send voice 
messages, see Chapter 4, “Web Access to Exchange” on 
page 103.

• To use OnePoint Messenger to view, annotate, create, and send 
faxes via telephone or e-mail, see Chapter 5, “Using OnePoint 
Messenger Fax Features” on page 125.

• To use your PC to configure or modify the telephone user 
interface, such as recording your name and greeting announced 
on the telephone, see Chapter 6, “Setting Preferences” on 
page 153.

• To learn how to use the Telephone User Interface (TUI), see 
Chapter 7, “Using OnePoint Messenger from a Telephone” on 
page 165.

• To learn how to test your multimedia controls, see Appendix A, 
“Tuning Your Multimedia Setup” on page 205.

• To learn about standard Windows controls, which are used with 
Outlook, see Appendix B, “Standard Windows Controls” on 
page 209.

• To find a desired topic, see the Table of Contents or the index of 
this book.
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1.   What OnePoint Messenger Can 
Do for You

This chapter introduces you to OnePoint Messenger and explains the 
program’s terms and concepts.  It contains the following sections:  

What Is OnePoint Messenger and Unified Messaging?

OnePoint Messenger is a suite of client and server software compo-
nents that brings unified messaging to your telephone and PC.   Uni-
fied messaging is the combination of voice mail, fax, and e-mail in a 
single Inbox with a single point of user administration, thus the name 
“OnePoint Messenger”.  However, although you have a single Inbox, 
you have multiple ways to access it.  See “OnePoint Messenger Mes-
saging Interfaces” on page 23.

In OnePoint Messenger, a unified message is any message that you 
create with OnePoint Messenger tools, either with the New Unified 
Message form that OnePoint Messenger adds to Outlook or a tele-
phone message, including fax, stored by OnePoint Messenger on 
Exchange.  Even if you use the New Unified Message form simply to 
create a text e-mail message, we consider it a unified message.  This 
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distinction is important for several reasons.  It affects what messages 
are available to some OnePoint Messenger users over the telephone 
or through their pagers.  Unified messages have special icons that 
provide utility such as more sorting options and message component 
access through QuickPick and QuickPlay, features added to Outlook 
by OnePoint Messenger.

What’s New in OnePoint Messenger 2.0

New features in this release include:

• Support for the “.wav” sound file format for voice messages, 
while continuing to support the “.cvv” format for existing voice 
messages. See Chapter 3 (page 61).

• Calling Line Information (CLI), which is the name or phone num-
ber of the caller.  It appears in the Subject field of a message 
when sent from a telephone.  When leaving a telephone message 
for a OnePoint Messenger user, you can also change the number 
that appears. See Chapter 7 (page 165).

• Fax Gateway, which enables you to send a fax or text message 
directly to a fax machine from Outlook. 

• Latin American Spanish telephone user interface (TUI) prompts 
can be installed on the Telephony Server, in addition to British 
and American English, to allow you to have a choice of TUI lan-
guages separately at the system level and within your mailbox.

• Message delivery fault tolerance—When the Microsoft Exchange 
goes offline, OnePoint Messenger continues to take and store 
telephone messages.  When Exchange comes up, the messages 
are delivered, providing an extra degree of “guaranteed delivery”. 
See “Post Office Resiliency” on page 28.

NOTE: This feature is not yet operational.

• Multiple greetings, which you can record and set for various con-
ditions both from the telephone and from Outlook. See 
Chapters 6 (page 153) and 7 (page 165).

• Outlook 2000 support, in addition to Outlook 98 (Outlook 97 is 
not supported)

• QuickFax, which enables you to create and send a fax directly to 
a fax machine from any application along with the option to cre-
ate a personal cover page or use a system fax cover page. See 
Chapter 5 (page 125).
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• QuickPlay, which adds enhanced voice message playing options 
directly from the Outlook Inbox list, including support for Call-
Me/Meet-Me. See Chapter 3 (page 61).

• Voice Profile for Internet Mail (VPIM) support, which enables 
you to receive voice messages in your Inbox from other voice 
mail systems.  With a separate site feature license, you can also 
send VPIM messages. See “Using Voice Profile for Internet Mail 
(VPIM)” on page 28.  You can send the same message to a VPIM 
address, standard e-mail address, and a fax machine.

• You can now change you telephone passcode from Outlook with-
out having to remember your current passcode. See Chapter 6 
(page 153).

OnePoint Messenger Highlights

With OnePoint Messenger, you can:

• Access both your e-mail and voice mail from any phone or PC.

• From any telephone, you can call your mailbox and listen to your 
e-mail converted to speech for you by the Text-to-Speech feature.

• From any telephone , you can reply to and forward e-mail, voice 
mail, and faxes, including messages sent from another voice mail 
system.

• Create and send compound multimedia messages on your PC 
desktop or telephone.  Unified messages may include graphic or 
text components and voice, fax, and other types of attachments.

• Send and receive messages through the Internet to other Internet-
enabled (“VPIM-compliant”) voice mail systems.

• Perform advanced fax creation, viewing, and management. Anno-
tate faxes on your desktop and forward them directly to a fax 
machine or to any e-mail account or VPIM-compliant voice mail 
system.  The Text-to-fax feature means you can convert any doc-
ument to a fax, and also download text email to a fax machine.

• Add phone messages to advanced Outlook file management, 
including integration with My Computer, Web “Favorites,” per-
sonal folders, and public folders on Exchange.

• Record telephone greetings for various conditions, ranging from a 
busy-phone greeting to an extended out-of-office greeting, from 
either your PC or telephone.
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Using OnePoint Messenger Creatively

OnePoint Messenger users with cellphones and long commutes 
appreciate telephone features such as Text-to-Speech, forwarding 
messages to fax machines, sending voice messages to distribution 
lists, and getting paged when urgent message arrive.  

Desk-bound users appreciate the OnePoint Messenger “Quick” fea-
tures in Outlook—QuickPick, QuickPlay, and QuickFax—and the 
ability to manage telephone messages as e-mail, such as forwarding 
or replying to telephone messages as e-mail.

The combination of telephone and e-mail in one interface with a 
graphical user interfaces enables synergies, such as sorting all mes-
sages by sender or storing related messages in one subfolder.

Typically, old telephone messages stack up because, to remember 
what an old message contains, you must listen to each message in 
sequence.  OnePoint Messenger essentially turns those messages into 
e-mail with voice attachments, so, not only can you point and click to 
access any message, you can make comments on the Subject field to 
remind you of the subject matter or sender, set importance or 
reminder flags, and add text or voice comments on the body of the 
message.  Also, OnePoint Messenger adds the QuickPlay button to 
the Outlook Inbox (see page 74), so you can scan voice messages by 
jumping from one to any other one. 

QuickPick (see page 24) is another time-saving feature that is espe-
cially useful for accessing particular components in a message that 
contains multiple attachments or a sequence of replies.

If you are travelling, you can download all your messages onto your 
laptop before you leave.  While travelling, you can access your Inbox 
by using either Web Client (see page 103 in Chapter 4) or a Meet-Me 
connection (see page 82 in Chapter 3).  You can use any PC with 
Internet access.  You can route text messages or faxes from your 
Inbox to any fax machine, so you don’t need a printer.

OnePoint Messenger’s fax functionality also provides a number of 
incidental benefits.  A fax machine becomes a scanner to import doc-
uments into your Inbox.  In the other direction, you can create review 
documents from any application by turning the document into a fax 
image and sending it either as a fax or as e-mail.



OnePoint Messenger Messaging Interfaces 23

OnePoint Messenger Messaging Interfaces

OnePoint Messenger provides automated telephone answering and 
messaging, and it interfaces with the Microsoft Exchange e-mail 
server to give you access to all your messages from your computer or 
any telephone.  It also provides several ways for you to send faxes. 
OnePoint Messenger provides three ways for you to access your 
Inbox:

Telephone: You can access your mailbox from any telephone to 
retrieve and send voice and fax messages and text e-mail.  You can 
reply to or forward incoming messages, route messages to a fax 
machine, and create new messages. See Chapter 7 (page 103) for 
details on the Telephone User Interface (TUI).

Outlook: OnePoint Messenger adds your telephone messages to your 
Outlook e-mail and enables you to more easily create messages with 
voice and fax content.  See Chapter 3 (page 61) for details on using 
OnePoint Messenger with Outlook.

Desktop Fax: You can choose the Unified Fax Printer from any 
application that has a print menu.  The Unified Fax Printer dialog has 
several options for creating faxes, now including QuickFax for send-
ing a fax directly to a fax machine. See Chapter 5 (page 125) for 
details on faxing.

Web: The Web interface to your mailbox provides you access to both 
your e-mail and telephone messages from any computer connected to 
the Internet or your LAN.  The Web client provides most of the same 
functionality as Outlook and simulates the Outlook interface for easy 
use.  The main difference is that the Unified Fax Printer does not 
automatically create fax attachments in the Web client. See Chapter 4 
(page 103) for details on using Web Client.

To access and create unified messages from either a Web browser or 
Microsoft Outlook™, see “What You Need on Your PC” on page 44 
in Chapter 2).  Compatible Web browsers are Internet Explorer 
4.0™+ or Netscape 4.0™+ (see page 44) on any Windows 95 (or 
higher) PC connected to the network or the Internet.
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What You Can Do with OnePoint Messenger on a PC

The OnePoint Messenger features that you can access on your PC 
depend on what features your organization has set up for you on the 
Exchange and Telephony Servers.

At the most basic level, your Inbox may have no unified messaging 
privileges.  However, OnePoint Messenger users can send anyone a 
unified message, and people who do not have OnePoint Messenger 
installed can still play the fax and voice content using the standard 
image viewer and sound player that are bundled with Windows.

The next level of OnePoint Messenger privileges is access to your 
Inbox through the telephone.  Those features are described in the next 
section.

With the Full Unified Messaging license, you can install OnePoint 
Messenger on your PC.  When you install OnePoint Messenger on 
your PC, you can choose whether to install the Outlook client, the 
Unified Fax Printer, or both.  If your organization has purchased the 
Web site license, you can access your mailbox with a Web browser 
from any PC with access to your Exchange Server, either via the LAN 
or via the Internet.

Within Outlook, the Call-Me feature, while standard, has levels of 
availability set by your Telephony Server and Exchange administra-
tors.  Otherwise, all features described in Chapters 3 through 6 are 
available.  The basic features that OnePoint Messenger adds to Out-
look include the ability to receive messages as unified messages both 
other OnePoint Messenger users and from telephone callers.  You can 
play unified messages using a Unified Message Read form, Quick-
Pick, QuickPlay, Call-Me, and Meet-Me. These features are detailed 
in Chapter 3. In summary, they are:

Call-Me and Meet-Me—These are two ways to use a phone as a lis-
tening and recording device while you are using Outlook (see below).

QuickFax—This is a new option in the Unified Fax Printer dialog 
that enables you to send a document as a fax directly to a fax 
machine. You can use the system fax cover page or create one 
through an included cover page creation dialog.

QuickPick—This opens a window in Outlook to display the compo-
nents of a selected unified message. It represents each of the compo-
nent parts (attachments, text, embedded images) in each message in 
the reply sequence, providing direct access to any component.
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QuickPlay—This enables you to play voice messages from the Inbox 
list without opening them (See below.)

Unified Fax Printer—Unified Fax Printer uses the print menu of any 
Windows application to create a multi-page TIFF fax image of the 
active document. Unified Fax Printer can spawn a New Unified Mes-
sage form in Outlook to which it attaches the fax image or send the 
fax directly to a fax machine (see QuickFax.) 

The Unified Messaging tab—This is a tab in the Options dialog of 
Outlook that contains your preference settings for opening messages, 
setting your telephone passcode, spoken name, and greetings.

Web Client—If your organization has set up Web access to e-mail, 
you can access your mailbox on your Exchange Server from any PC 
that can connect to it from the LAN or Internet. You do not need to 
install anything prior to making the connection. For details, see Chap-
ter 4 (page 103).

Playing and Viewing E-mail, Fax, and Voice Messages

When you double-click a header, the message form opens.  If there is 
an attachment, it appears as an icon in the message form. Double-
click the icon to start the associated viewer/player.  You can listen to 
voice messages using either speakers or headphones attached to a 
sound card installed in your PC. 

Call-Me/Meet-Me

Call-Me and Meet-Me are two related features that OnePoint Messen-
ger adds to Outlook.  They are alternative ways of setting up a con-
nection between your computer and your telephone so that you can 
use your telephone with Outlook as a substitute for a microphone and 
speakers.  In both Call-Me and Meet-Me, once you set up the connec-
tion, you control what message plays or the progress of a recording 
session by using your computer controls in Outlook.  Your telephone 
simply replaces the speakers and microphone.  The difference 
between Call-Me and Meet-Me is how the telephone-computer con-
nection is established:

• Call-Me: Initiate the connection from Outlook by signalling 
Telephony Server to call your telephone.  Your telephone rings. 
When you answer, the message appears on-screen indicating a 
successful connection. 

• Meet-Me: Initiate the telephone connection from Outlook by sig-
nalling Telephony Server to expect a call to your mailbox from 
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you, then dial the Message Center from your telephone.  The 
resulting interface is the same as for Call-Me. 

Details on choosing and using a player and recorder are in “Choosing 
between Telephone and Desktop Audio” on page 76 and  “Choosing 
between Call-Me and Meet-Me” on page 78 in Chapter 3.

Sending, Viewing, and Annotating Faxes

OnePoint Messenger displays incoming faxes in Outlook and your 
Web mailbox interface. Opening a fax invokes your default TIFF 
viewer, usually Imaging for Windows, an application that is bundled 
with Windows.  This program shows the fax image and allows you to 
magnify it, change its orientation, annotate it, and print it on a printer.

OnePoint Messenger now provides two ways to create a fax. With the 
first, you can create a fax from any document and attach it automati-
cally to an e-mail message.  The new alternative enables you to create 
a fax from any document, attach a cover page to it, and send it as a 
traditional fax (with no other added text or attachments) to any recipi-
ent including voice mailboxes and fax machines.  See Chapter 5 
(page 125) for details on creating, viewing, annotating, and printing 
faxes.

Managing Your Mail

Use the main screen of your Inbox to view a combined list of your 
telephone and e-mail messages.  You can sort, file, display, delete, 
forward, reply to, and otherwise manage your unified messages in the 
same ways that you can manage standard e-mail.  You can open a 
New Unified Message form from any folder.  For details on using the 
Inbox, see Chapter 3 (page 61).

Using the standard functionality of Outlook, you can also manage 
your voice mail better than with any voice mail system. For example:

• You can create subfolders in your Inbox for people, projects, and 
content types.  For example, you might create a folder for a par-
ticular person, to which you move all messages (including voice 
messages) to and from that person, then add notes about conver-
sations.  That same folder can hold relevant faxes, e-mails, and 
documents (which you can attach to draft messages so that you 
can consolidate them in that folder).  You might also create a 
folder for a particular project, to which you can add copies of rel-
evant messages from the other folder.
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• Use the Outlook Inbox Assistant to filter messages by sender, 
type, or priority.  You can even create a virtual message waiting 
alert list for voice messages.  See “Creating a Telephone Message 
Alert” on page 161 in Chapter 6, or see your Outlook documenta-
tion.  For example, rather than hear from your voice mail system 
only that you have “17 saved messages”, you might create a High 
Priority folder in Outlook, to which you have the Inbox Assistant 
automatically copy all e-mail and voice messages from your boss.

• Also using the Inbox Assistant, you can create automatic replies 
as out-of-office alerts.  See “Using the Out of Office Assistant to 
Alert Contacts” on page 160 in Chapter 6, or see your Outlook 
documentation.

Recording Greetings and Spoken Name

You can use a microphone attached to your PC or use a telephone to  
review and update your telephone greetings and spoken name.  Greet-
ings are played to callers when they are forwarded to your mailbox 
when you do not answer your telephone.  Your spoken name is played 
in several situations, most commonly when another OnePoint Mes-
senger user uses a telephone to access his or her mailbox and then 
address a message to you.

For details on recording your greeting or name using your PC, see 
Chapter 6 (page 153).  For details on recording using a telephone, see 
Chapter 7 (page 165).

NOTE: Call-Me/Meet/Me is not available for recording name and 
greeting.

What You Can Do with OnePoint Messenger on a 
Telephone

Depending on the features invoked for you, OnePoint Messenger 
functionality is very similar using either a PC or a telephone.  Using 
any standard touchtone telephone, you can:

• Access voice, fax, and text e-mail messages.  You can specify 
which parts of the messages you want to hear and in which order.  
You can set whether text from e-mail messages is spoken to you.

• Forward faxes and e-mail in your mailbox to any fax machine.  
You can set a particular default fax machine telephone number, 
or have the fax sent to the number from which you are calling, or 
enter another number.
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• Answer or forward messages, including e-mail, voice, and fax 
messages.

• Send new voice and fax messages to one or many people at once, 
including to system distribution lists.  For details on accessing 
distribution lists, see “Sending Messages to Distribution Lists” in 
Chapter 7.

• Change your passcode, default fax delivery number, and pager 
number.

• Record telephone greetings and your name.

Post Office Resiliency

OnePoint Messenger 2.0 has a feature called Post Office Resiliency 
that provides an extra degree of fault tolerance for telephone mes-
sages.  If callers attempt to leave a message for you when Microsoft 
Exchange is not working, the OnePoint Messenger Telephony Server 
will store the message until your Inbox is available on Exchange.  
This helps to ensure both that the caller has the ability to leave the 
message and that you receive it.

Exchange must come back online for you to receive the message from 
any client.  To access the message from a telephone, both the 
Exchange Server and Telephony Server must be operational and com-
municating.  The time stamp for the message will be the time that it 
reached your Inbox.

NOTE: This feature is not yet fully operational.

Using Voice Profile for Internet Mail (VPIM)

OnePoint Messenger now provides the ability to exchange messages 
with users of voicemail systems that support the Voice Profile for 
Internet Mail (VPIM) RFC 2421 standard.  The VPIM standard 
allows compliant telephone voice mail systems to exchange messages 
over the Internet.  OnePoint Messenger complies with the standard 
with one exception: it does not support sensitivity attributes (Confi-
dential/Not Confidential) sent by other voicemail systems.

Message attributes required by the VPIM standard that OnePoint 
Messenger supports include sender name, VPIM address, importance 
(OnePoint Messenger uses Urgent/Not Urgent), return receipts, non-
delivery notices for components or recipients, and recipient name and 
address. If the message is generated from an e-mail client, a subject 
line is also available.
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Communicating with Users of Other Voice Mail 
Systems

If your recipient uses a voice mail system that conforms to the VPIM 
standard, you can address messages to that system by using a special 
“VPIM” addressing format. On the PC, using Outlook or Web Client, 
you have three ways to enter the address:

• Enter the complete address as defined by your recipient’s mail 
server.  The VPIM address is in this form:

[VPIM:<user address>@<Internet domain name>]

Typically, the part occupied by “<user address>” is the user’s 
mailbox number, which is usually the user’s telephone extension.

• You can have the person send you a message, so that you can 
reply to it and capture it to your Contacts list.  Record the address 
in the form shown above.  For example, if the address is 
1234@myco.com, enter it as:

[VPIM:1234@myco.com]

If you already have an entry for your recipient’s e-mail address, 
you might add the full VPIM address as an alternate e-mail 
address or you might create a separate contact with a name that 
better identifies the address as a VPIM address.  When you 
address a VPIM message to your recipient, enter his or her alias, 
click Check Names, then choose the VPIM address from the list 
of alternatives when the list appears.

• Your Exchange administrator can create Custom Recipient 
accounts, which make the addresses of users of other mail sys-
tems available to all of your Exchange users from the system 
address book.  If your VPIM recipient is someone who would 
receive messages via VPIM from other members of your organi-
zation, ask your Exchange administrator to enter the VPIM 
address in a Custom Recipient account for that person.

Because many voice mail systems only accept voice and fax mes-
sages, it can be helpful for the Exchange administrator to indicate 
that the Custom Recipient mailbox has that limitation by adding 
something like “voice only” to the Custom Recipient name.  You 
would see that note in the address list and know not to send text 
or non-voice/fax attachments to that address.

To address a message to a VPIM recipient from a telephone, you have 
the second two options listed above.  You can reply to a message 
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from the VPIM user or access the Custom Recipient address through 
the Dial by Name (DBN) feature (see “Dial by Name” on page 168 in 
Chapter 7).  As above, if your Exchange administrator appends 
“voice only” to the Custom Recipient name, you would enter enough 
of the user’s last name for OnePoint Messenger to identify a short list 
of possible recipients, and you would then be able to recognize the 
VPIM account because the TUI would speak the VPIM user’s name 
followed by “voice only” (or “VPIM” or whatever the Exchange 
administrator appends to the user name).

Communicating with Remote OnePoint Messenger 
Users

When the Microsoft Exchange administrator sets up an Exchange Site 
Connector connection with other Exchange Servers, the connector 
copies those remote addresses to your system directory.  If OnePoint 
Messenger is installed on that remote Exchange Server, unified mes-
sages that you send to those users will be handled as unified messages 
by that remote Exchange Server.  When one of those remote users 
sends a new unified message to you or in reply to your message, your 
client applications will treat the message as a unified message, giving 
you the extra OnePoint Messenger controls.

With VPIM, you now have another way to address messages.  When 
a remote Exchange Server is not connected to your Exchange Server 
with a Site Connector, using a VPIM address to send a unified mes-
sage to another OnePoint Messenger user at that site is the best way to 
address the message.  The problem with using a standard e-mail 
address is that some unified message coding is lost in transmission so 
some functionality with that message is lost to the recipient (and to 
you if your recipient replies).  The VPIM protocol preserves the uni-
fied message coding.

Distribution Lists

You can address messages to system distribution lists that consist of 
combinations of addressee types.  Some recipients can be OnePoint 
Messenger users at the local Exchange Site, OnePoint Messenger 
users at remote Exchange Sites, and recipients at other e-mail and 
VPIM-compliant voice mail systems.  The only problem will be the 
inability of some VPIM voice mail systems to receive some attach-
ments.  You will receive a non-delivery notice for those undelivered 
components.  To counter that possibility, it is best for the Exchange 
administrator to separate the VPIM addresses into a separate distribu-
tion list.
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How OnePoint Messenger Works

On your Windows PC, OnePoint Messenger adds telephone controls 
to Microsoft Outlook.  OnePoint Messenger provides a Web Client, 
so that you can use the Internet to access your mailbox on the 
Exchange Server.  The Web Client automatically downloads to your 
PC when you log in to Exchange through a Web browser.  See Chap-
ter 4 for details.

OnePoint Messenger is part of the communications system shown in 
Figure 1-1 below.  The OnePoint Messenger server software runs on 
two Windows NT Server 4.0 computers.  One is the Telephony 
Server, which has telephony linecards that connect to the telephone 
network, typically through a PBX, as shown below.  The Telephony 
Server connects to the OnePoint Messenger-enhanced Microsoft 
Exchange mail server through your local area network (LAN). 

Figure 1-1  OnePoint Messenger Unified Messaging Network.

When you access OnePoint Messenger through a telephone, the call 
goes through the PBX to the Telephony Server, which connects you 
to OnePoint Messenger mailboxes—yours and others’—on the 
Microsoft Exchange Server.

If someone calls you and you do not answer, the call is routed by your 
PBX to the Telephony Server, which plays your greeting, then 
records and sends the caller’s message to your mailbox on Exchange. 
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When you use Outlook on your office PC to access your mailbox on 
Exchange, all of the traffic between your computer and Exchange are 
through your office network.  For example, when you make changes 
to your telephone greeting using your PC, that greeting goes over the 
network to Exchange.  It then is copied to the Telephony Server, 
which keeps a cache of such user information so that there are few 
data transfers between servers to delay the messaging session.

Using OnePoint Messenger on Windows with Outlook

OnePoint Messenger clients run only on Windows 95, Windows 98, 
or Windows NT.  See “OnePoint Messenger Installation Require-
ments” on page 43 in Chapter 2 for details on hardware and software 
prerequisites and setup.

Chapter 3 (page 61) covers the use of OnePoint Messenger on Out-
look, providing general information on the Outlook Inbox.  Online 
help for OnePoint Messenger is available from the Outlook Help 
menu under OnePoint Messenger Help.  Training cards are in the 
OnePoint Messenger program group.

For ease of use, OnePoint Messenger uses the full graphical 
functionality of Windows and the conventional controls, so, if you are 
familiar with using Windows, you will be able to use OnePoint 
Messenger with very little training.  The OnePoint Messenger menus, 
dialog boxes, and windows are integrated into Outlook, which uses 
standard Windows controls.  For information on Windows controls, 
see Appendix B, “Standard Windows Controls” on page 209, your 
Windows manual, Outlook manual, and Outlook online help.

Using OnePoint Messenger with a Web Browser

The OnePoint Messenger Web Client works on Windows 95/98/NT 
with Internet Explorer (IE) 4.01 or later or Netscape 4.0 or later. 
Microsoft provides Outlook Web Access, a Web interface designed to 
look like the Outlook interface.  OnePoint Messenger adds Web Cli-
ent to Outlook Web Access to provide unified messaging.  Web Cli-
ent requires a site license.

You do not need to install anything on your PC except a supported 
Web browser before accessing your Exchange website.  When you 
use Netscape for the first time to access your mail, a Netscape plug-in 
downloads.  This gives you the ability to connect to your mailbox 
quickly from any Windows PC with Internet access.  See Chapter 4 
(page 103), for details on using Web Client.
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Using the Telephone User Interface (TUI)

The Telephone User Interface (TUI) is detailed in Chapter 7.  You are 
probably familiar with using voice mail menus for accessing and cre-
ating and messages.  The TUI lists your options in a particular con-
text, then you choose one by pressing the appropriate key on the 
telephone keypad.  In some cases, you must traverse several menus to 
reach your desired option.  In some of those cases, OnePoint Messen-
ger is set up to enable you to skip the menus by typing ahead. 
OnePoint Messenger also makes the key commands easy to remem-
ber by associating them with the first letter of the command.

Advanced voice messaging features include:

• Fax on Demand and Automated Attendant, two services that you 
can dial directly or access through the Message Center

• Multiple conditional greetings, which you can record and invoke 
for difference situations, such as when you are on vacation.

• Message-notification on your telephone and through your pager

• You can create and send a message from the TUI to multiple 
recipients, including preset system distribution lists.  You can 
enter the addresses directly or by using the Dial by Name service 
(see “Dial by Name” on page 168 in Chapter 7).  You can edit the  
list after you create the message.

The TUI supports unified messaging in various ways:

• When you log in, the TUI tells you the number of unread mes-
sages of each type (voice, fax, and e-mail) that are waiting in your 
Inbox.  You can set which type of message plays first or if it plays 
at all.

• You can preset what parts of messages play, and you can override 
those presets.  For example, you can set the TUI to play only the 
subject of text messages, but then if you hear the subject of one 
that you want to play, the Text-to-Speech engine will read the 
text to you.

• You can route a fax or text message to any fax machine, and you 
can select your online fax number, a preset default number, or 
enter another fax number.
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Setting OnePoint Messenger User Options

OnePoint Messenger adds unified messaging to Microsoft Exchange.  
If you have an Exchange mailbox, your Exchange Administrator can 
set up one of three general levels of OnePoint Messenger feature lev-
els for you:

• Full Unified Messaging: This feature level provides you the 
right to install OnePoint Messenger on your desktop, giving you 
unified messaging through Outlook and the ability to create faxes 
using the Unified Fax Printer.  If your organization has purchased 
the Web Client license, you can create unified messages through 
the Web Client.  From any telephone, you can access and manage 
all of your messages, including e-mail.

• Voice and Fax Mail: With this feature level, you can access 
voice and fax messages through any telephone, but you cannot 
access other content types within e-mail messages from the tele-
phone.  You may not install the OnePoint Messenger Desktop 
Client components, but you can receive unified messages through 
Outlook as standard e-mail messages with voice and fax attach-
ments, then play voice content through standard “.wav” format 
players, and view faxes through your default “.tif” format viewer.  
However, the additional playback controls that OnePoint Messen-
ger adds are not available.

• None: Exchange users with this OnePoint Messenger setting on 
their mailbox profiles do not have any telephone access to their 
Exchange mailboxes, no Web Client access to unified messages, 
and no right to install OnePoint Messenger on the desktop.  An 
Outlook user with this setting could still receive and play unified 
messages, as described for Voice and Fax Mail, above.

Your systems administrator can set a range of privileges for both Full 
Unified Messaging and Voice and Fax Mail users, including access to 
messages through pagers, limits on Call-Me sessions, use of fax, use 
of Text-to-Speech from the telephone, use of VPIM messaging 
(described in “Using Voice Profile for Internet Mail (VPIM)” on 
page 28) and other features.  Get a list of your privileges from your 
systems administrator.  Some settings that your systems administrator 
must enter that are not so much limits on service as they are your 
preferences include:

• Whether to play the TUI tutorial when you first log in to your 
mailbox from a telephone



Terms and Components 35

• Your pager type and number and the whether all unified mes-
sages or only urgent messages generate a page to you

• The language used for your mailbox prompts and the language 
used for the system prompts outside your mailbox

In addition to being able to set how Outlook handles your unified 
messages, you can use Outlook to set these telephone user interface 
(TUI) preferences:

• Record your name and mailbox greetings, and enable greetings 
played to callers for various conditions

• Mailbox log-in passcode that you enter from a telephone

You can log in to your mailbox from a telephone, then set the tele-
phone user interface (TUI) preferences above and:

• Enable or disable your pager and set the level of paging to urgent 
messages only or all unified messages

• Change your default personal fax number

• Set the amount of message detail played (headers only or headers 
and message body—Actually, with the setting “Headers Only”, 
you can still play the message body by pressing P again after the 
header plays.)

For details on setting preferences in Outlook, see Chapter 6 
(page 153).  For details on setting preferences using a telephone, see 
Chapter 7 (“Setting Telephone User Interface Options” on page 196).

Terms and Components

This chapter has introduced many terms and OnePoint Messenger 
features.  This section summarizes the terms that have been intro-
duced and adds a few more definitions of terms relevant to OnePoint 
Messenger clients.  For additional definitions, see the glossary in 
OnePoint Messenger Administrator Guide, described in the section 
“Other Documentation” on page 16 in this guide.

The previous section introduced the basic license levels, Full Unified 
Messaging (“Full UM”), Voice and Fax Mail (“Voice & Fax”, and 
None.  Within Full UM and Voice & Fax, system administrators 
assign you a Class of Service (“COS”) that sets further limits on 
access to services such as Text-to-Speech reading of e-mail over the 
telephone, Call-Me (see Chapter 3), and VPIM messaging (see 
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“Communicating with Users of Other Voice Mail Systems” on 
page 29).

Software Components

The software components in the OnePoint Messenger client are:

• The OnePoint Messenger Outlook Extension and the OnePoint 
Messenger Exchange Extension bring unified messaging to 
Exchange, Outlook, any touchtone telephone, and supported Web 
browsers.  OnePoint Messenger adds telephone controls, sound, 
fax features, and document viewing features.

• QuickPick opens a window in Outlook to show details about uni-
fied messages (see “QuickPick and the Unified Read Message 
Form” on page 83).

• Unified Fax Printer creates fax images from any program with a 
Print menu.

• Unified Message Player, usually called the “player,” plays sound 
attachments in unified messages.  It presents a control bar so you 
can control volume and what part of the message to play.

• Web Client is the unified messaging extension to Outlook Web 
Access to download a simulation of your Outlook Inbox in sup-
ported Web browsers to provide an Internet interface to your 
Inbox on Exchange.

The software components provided by other vendors that support 
OnePoint Messenger unified messaging are:

• Internet Explorer (IE) and Netscape are Web browsers for 
accessing the World Wide Web on the Internet. 

• Microsoft Exchange runs on a Windows NT Server to provide 
your mailbox, address books, and other functions. 

• Microsoft Outlook is a personal information management appli-
cation that provides a desktop client interface to the Microsoft 
Exchange mail server.

• Outlook Web Access is the Microsoft Web interface to Exchange.
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Outlook Interface

The terms used in this guide to describe elements that appear in 
Microsoft Outlook are:

• Inbox: The folder that contains your incoming mail.  The Inbox 
list is the mail summary that appears on the Inbox main screen. 

• Header: The message description fields, including message type 
icons, Subject, Sender, and date received.  It appears as a line in 
the Inbox list.  You can choose what fields display there.

• New Unified Message form: The message-creation form that 
OnePoint Messenger adds to Outlook.  Its distinguishing feature 
is that it has a recorder toolbar on it so that you can easily record 
voice attachments.  Otherwise, it is a normal form to which you 
can add any content type.  The Unified Read Message form is the 
full OnePoint Messenger incoming message form.  It contains the 
components of the standard Outlook Read Message form, plus a 
list of icons representing the message components, and the Uni-
fied Message Player toolbar.  Instead of an Options tab, it con-
tains an Options button.

• Outlook Bar: Optional column of buttons on the left side of the 
Outlook interface that provides easy access to folders.

• Outlook toolbar: The standard toolbar that appears in every Out-
look folder.  OnePoint Messenger adds Unified Messaging but-
tons to the right end of that toolbar, including buttons for 
QuickPlay, Call-Me/Meet-Me, and for accessing unified messag-
ing forms.  Chapter 3 details those buttons and functions.

Address Books and Distribution Lists

You can maintain address books on your own disk drive for use with 
Outlook. Your Exchange administrator can maintain one or more 
address books on the Exchange Server for group access. 

To address a unified message in Outlook, you have the same access to 
system and personal address book that you have for standard e-mail 
messages.  When using a Web browser, you have access only to the 
address books on Exchange.  Using a telephone, you have access only 
to addresses stored on Exchange of OnePoint Messenger users.

A distribution list contains the e-mail addresses of one or more peo-
ple or other distribution lists.  You can send e-mail to all of the lists 
members by selecting the distribution list name from the address 
book.  System distribution lists (those maintained on Exchange by 
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your Exchange administrator) are available to all desktop client users.  
Only those distribution lists to which the Exchange administrator 
assigns the OnePoint Messenger Voice and Fax Mail setting are 
available to OnePoint Messenger telephone users.  This is to ensure 
that everyone on such a list has a voice-enabled mailbox.

Using Outlook, you can create distribution lists for your private use in 
your Personal Address Book, stored on your local drive.  Only Out-
look can use them to address mail; you cannot access them with Web 
Client or a telephone.

Dial by Name (DBN) is a feature that enables you to call other users 
or address messages to them by pressing the keys on the telephone 
keypad that spell enough of your recipient’s name that the TUI can 
reduce the possible recipients to a short list.  You can also do this to 
select a distribution list.  When the system recognizes your intended 
recipient or a short list of possbles, the TUI asks you to press the key 
that matches your recipient.  See “Dial by Name” on page 168.

Personal Message Folders

A personal message folder is one that only you can see unless you 
give permission to others.  Your Inbox is a personal message folder, 
and you can create others on your PC or network server.  You can 
create and name as many personal message folders as you want to 
help you organize your messages.

Messages, Compound Messages, and Sibling Messages

OnePoint Messenger allows you to exchange all combinations of e-
mail, voice, and fax messages with other users through a combined 
telephone voice mail and e-mail system.  This tends to complicate the 
description of terms used for message types.

Unified message here means a message created by OnePoint Messen-
ger, either using the telephone or unified message form on the desk-
top.  Within the unified message, there may be a voice attachment.  A 
message attachment is a file that can be detached and stored sepa-
rately from the message.  The message indicates the presence of the 
attachment with an icon. 

Voice mail (or voicemail) traditionally describes messages recorded 
from a telephone, while e-mail describes text messages created on a 
PC.  In the world of unified messaging, the terms still indicate the 
source, but the content of the message is not necessarily voice only or 
text only.  This is why the term unified message is used here instead 
for OnePoint Messenger messages.  For example, with OnePoint 
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Messenger, you might use a telephone to forward an e-mail text mes-
sage to someone.  With no voice content, that is certainly not a voice 
message.  This guide uses voice message for a message containing 
only voice.

An antecedent message is the message that you are forwarding, or to 
which you are replying.  You may receive a message from someone 
that is composed of a series of comments from different authors, each 
one commenting on what was in the earlier (antecedent) message. 

Sound files (or audio files) are created by many programs, including 
OnePoint Messenger.  While you can attach all kinds of sound files to 
a unified message, the Unified Message Player plays only the WAV 
(.wav extension) and OKI (.cvv extension) formats.  To help differen-
tiate between supported and unsupported sound files, this book refers 
to those supported sound files as voice attachments.  You can use the 
OnePoint Messenger recorder to record sounds other than voice.

A compound message contains a combination of message component 
types—typically text in the body of the message and an attached file. 
One kind of attachment can be an antecedent message.  In Outlook, 
an antecedent message included as an attachment is represented by an 
envelope icon on the body of the current message.  By default, a uni-
fied message form sent as a reply or forward is set to include the ante-
cedent message as an attachment.  The antecedent attachment icons in 
the unified message depend on the content of the antecedent message. 
For more on unified message attachment icons, see “QuickPick and 
Read Message Form Toolbar” on page 88.

You can choose to have the antecedent message included as inline 
text (below your text on the message body) or as an attachment. Since 
forwarding a voice message as inline text is not possible, the 
OnePoint Messenger unified message buttons open forms that have 
the antecedent message attached.

An intentional message is a voice message that you send directly to 
another mailbox instead of calling the person.

File Formats

.WAV and .CVV: The OnePoint Messenger recorder now saves 
voice attachments with a “.wav” extension, which plays in your 
default .wav player as well as the Unified Message Player installed 
with OnePoint Messenger 2.0. OnePoint Messenger 1.1 uses the 
“.cvv” extension, which Unified Message Player can also play. If you 
forward a “.cvv” attachment to someone, you may want to send the 
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Unified Message Player (“ribbit.exe” on your disk drive) to be sure 
your recipient can play the attachment.

.TIF: Unified Fax Printer creates faxes using the multi-page version 
of the TIFF format (.TIF file extension), a common format that many 
graphics programs can interpret.

Text file formats: Outlook gives you the option of saving e-mail as 
text (.txt), as Rich Text (.rtf), as an Outlook template (.oft), or in 
native Outlook message format (.msg).  RTF includes some format-
ting (bold, italics, etc.).  Most word processing programs can interpret 
RTFs.  An MSG file retains all the formatting, but is not available in a 
word processing program.

Where to Go from Here

• To install OnePoint Messenger on your PC, see Chapter 2, 
“Installing OnePoint Messenger Client Components” on page 43.

• To use OnePoint Messenger to send and receive voice messages 
and other mail through Outlook, see Chapter 3, “Using OnePoint 
Messenger with Outlook” on page 61.

• To use OnePoint Messenger on the World Wide Web with             
Internet Explorer™ and Netscape™ to receive and send voice 
messages, see Chapter 4, “Web Access to Exchange” on 
page 103.

• To use OnePoint Messenger to view, annotate, create, and send 
faxes via telephone or e-mail, see Chapter 5, “Using OnePoint 
Messenger Fax Features” on page 125.

• To use your PC to configure or modify the telephone user 
interface, such as recording your name and greeting announced 
on the telephone, see Chapter 6, “Setting Preferences” on 
page 153.

• To learn how to use the Telephone User Interface (TUI), see 
Chapter 7, “Using OnePoint Messenger from a Telephone” on 
page 165.

• To learn how to test your multimedia controls, see Appendix A, 
“Tuning Your Multimedia Setup” on page 205.

• To learn about standard Windows controls, which are used with 
Outlook, see Appendix B, “Standard Windows Controls” on 
page 209.
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• To find a desired topic, see the Table of Contents or the index of 
this book. 
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2.   Installing OnePoint Messenger 
Client Components

This chapter lists requirements for the system and tells you how to 
install OnePoint Messenger on your PC.  It contains these sections: 

NOTE: If your system administrator has already installed OnePoint 
Messenger on your PC, skip this chapter and proceed to Chapter 3 for 
instructions on how to use OnePoint Messenger with Outlook.

OnePoint Messenger Installation Requirements

Before installing the OnePoint Messenger for Outlook client, a mail-
box configured for OnePoint Messenger must be created for you on 
the Microsoft Exchange Server.  There must be a LAN connection to 
the Exchange Server, and there must also be one to the Telephony 
Server if you plan to install the Outlook client from there.  To provide 
telephone functionality, the complete communications system must 
be running, as described in “How OnePoint Messenger Works” on 
page 31.

Section Page

OnePoint Messenger Installation Requirements 43

Preparing Your PC for OnePoint Messenger
• Installing Desktop Multimedia
• Installing Outlook
• Setting Network Access
• Creating an Exchange Transport Profile
• Modifying your Exchange Transport Profile

45
45
45
46
48
51

Installing the OnePoint Messenger Client 52

Removing OnePoint Messenger from Your PC 57

Testing Your PC Sound Setup and Volume Levels 58

Where to Go from Here 58



44 Chapter 2. Installing OnePoint Messenger Client Components

The following sections list what you need on your PC to run Outlook 
and the OnePoint Messenger Outlook client, then guide you through 
installing the components.  You do not need to run the OnePoint Mes-
senger client installation program in order to provide access to your 
mailbox from a Web browser or from a telephone.  For details on 
using a Web browser to access your mailbox, see Chapter 4, “Web 
Access to Exchange” on page 103.  For details on using a telephone 
to access your mailbox, see “Using OnePoint Messenger from a Tele-
phone” on page 165.

What Comes with OnePoint Messenger

In addition to its documentation, the OnePoint Messenger client 
installation includes two options:

• Unified Fax Printer: Installed in your printer folder, it creates 
faxes from any application.  For details on OnePoint Messenger 
fax features, see Chapter 5 (page 125).

• OnePoint Messenger Outlook Client: Software components 
include: 

• Unified Messaging Extensions to Outlook, including the 
recorder, New Unified Message form, and the Unified Mes-
sage Read Message form

• Unified Message Player, the sound player

• QuickPick, for viewing unified message components

For details on using the client on Outlook, see Chapters 3 
(page 61) and 6 (page 153).

What You Need on Your PC

You must have the following hardware and software to run the 
OnePoint Messenger Outlook client on a PC.

• Microsoft Windows 95, Windows 98, or Windows NT 4.0

• Microsoft Outlook 2000 or Outlook 98

• At least 20 MB of disk storage, including 3 MB for OnePoint 
Messenger.  Outlook alone requires 17 MB.  However, if you 
install Outlook as part of Microsoft Office, you must have 
enough disk storage for Office, which requires about 100 MB, 
depending on options.
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• Outlook typically utilizes up to 14 MB of RAM, if the resource is 
available.

• For network access to your Exchange Server, you need either a 
network card for LAN access or a modem for remote access.

• To play and record voice messages using your PC multimedia 
hardware, you need a sound card, speakers, and a microphone.  
For details, see “Tuning Your Multimedia Setup” on page 205.  
As an alternative to using desktop multimedia, OnePoint Messen-
ger provides Call-Me and Meet-Me, two ways to create a com-
bined computer-telephone session.  For details, see “Choosing 
between Telephone and Desktop Audio” on page 76 in Chapter 3.

Preparing Your PC for OnePoint Messenger

Before you can make full use of OnePoint Messenger features, you 
must prepare your PC.  You need to set up:

• Desktop multimedia

• Outlook 98 or Outlook 2000

• Network access (page 46)

• Exchange transport profile (page 48)

This section discusses the procedures for providing those elements.

Installing Desktop Multimedia

In order to use desktop multimedia—microphone and speakers—
install the multimedia elements from your Windows CD-ROM.

1 Load the Windows CD-ROM.

2 Select Multimedia from the Add/Remove dialog in the installa-
tion wizard.

Installing Outlook

Before you can install OnePoint Messenger on your PC, Outlook 
2000 or Outlook 98 must be installed.  Install the full version of Out-
look, which you can do from its own CD-ROM or as part of 
Microsoft Office.

1 Select Full Installation (not the default Standard installation).
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2 Select Corporate or Workgroup as the e-mail service (do not 
select Internet).

3 After Outlook installs, you must reboot, which is necessary to do 
before you install the OnePoint Messenger client.

If you have Outlook already installed, but are not sure if the version is 
supported, check the version number in the Outlook Help menu.

To ensure that the Exchange transport profile is correctly cre-
ated, and that you have selected Corporate or Workgroup as the 
e-mail service:

1 Click the Windows Start button, then choose Settings, then Con-
trol Panel, then Control Panel.

2 On Windows 98, double-click Mail, or, on Windows 95 and NT, 
double-click Mail and Fax.

3 If Microsoft Exchange is not in the list on the Services tab, close 
Mail, then open the Add/Remove Programs applet in Control 
Panel.

4 Select Outlook, then click Add/Remove.

5 When the dialog asks if you want to remove Outlook or add com-
ponents, select Add Components.

6 The dialog will ask for the source CD-ROM or drive.  Load the 
source, then select Corporate connection from the options list.

To check your Outlook version number:

1 Start Outlook.

2 Choose About Microsoft Outlook from the Help menu.

Setting Network Access

In order for OnePoint Messenger to run, network communication 
must be established.  To do this on a Windows 95 or 98 PC, you must  
set the proper network access control and security level.

On Windows 95 and Windows 98, set the network access control:

1 Right click the Network Neighborhood icon on the desktop and 
choose Properties.

2 Select the Access Control tab.

3 Select “User-level access control.”
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4 Type your LAN Domain name in the edit box.

5 Click OK.

Setting the Security Level

For Windows 95 and Windows 98 clients, you must set the DCOM 
security level in order to use Call-Me in Outlook (for more on the 
Call-Me and Meet-Me features of OnePoint Messenger, see “Choos-
ing between Call-Me and Meet-Me” on page 78 in Chapter 3.)

You can download DCOM for a Windows 95 or Windows 98 system 
from this URL:

http://www.microsoft.com/com/resources/downloads.asp

Download both the administrative application and DCOM itself.  For 
both Windows 95 and Windows 98, dcom95cfg.exe is the administra-
tive application.  Put both in a temporary directory, and double-click 
each to install them.

To set the security level:

1 In Windows Explorer, navigate to and double-click dcomc-
nfg.exe in the \system subdirectory of the \Windows directory.  
A dialog with three tabs appears, as shown in Figure 2-1.

Figure 2-1 DCOM Dialog

2 If you see “Before you can use DCOM, your system must be con-
figured for ‘User-level’ security”, use the Network icon in the 

http://www.microsoft.com/com/resources/downloads.asp
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Windows Control Panel to set directory access for “User-level” 
security before running the DCOM configuration utility.  That 
means you must change file-sharing to identified users rather than 
general password access:

a. In Control Panel, double-click the Network applet.

b. In the Network dialog, select the Access Control tab.

c. Select User-level access control.  Changing file sharing from 
file to user level removes all existing shares.  You must 
reboot for the changes in sharing to take effect.

4 When user-level sharing is set up, select the Default Security tab 
of the dcomcnfg dialog.

5 Under Default Access Permissions, click Edit Default.

6 If “The World” does not appear in the Access Permissions list, 
click Add.

7 Select “The World” from the list on the right (if no list appears, 
select you workgroup list from the “Obtain list from” drop-
down list, then click Grant Access, so that The World appears in 
the access list on the right.

8 Click OK.

9 Reboot.

Creating an Exchange Transport Profile

To establish communication between Outlook and the Exchange 
Server, you must create a mail transport profile.  If you have already 
created a profile, you may need to modify it.

If you already have a mail transport profile, check the settings:

1 Click the Windows Start button, then choose Settings, and Con-
trol Panel.  Double-click the Mail applet.

2 If the Services tab contains an “Internet E-mail” profile, you 
may need to delete or modify it if Outlook and OnePoint Messen-
ger do not run correctly.

3 A preemptive approach is to record the properties listed in the 
Internet E-mail profile, then click Remove to delete it; set up 
Outlook and OnePoint Messenger; create an Exchange mail 
transport profile, then set up the Internet E-mail profile again if 
you still want it.



Preparing Your PC for OnePoint Messenger 49

To set up the Exchange mail transport profile:

1 When you start Outlook for the first time, the Exchange Setup 
Wizard (called Inbox Setup Wizard in Outlook 98) appears, as in 
Figure 2-2, to help you create the transport profile.

NOTE: If the Wizard does not run and you have not established a 
connection with your mailbox on Exchange, see the next section.

Figure 2-2 First Screen of Exchange Setup Wizard

2 Under “Use the following information services,” select 
Microsoft Exchange Server, as shown in Figure 2-2.

3 Click Next.  The next screen of the wizard appears, as shown in 
Figure 2-3.

Figure 2-3 Second Screen of Exchange Setup Wizard
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4 Under Microsoft Exchange server, enter the name of your 
server.  Under Mailbox, you can accept the suggested profile 
name or enter any name that you prefer.  Click OK.  The third 
wizard window appears, as in Figure 2-4.

Figure 2-4 Third Screen of Exchange Setup Wizard

5 If you want to be able to work offline, click Yes under the prompt 
“Do you travel with this computer?”

6 Click Next.  The next screen helps you locate your Personal 
Address Book on your local drive.  This window lists the default 
address book that is installed with Exchange.  You can accept 
this, or click Browse to select another address book.

Figure 2-5 Setup Wizard, Personal Address Book Path
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7 Click Next.  In Outlook 98, a screen appears offering you the 
option of having Outlook start when you boot Windows.  Choose 
your preference, then click Next.

8 Click Finish.  You can view and modify the properties of your 
transport profile in the Mail and Fax applet in Control Panel, as 
described next.

Modifying your Exchange Transport Profile

If you need to modify your Exchange transport profile, for example, 
to add a connection to a Lotus Notes mailbox in addition to Outlook, 
or if you need to set up a new transport profile, you can do so from the 
Services applet in Control Panel or from Outlook.

To add an Exchange transport profile from Outlook:

1 From the Tools menu of the Inbox, choose Services.  
The Services dialog opens, as shown in Figure 2-6.

Figure 2-6 Services Dialog

2 Click Add.  The Add Serice to Profile dialog opens, as shown in 
Figure 2-7.
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Figure 2-7  Add Serice to Profile Dialog

3 Select Microsoft Exchange Server, as shown above, then click 
OK.  A dialog with four tabs appears.

4 On the General tab, enter the computer name of your Exchange 
Server in the Microsoft Exchange server text box, and enter 
your own name in the Mailbox text area, as shown in Figure 2-8.

Figure 2-8 Microsoft Exchange Server, General Tab

5 Click Check Names.  If you have entered both names correctly 
and you have a good network connection to the Exchange Server, 
the names become underlined.

6 Click OK to accept changes and close the dialog.

7 Reboot.

Installing the OnePoint Messenger Client

After installing Outlook, and setting up network access and your 
Microsoft Exchange transport profile, install the OnePoint Messenger 



Installing the OnePoint Messenger Client 53

client components.  The installation program gives you the option of 
installing the Unified Fax Printer and/or the Outlook components.

You can run the installation from the OnePoint Messenger CD-ROM 
or from the Telephony Server over the LAN.  In order to install the 
software over the network to a Windows NT computer, the account 
on which you are logged in must have local administrator rights.

NOTE: When upgrading OnePoint Messenger client software, you 
must remove the older version first.  See “Removing OnePoint Mes-
senger from Your PC” on page 57.  If you start the installation pro-
gram before uninstalling, a reminder message appears that stops you 
from proceeding.
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To install the OnePoint Messenger client components on a PC:

1 From your system administrator, get your mailbox address and 
personal Exchange ID (“alias”).  If installing the client from the 
network, get the location of the installation directory.  The default 
directory is \UMInstall on the Telephony Server.

2 Start Windows on your PC.  Close all applications.

3 Click the Windows Start button, and choose Run.

4 In the Run dialog, enter the Telephony Server install path or the 
drive letter of the CD-ROM that contains the OnePoint Messen-
ger client components.

The path to the Telephony Server includes the name of the server, 
“UMClient” (the name of the shared client directory), and “setup” 
(the client setup file), in this form:

\\<server>\<directory>\setup

For example, in this path:

\\Typhoon\UMClient\setup

“Typhoon” is the name of the server.

“UMClient” is the directory that contains the client software.

“Setup” is the setup.exe file.

5 Click Next.

6 Click Next or Yes to accept the defaults for these screens:

• Welcome

• Software License—please read the license before accepting

• Information—lists the components that can be installed

• Choose Destination—target directory

7 From the Select Components dialog, select one or both of the 
two options, then click Next:

• Outlook Client: Installs OnePoint Messenger additions to  
Outlook—Unified Message Player, Recorder, menu items, 
buttons, forms, and QuickPick

• FAX Client: Installs the Unified Fax Printer to create faxes 
from applications with Print menus, ImageViewer fax 
viewer, fax cover page generator
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8 On the Select Program Folder screen, to accept the default 
folder name, click Next.

9 A progress screen appears while the OnePoint Messenger client 
components are installed.  A DOS window appears on top of the 
progress screen, then disappears.  If a Readme text file appears 
with last-minute information about OnePoint Messenger, read the 
file, then click Continue.

10 On the Setup Complete screen, choose either:

• Yes, I want to restart my computer now.

• No, I will restart my computer later.

The computer must restart in order for the OnePoint Messenger 
installation to take effect.

Testing the OnePoint Messenger Client

After installing the client, inspect the Outlook interface to verify that 
the OnePoint Messenger components have been added.  For example, 
note the new unified messaging buttons at the right end of the Out-
look toolbar and the new menu items in the Tools menu.  For details, 
see Chapter 3.  If you do not see these elements, use Version Reader, 
as described in the section “Version Reader” below to check for Out-
lookExt.dll.

If you installed the Unified Fax Printer, you should see it listed in the 
printer list in any print menu.

Installation details are in CVInstall.log, a log file placed in your \temp 
directory by the OnePoint Messenger Desktop Client installation pro-
gram.  The log notes the files installed, the registry keys read and 
modified, and installation errors.

If the installation failed, remove any vestiges of the client before rein-
stalling.  See “Removing OnePoint Messenger from Your PC” on 
page 57, below.

To make sure that everything works, run this test sequence:

1 Create a voice message in a New Unified Message form, as 
explained in “Creating Unified Messages” on page 91 in 
Chapter 3.  If you cannot access the form, see the section “Ver-
sion Reader” below to check for the existence on your system of 
cvMail.dll, cvCommon.dll, and cvExten.dll.

2 Send the message to yourself.
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3 When the message returns from the Exchange Server, it should 
appear with a telephone icon in the Inbox list.  Double-click the 
message.  QuickPick should open a window and Auto-play 
should play the voice attachment component.

4 If QuickPick does not display, see the section “Version Reader” 
below to check for QuickPickControl.dll.

5 If the voice message does not play, check for cvSound.dll and rib-
bit.exe.  Also, check the Unified Message Player status window 
for “No License”.

6 If you selected the Unified Fax Printer installation option when 
you installed OnePoint Messenger, create and send a fax mes-
sage, as explained in Chapter 5 (page 125).

Version Reader

Version Reader is a handy OnePoint Messenger utility that is 
installed on your system.  It displays version information for the 
OnePoint Messenger programs currently installed.

To verify the installation using Version Reader:

1 From the Windows Start button, choose Programs, then 
OnePoint Messenger, and Version Reader.  Version Reader 
appears, as shown in Figure 2-9.  If the OnePoint Messenger 
group does not exist, the program is either not installed, or you 
assigned it another program group name.

Figure 2-9 Version Reader

2 Check the presence and build number of the files listed above in 
the list.
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3 Click Close.

NOTE: Note the Export to File button, which you can use to create a 
list of currently installed components.  With this and the Browse but-
ton, you can use Version Reader to examine component versions of 
other installed programs.

NOTE: The OnePoint Messenger program group consists of only 
Help and Version Reader, because the OnePoint Messenger client 
runs as a part of Outlook and the Unified Fax Printer runs within the 
print menus of all applications, so you do not need to start either sep-
arately.

The Help listed in the group is a set of “training cards” for the most 
common tasks.  Also, the last item in the list of cards is a link to the 
general OnePoint Messenger help.

Removing OnePoint Messenger from Your PC

If you decide to quit in the middle of installing or setting up OnePoint 
Messenger on your PC, or to remove OnePoint Messenger from your 
PC after it is installed (such as before installing an updated version), 
follow these steps:

1 Click Start, then Settings, then Control Panel.

2 On the Control Panel, click Add/Remove Programs.

3 Highlight the OnePoint Messenger program in the list.

4 Click Add/Remove.

5 Click OK.

6 Close the Control Panel.

If you remove Outlook from your PC, OnePoint Messenger will still 
be on the system but will be unavailable.  Follow the steps above to 
remove it.

Setting Up Web Access to Exchange

You can use Internet Explorer or Netscape to connect to your mailbox 
on your Exchange Server over the Internet.  When you use your Web 
browser to connect to your mailbox, the Exchange Server presents 
you a Web page that simulates the Outlook interface.  Microsoft calls 
this interface Outlook Web Access.  OnePoint Messenger installs an 
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extension on the Exchange Server to add unified messaging features 
to the Outlook Web Access interface.  Outlook Web Access and Web 
Client download automatically to your system when you use Internet 
Explorer.  When logging in for the first time with Netscape, you are 
prompted to install the Web Client plug-in.

To set up Web browser access to your mailbox:

1 Install and launch Internet Explorer 4.0 or later or Netscape 4.0 or 
later.

2 Configure your dial-up or LAN settings for TCP/IP access.

3 In your browser, enter the URL or network address of your 
Exchange Server, as described in “Connecting to Your Mailbox 
through the Web” on page 105.

For details on the use of Web Client, see “Introduction to the Web 
Interface” on page 108.

Testing Your PC Sound Setup and Volume Levels

To use your PC to listen to or record voice messages, make sure your 
sound card and volume controls are set up properly.  Refer to your 
desktop multimedia documentation for instructions about how to set 
and test the multimedia components.

Also, use the Microsoft utilities included with Windows, such as 
Windows Media Player and Volume Control, to test and set your 
audio output levels.  For details on using those applications, see your 
Windows documentation and “Tuning Your Multimedia Setup” on 
page 205 in Appendix A.

Where to Go from Here

• To use OnePoint Messenger to send and receive voice messages 
and other mail through Outlook, see Chapter 3, “Using OnePoint 
Messenger with Outlook” on page 61.

• To use OnePoint Messenger on the World Wide Web with             
Internet Explorer™ and Netscape™ to receive and send voice 
messages, see Chapter 4, “Web Access to Exchange” on 
page 103.

• To use OnePoint Messenger to view, annotate, create, and send 
faxes via telephone or e-mail, see Chapter 5, “Using OnePoint 
Messenger Fax Features” on page 125.
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• To use your PC to configure or modify the telephone user 
interface, such as recording your name and greeting announced 
on the telephone, see Chapter 6, “Setting Preferences” on 
page 153.

• To learn how to use the Telephone User Interface (TUI), see 
Chapter 7, “Using OnePoint Messenger from a Telephone” on 
page 165.

• To learn how to test your multimedia controls, see Appendix A, 
“Tuning Your Multimedia Setup” on page 205.

• To learn about standard Windows controls, which are used with 
Outlook, see Appendix B, “Standard Windows Controls” on 
page 209.

• To find a desired topic, see the Table of Contents or the index of 
this book.
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3.   Using OnePoint Messenger 
with Outlook

This chapter explains how to use Outlook with OnePoint Messenger 
to play and create unified messages.  This chapter contains the fol-
lowing sections: 

NOTE:To use your Outlook to configure or modify the telephone 
user interface, such as recording your name and greetings that are 
announced to telephone callers, see Chapter 6, “Setting Preferences” 
on page 153.

Section Page
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Overview of OnePoint Messenger Elements in Outlook 63
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If you are familiar with Outlook, skip to the section “OnePoint Mes-
senger Buttons Added to the Outlook Toolbar” on page 65.  If you are 
unfamiliar with Windows, read Appendix B first.

Starting Outlook and Connecting to Your Mailbox

To use OnePoint Messenger with Outlook, first perform the installa-
tion and configuration procedures in Chapter 2, then start Outlook. 
When Outlook starts for the first time, you are presented with a wiz-
ard to help you create a transport profile to Exchange.  For details, see 
“Creating an Exchange Transport Profile” on page 48.

Depending on how you set your Outlook login preferences, you may 
be connected directly to Exchange as soon as you start Outlook, or 
you may be presented with a choice of user profiles, a password 
screen, or a screen asking if you want to connect to the server.

NOTE: If you see a password screen on your first use of Outlook, get 
your password from your system administrator.  You can change your 
password and startup screen later.  See Outlook help for details.

Logging into Your Exchange Mailbox from a Different PC

You can use OnePoint Messenger with Outlook to log into your 
Exchange Server from any PC that has both Outlook and OnePoint 
Messenger installed and which has network access to your Exchange 
Server.  When you log in to Exchange from another PC, any personal 
folders on your own PC will not be available.

NOTE:OnePoint Messenger works only with Outlook, not other 
Exchange clients.  Exchange Client is not Outlook.

Getting Online Help

OnePoint Messenger adds online help to Outlook as ToolTips, 
“What’s This” help, and as a comprehensive topical help system, in 
parallel to the help offered by Outlook:

• ToolTips: If you hold the mouse over Outlook and OnePoint 
Messenger buttons, ToolTips appear.

• What’s This help: From the Help menu, choose What’s This?, 
then click a button or other interface element to get a popup with 
more information on its function.
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• Help Topics: You can access topics on tasks and forms from 
either the Outlook help or OnePoint Messenger help, which are 
both available from the Outlook Help menu.

To access online help for OnePoint Messenger on Outlook:

• Choose Unified Messaging Help from any Outlook Help menu.

• For help on the Unified Messaging tab, click its Help button.  To 
get to the general help contents for OnePoint Messenger from the 
tab’s help dialog, click Help Topics.

Training Cards: The OnePoint Messenger Training Cards are expla-
nations of how to perform major tasks using OnePoint Messenger on 
Outlook and Unified Fax Printer.  The main window of the training 
card help is the list of tasks, such as creating a fax or a voice message.

To use the training cards:

1 Click the Windows Start button, then choose Programs, then 
OnePoint Messenger, then Help.

2 Click a task to see the associated procedure.

Also, a link to the comprehensive OnePoint Messenger topic help 
is the last item in the task list.  You can have both help systems 
open and keep them in the background behind Outlook.

3 To close the training card task list, click the Close box  in the 

top right corner of the help system.

Overview of OnePoint Messenger Elements in Outlook

This section describes the OnePoint Messenger functions added to 
Outlook.  For a full discussion of Outlook features, see your Outlook 
documentation.  If you are an experienced Outlook user, you can 
probably skim this section.  The interface controls are all common to 
Windows applications.  For more on using the standard Windows 
controls used in Outlook, see “Standard Windows Controls” on 
page 209, or see your Windows documentation.

When you start Outlook, the Outlook main screen appears, showing 
the Inbox folder, as shown in Figure 3-1.  You can change the default 
startup folder.  See your Outlook documentation for details.

When you use Outlook with Microsoft Exchange, you can select 
whether to leave your mail on the mail server, copy it to your local 
drive, or remove it from Exchange to your computer.  To be able to 
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access your mail from a telephone, keep your mail on the server.  You 
can, however, copy your mail to a folder on your computer—for 
example, to a laptop that you will use off-line—and still have access 
to it on Exchange.  For details, see your Outlook online help.

With OnePoint Messenger, the Inbox contains your incoming mes-
sages from both your telephone and e-mail system.  Figure 3-1 shows 
OnePoint Messenger added to the Outlook Inbox folder, next to the 
Outlook Folder View and Outlook Bar.

Figure 3-1   Outlook Main Screen, Folder View

For details on OnePoint Messenger interface elements, see:

• “OnePoint Messenger Commands on Main Screen Menus”, next

• “OnePoint Messenger Buttons Added to the Outlook Toolbar” on 
page 65

• “Inbox Message Summary (Inbox List)” and “Unified Message 
Icons in the Inbox List” on page 66

• “Folders” on page 67

 

 
Unified Message type icons in Message Summary

OnePoint Messenger buttons
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OnePoint Messenger Commands on Main Screen Menus

The menu options on the Outlook menu bar change between folders, 
but the same OnePoint Messenger commands appear in each folder:

• Help menu: Unified Messaging Help

• On the Tools menu:

• New Unified Message

• Play Unified

• Reply Unified

• Reply All Unified

• Forward Unified

• Initiate Call-Me/Meet-Me

• Terminate Call-Me/Meet-Me

• The Unified Messaging tab within the Options command

With the exception of OnePoint Messenger controls in the Uni-
fied Messaging tab (available from Tools > Options), each of the 
commands in the Tools menu has an equivalent toolbar button.

OnePoint Messenger Buttons Added to the Outlook Toolbar

OnePoint Messenger adds new buttons to the right end of the standard 
Outlook toolbar of the Inbox and other Outlook folders, as shown in 
Figure 3-1.  All of the buttons in the Outlook toolbar have equivalent 
commands in the Tools menu of the Inbox.  For details on the unified 
message buttons, see the section “OnePoint Messenger Buttons 
Added to the Outlook Toolbar” on page 65.

NOTE: Your OnePoint Messenger system administrator configures 
user access to certain OnePoint Messenger features, so some features 
described here may not appear on your system  

Four OnePoint Messenger buttons—New Unified, Reply Unified, 
Reply All Unified, and Forward Unified—have the same general 
function of opening the New Unified Message form.  The difference 
in that form from the standard Outlook message form is that the New 
Unified Message form has a recorder toolbar on it to make it easy to 
record a voice attachment.  You can use the New Unified Message 
form to include every kind of content that you can with the standard 
Outlook form.  For details, see “Creating Unified Messages” on 
page 91.
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The OnePoint Messenger buttons on the Outlook toolbar are:

New Unified Message—Opens am empty New Unified Message 
form (no preset addresses or file attachments.

Play Unified—Launches the Player toolbar and plays the first voice 
attachment in the selected unified message using desktop audio.  If 
there is no voice attachment, nothing happens.  The Play button does 
not trigger the display of a fax message.

Reply Unified—Opens a New Unified Message form in reply to the 
selected message.  This form includes the name of the sender of the 
original message in the To field.  The original message is attached.

Reply All Unified—Opens a New Unified Message form with the 
names of all “To” recipients of the original message in the To field 
and “Cc” recipients in the Cc field. The original message is attached.

Forward Unified—Opens a New Unified Message form with the 
selected message attached.

Initiate Call-Me/Meet-Me—Initiates a Call-Me or Meet-Me session, 
depending on the telephone connection method that you have speci-
fied in the Unified Messaging tab.  For details, see “Choosing 
between Call-Me and Meet-Me” on page 78.

Terminate Call-Me/Meet-Me—Terminates the active Call-Me or 
Meet-Me session.

Inbox Message Summary (Inbox List)

The Inbox Message Summary (Inbox list) shows your incoming mes-
sages, both opened and unopened.  Unopened messages appear in 
bold.  By default, the Inbox list displays these fields about each mes-
sage: Priority, Message Status, Flag, Attachment, From, Subject, 
and Received Date/Time.  You can change which fields appear and 
their order.  For details, see Outlook help.

Unified Message Icons in the Inbox List

A unified message is one created on a Unified Message form or from 
a telephone.  The icons that appear next to the message on the Inbox 
list indicate the primary content.

A telephone icon in the Inbox list indicates a telephone call or that the 
sender created the message using a Unified Message form.

A fax icon appears when the message is generated by the Unified Fax 
Printer or when a telephone user sends a fax.  A voice message to 
which a fax is attached displays a telephone icon.
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The standard Outlook paperclip icon appears in the attachment field 
of all unified messages that contain voice or fax attachments.

See the Inbox symbols topic in Outlook help for details on standard 
Outlook symbols.

Folders

Folders are a standard feature of Outlook.  Folders include message 
subfolders, public folders, and application folders (Contacts, Notes, 
Journal, Calendar, and Tasks).  OnePoint Messenger lets you create 
unified messages from any folder.  The unified messaging buttons 
that OnePoint Messenger adds appear in the Outlook toolbar in each 
folder, as do the unified messaging commands in the Tools menu and 
the Unified Messaging Help command in the Help menu.

Messages you send are stored, by default, in the Sent Items folder.  
Messages you mark for deletion are stored in the Deleted Items 
folder.  You can create message subfolders for your own needs.  You 
can move or copy any message to any folder, either manually or by 
using the Inbox Assistant (see Chapter 6 “Creating a Telephone Mes-
sage Alert” on page 161, or see your Outlook documentation.)

Working with Unified Messages in the Inbox List

This section discusses selecting, opening, closing, and managing uni-
fied messages in the Inbox.

Modifying Long Outlook Toolbars

If you shrink the right side of the Outlook window, buttons on that 
side of the Outlook toolbar may not be visible.  Since OnePoint Mes-
senger adds buttons to the right end of the Outlook standard toolbar, 
those buttons will be the first to disappear.

In Outlook 98 and 2000, to help make these buttons visible, you can 
create a new toolbar below the standard one, then move some stan-
dard Outlook buttons to it, leaving the OnePoint Messenger buttons 
more to the left and visible in the Outlook toolbar.  You can create 
custom toolbars in all windows.

To create a new toolbar:

1 From the View menu, choose Toolbars, then Customize.… The 
Customize dialog appears.

2 Click New.  The New Toolbar dialog appears.
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3 Enter a name for the new toolbar.

4 Click Close.

5 With the Customize dialog open, drag standard Outlook buttons 
from the Outlook toolbar to the new toolbar.

6 Click Close.

Selecting Unified Messages

Working with unified messages in the Inbox is the same as working 
with standard Outlook messages, which is similar to working with 
files in the Windows File Manager.  You can select one or more mes-
sages to open, move to another folder, delete, flag, mark as read or 
unread, and other options.

To select a message:

Click its message header once in the Inbox.  This highlights it without 
opening it, so that you can choose what to do with it.

To select several messages:

Press [Shift] while clicking the top and bottom message of a block of 
messages.

or

Press [Ctrl] while clicking nonadjacent messages.

You can perform a function on the selected messages at the same 
time, such as saving their combined contents to a single file, moving 
them to another folder, marking them as read or unread, deleting 
them, or printing them.

Opening Unified Messages

To open a unified message:

Open a unified message just as you do a standard e-mail message:

• Double-click the message.

• Alternatively, select the message, then press [Enter].

To open more than one message, select each, then press [Enter]. 
Each message opens in its own window.  Unified messages open in 
one of two types of windows:

• A Unified Read Message form, just as standard e-mail messages 
open in a standard Read Message form.  The Unified Read Mes-
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sage form differs from the standard form in several ways, as 
described in “QuickPick and the Unified Read Message Form” on 
page 83.

• QuickPick, a OnePoint Messenger application that opens the 
message in a small window showing the message components 
displayed as icons.  At installation, QuickPick is set as the 
default.

Use the Unified Messaging tab to set which form you want to 
open automatically.  For details, see “QuickPick and the Unified 
Read Message Form” on page 83.

Two other options determine how voice messages play:

• Call-Me/Meet-Me: Call-Me and Meet-Me are two ways to 
establish a combined computer-telephone session, so that you can 
listen to and record messages using the telephone handset.

• Auto-play: At installation, auto-play is set as the default.  With 
auto-play set, the first voice attachment in a unified message 
plays automatically when you open the message.

Using Message Preview Options

QuickPlay: The term QuickPlay represents functionality added to the 
Play button on the Outlook toolbar.  It gives you quick access to 
voice attachments from the Inbox list.  For details, see “QuickPlay” 
on page 75.

AutoPreview: From the View menu, choose AutoPreview to display 
the first three lines of each unread message.  You can use this to 
determine if a unified message contains text.  Telephone messages 
generally have no body text, so nothing appears in the preview.

Preview: In addition to the three-line autopreview, Outlook 98 and 
Outlook 2000 also have a preview pane (View > Preview) that you 
can use for the same purpose.

When you see a message with a telephone icon, the subject “Unified 
Message” and no body text, you probably have a voice message that 
you can play from the Inbox list without opening.  See “Playing 
Voice Messages” on page 74.

Using the Preview Pane

In addition to the “Messages with AutoPreview” list option, 
Outlook 98 and Outlook 2000 provide a preview pane that enables 
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you to see much more of a selected message without opening it.  Lim-
itations include:

• A typical telephone message contains only a voice attachment, so 
its preview pane displays only an attachment icon.

• For messages created in a New Unified Message form in Out-
look, the preview pane displays “Items with embedded 
script cannot be displayed in the preview pane.”

• When you have the preview pane open and Call-Me/Meet-Me set 
as the default, selecting a unified message created from a tele-
phone launches a Call-Me/Meet-Me connection.

To stop the Call-Me/Meet-Me connection process while in pre-
view mode:

Click Cancel in the connection dialog.

or

You can change your audio preferences in the Unified Messaging tab 
to Desktop Multimedia (or Call-Me, without specifying a phone num-
ber).  For details, see: “Choosing between Call-Me and Meet-Me” on 
page 78.

To access a voice attachment when the preview pane is open:

Besides the standard methods of playing the voice attachment select-
ing the message in the Inbox list, then clicking Play or by double-
clicking the message, you can access the voice file from the Preview 
pane if the message was created from a telephone: 

Click the left mouse button on the attachment button above the top 
right corner of the Preview pane, then click the attachment icon that 
appears.

If the phone message contains more than one attachment or an ante-
cedent message, icons appear for each.  “Msg.wav” is the most recent 
voice attachment.  Clicking an antecedent icon opens the antecedent 
in QuickPick or the Unified Read Message form, depending on your 
set preference.

Closing Messages

You have several ways to close a message in QuickPick or the Uni-
fied Read Message form:

• Press [Esc].
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• Use standard Windows controls (Control Menu button, Close 
Box button, or the Close command from the File menu) 

• Click the Outlook Delete button in the QuickPick or Unified 
Read Message form toolbar.  This moves the message to the 
Deleted Items folder and opens the next message. 

• Click the Unified Message Delete button.  This moves the mes-
sage to the Deleted Items folder and opens the next unified mes-
sage.

• Click the Outlook Next or Previous buttons to open the next or 
previous message.

• Click the Unified Message Next or Previous buttons to open the 
next or previous unified message.

Managing Messages from the Inbox

Messages that appear in your Inbox that come from telephone callers 
generally do not display as much information in their headers about 
the caller and subject as do messages sent as e-mail.  In the Inbox 
message summary, a call made from a telephone displays:

• “Unified Message” as a default Subject, unless the call is a 
response to an e-mail, because callers cannot enter a subject.

• “Outside Caller” in the From field, unless the PBX sends 
information about the caller (calling telephone number, possibly 
also the caller name associated with that number) to the Tele-
phony Server.  If the call is from an extension in the OnePoint 
Messenger domain, the PBX is more able to send the name of the 
caller along with the calling phone number.

You can make notes about telephone messages that you save in the 
Inbox in several ways:

• Edit the Subject fields of calls.

• Open the message.  Enter notes on the message body.  Close the 
message, then mark the message as Unread.  If you select Auto-
Preview view option, you can see your notes in the preview.

• Use a New Unified Message form to forward the unified message 
to yourself, adding notes about it.

To make the Subject field editable:

1 In Outlook 98 and Outlook 2000, choose Current View from the 
View menu on the Outlook main screen, then Define Views.
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2 In the Define Views for “Inbox” dialog, select the view(s) in 
which you want to edit the Subject field.

3 Select Other Settings.

2 Select Allow in-cell editing.

3 Click OK to accept changes.

NOTE:The Allow in-cell editing setting will persist until you 
change it, or you change views without saving this view, or you 
install a new version of OnePoint Messenger.

To annotate the incoming message summary:

1 Listen to the message.

2 Press [Esc] to close the message. 

3 Edit the Subject field of the message:

a. Select the message. 

b. Press [Tab] to select the Subject field.

c. Enter your notes about the caller and subject.

d. Select another message to accept the changes.

Figure 3-2 shows several messages.  The top line shows a call from 
“Outside Caller.” The Subject is being edited to note the information 
in the call.  The Subject field in the third line has the original “Unified 
Message.”

Figure 3-2   In-cell Editing in Outlook Inbox List
 

Marking Messages as Read or Unread

Both OnePoint Messenger and standard Outlook messages use bold 
text in the Inbox list to highlight unread messages.  Also, standard 
Outlook messages have icons in the Icon field of the list that indicate 
whether the messages have been read or not.  Unified message icons 
do not signal read/unread status.  Conversely (or perversely!), when 
you display the Preview Pane, the act of selecting then deselecting a 

Unedited subject

Edited subject
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standard Outlook message makes the message status indicators signal 
Read, which does not happen with unified messages.

How you play a unified message determines whether it is marked as 
read or unread in the Inbox list.  When you listen to a message 
through the telephone or QuickPick, the message is marked as read in 
the Inbox list. 

If you simply select the message in the Inbox list and click Play to 
play the voice attachment without opening the message, the message 
is not marked as read.  This is to prevent you from thinking that you 
had opened the message and inspected all of its contents, which may 
include more than one voice attachment.  However, if you are confi-
dent that you have played the whole message, you might want to 
mark the message as read.

To mark the message as read:

1 In the Inbox list, select the message.

2 From the Edit menu, choose Mark As Read.

or, in the Read Message form:

From the Edit menu, choose Mark As Read.

NOTE: In the Inbox, you can [Shift]-click to select a contiguous 
group of messages (to select non-contiguous messages, [Ctrl]-click 
each message) upon which to perform this Mark As Read operation. 

Marking a Message as Unread

You might want to mark a message as unread after having played it to 
remind you to do something with the message.  Also, marking a mes-
sage as unread places it high in the message queue so that it is easily 
available from a telephone the next time you call in.

NOTE: Marking a message as unread will not cause the message-
waiting indicator (MWI) to signal your telephone.  However, if you 
receive another unified message, the MWI will stay on until you have 
played both messages.

To mark an opened unified message as Unread:

Right-click on the message, then choose Mark as Unread from the 
context menu (popup menu).

Alternatively, select the message in the Inbox, then from the View 
menu, choose Mark As Unread.
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Using Subfolders

Outlook provides you the ability to create subfolders under the root 
Inbox folder, most commonly for storing related messages that you 
have received.  With OnePoint Messenger unified messaging, you 
now have the ability to store telephone messages in those subfolders.  
However, be careful that you do not unintentionally dilute the func-
tionality that you have for accessing messages from a telephone, 
because you cannot use a telephone to access a message that you have 
moved to a subfolder.  In addition, moving an unread unified message 
to a subfolder deactivates the message-waiting indicator (MWI) on 
your telephone.

Playing Voice Messages

OnePoint Messenger adds several voice access and creation options 
to Outlook.  Those options can work independently or together, as 
defaults or as manually-invoked methods.  QuickPick is one of those 
options.  Auto-play and using the telephone with Outlook are other 
options.  You can listen to a voice attachment through desktop audio 
or a telephone, and choose from several ways how to play the mes-
sage through those devices. Ways to start to play a voice message are:

• Select a message in the Inbox, then click Play on the Outlook 
toolbar.  OnePoint Messenger 2.0 has added Call-Me/Meet-Me 
support and the QuickPlay feature to the Play button so that you 
have many more options for playing voice messages directly 
from your Inbox list, as described below (page 75). 

• In the QuickPick list, select a voice attachment, then click Play 
on the player toolbar to use the player to play the attachment.

• In the QuickPick list, double-click the voice icon to play the 
attachment in your default player.

• Double-click a voice icon in the message body to play the attach-
ment in your default player 

• Set auto-play as the default, then, when you open a message with 
voice content, the first voice attachment plays automatically.  For 
details, see “Using QuickPick and Auto-play with Unified Mes-
sages” on page 91.
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QuickPlay

The Play button in the Outlook toolbar gives you quick access to 
voice messages from the Inbox summary list.  When you select a 
message in the Inbox list that has a voice attachment, you can click 
Play to play the voice content through your PC speakers, or you can 
start a Call-Me or Meet-Me session (see page 76) to play the message 
through your telephone.  You can skip to other voice messages in the 
Inbox list without closing the previous messages. 

To use QuickPlay to play voice messages directly from the Inbox 
list:

1 Select the unified message to play.

2 Click Play on the Outlook toolbar. 

QuickPlay, which adds enhanced voice message playing options 
directly from the Outlook Inbox list, including support for Call-
Me/Meet-Me.  See Chapter 3 (page 61).

3 The Unified Message Player appears as a floating control bar, and 
the most recent voice attachment in the message plays.  You can 
use the player controls to skip forward or back in the message, or 
stop and start the message.  For details on the player controls, see 
“Unified Message Player Controls” on page 88.

4 To play a voice attachment in another message, select it, then 
click Play.  The previous message stops playing and the most 
recent voice attachment in the selected message begins to play.

While using the Inbox Play button is a quick way to play voice mes-
sages, there are limitations:

• The Play button plays messages only through the desktop, not 
through the telephone when Call-Me/Meet-Me is invoked.

• A message may contain more than a voice attachment.  To access 
other content in the message, such as text, fax, or more than one 
voice attachment, you must open the message.

If there is no voice content in a message that you select and click 
Play, a message popup tells you.  If someone uses a unified message 
form only to forward or reply to a voice message, but does not record 
anything, clicking Play will invoke the same message.
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Choosing between Telephone and Desktop Audio

You have several ways to access voice messages in Outlook:

• Call-Me: Set up a combined computer-telephone session by hav-
ing Telephony Server call your telephone.

• Meet-Me: Set up a combined computer-telephone session by ini-
tiating the telephone connection from Outlook, then dial the Mes-
sage Center from your telephone.  The resulting interface is the 
same as for Call-Me.  Call-Me and Meet-Me are detailed below.

• Desktop multimedia: To play voice attachments through the 
computer, use a PC sound card with speakers or headphones.

• Independent telephone call and Outlook session: Call your 
mailbox while you have an Outlook session open.  Do not estab-
lish a Call-Me/Meet-Me connection.  You can use Outlook to 
view the same message that you are listening to on the telephone, 
or you can open different messages with each interface.  You can 
use Outlook to give you more information about messages, so 
that you can exercise more control on your telephone over what 
messages and parts of messages play. 

Here are some factors to consider when choosing how to play and 
record messages:

• Privacy: Using the telephone allows you to listen to messages 
without others hearing.

• Consideration: Using the telephone also allows you to listen to 
messages without disturbing others.

• Clarity: The telephone generally provides greater clarity in play-
back and recording, including reducing background office noise. 

With those telephone benefits, why would you bother using Outlook 
to open telephone messages?

• Control of message components: When you receive a message 
that contains more than one component, such as a fax attachment 
or reply thread, Outlook gives you direct access to and more con-
trol of those components.

• Reply and forward options: You can have more choices and 
better control when you reply to or forward a message.  You can 
combine voice and text, add an attachment, add recipients that are 
not OnePoint Messenger users, and set other options.



Playing Voice Messages 77

• Message management options: After listening to the message in 
Outlook, you have more choices and easier control over how to 
manage the message, such as save the message in a special folder, 
annotate the Subject field, flag it, set it to Unread, save or print 
attachments.

If using Call-Me or Meet-Me gives you the benefits of both Outlook 
and a telephone, why would you not set up one of them as the default? 

• Setting Call-Me or Meet-Me as the default means that all unified 
messages invoke Call-Me or Meet-Me, even if it does not contain 
voice content. 

• While you are on the telephone playing or recording a voice mes-
sage means that the telephone is busy when someone calls you.

Choosing a Remote Access Method

If you are logging into your mailbox remotely, another criterion for 
deciding whether to listen to a message through the telephone or 
desktop speakers might be telephone connection costs.  If you are 
calling at long distance rates, listening to text-to-speech rendering of 
e-mail through a telephone can get expensive. 

If you can set up a connection to the Exchange Server to run Outlook 
or WEB Client (see Chapter 4, page 103), you can read or file the 
messages, so that, when you call for messages, only the voice mes-
sages play. 

If you have desktop multimedia, you can choose whether to play 
voice messages on the computer or through the telephone.  One crite-
rion is long the message is.  You can see that by adding the Size field 
to your Inbox message list header. 

To add the Size field to the Inbox list header:

1 From the View menu in the Inbox, choose Show Fields.  The 
Show Fields dialog appears.

2 From the Available Fields list, select Size, then click Add.  Size 
moves to the “Show these fields in this order list.”

3 Select Size, then click Move Up or Move Down to move it to 
your preferred spot in the header.

4 Click OK.

Call-Me/Meet-Me: You can also use Call-Me or Meet-Me in Out-
look with any telephone, giving you direct control over each compo-
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nent, playing the chosen voice component over the telephone, while 
opening other attachments, including faxes, on the desktop.

Independent Telephone Call and Outlook Session: If you cannot 
set up Call-Me or Meet-Me remotely, you might use the method of 
the independent call and Outlook session, so that you can multi-task. 
You can play voice messages over the phone as you open text mes-
sages on-screen. 

The parts of messages that play over the telephone in the independent 
session can differ from a Call-Me/Meet-Me session:

• If you have the text-to-speech (TTS) service, the independent ses-
sion allows the TUI to play text over the phone.  Text is not ren-
dered by TTS during a Call-Me/Meet-Me session. 

• A Call-Me/Meet-Me session allows you to use Outlook to choose 
which message plays over the telephone.  The independent ses-
sion does not. 

• In the independent session, you can use Outlook to see what mes-
sage is playing on the telephone, including its size, subject, parts, 
and other elements.  With this information, you can better use the 
Telephone User Interface (TUI) to control message playing.  As 
the TUI plays a message, you can tell the TUI to skip it, play it, 
skip forward or back, answer, forward, or delete it.

For details on using the telephone menus, see “Overview of Tele-
phone User Interface Functions” on page 166 in Chapter 7.

Choosing between Call-Me and Meet-Me 

Call-Me and Meet-Me differ only in how you establish the connec-
tion between your Outlook session on your PC and your telephone. 
After you have make the connection, performance does not differ.

You might prefer Call-Me to Meet-Me, because it entails no tele-
phone dialing—the Telephony Server calls you.  Be sure to say 
“hello” to establish the session.  On the other hand, to use Call-Me, 
you need to enter the telephone number that the Telephony Server is 
supposed to call.  Both are simple operations. 

Call-Me and Meet-Me use different resources on the Telephony 
Server, and sometimes, certain resources may not be available.  If you 
cannot establish a Call-Me or Meet-Me connection, report the 
instance to your system administrator, so that the administrator can 
re-evaluate the allocation of resources.
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Using Call-Me and Meet-Me

There are two ways to establish the telephone-computer connection:

• Set your preferences in the Unified Messaging tab so that a Call-
Me or Meet-Me session starts automatically when you open a 
unified message.

• Click Initiate Call-Me/Meet-Me on the Outlook toolbar.

CAUTION! Do not use Call-Me/Meet-Me with personal or offline 
folders.  Outlook will quit.

To start a Call-Me or Meet-Me session automatically:

1 Choose Options from the Inbox Tools menu.

2 Select the Unified Messaging tab, shown in Figure 3-3.

Figure 3-3   Unified Messaging Tab

The Default Audio group in Player/Recorder Options offers 
options to play voice attachments through your speakers or tele-
phone (using Call-Me/Meet-Me).

3 Select Call-Me/Meet-Me.

The Call-Me/Meet-Me group contains choices independent of the 
Default Audio group.  You are simply choosing between Call-Me 
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and Meet-Me as your preferred connection method, once you 
have chosen to establish a combined session.

4 To set Meet-Me as your preferred connection method, select 
Meet-Me.

5 To set Call-Me as your preferred connection method, select Call-
Me@.

6 To set a telephone number to be called when you open a unified 
message using Call-Me, enter the telephone number in the box to 
the right of Call-Me@.

If your PBX requires that you enter an access code to access an 
outside line, precede your extension in the field with that code.

To reach your Telephony Server in another area code, enter your 
local access code if necessary, 1 (in the U.S.), the Telephony 
Server area code, and the local phone number, just as you would 
dialing the telephone.  For example, if the access code is 9, the 
area code is 777, and the phone number is 123-4567, enter 
917771234567.

If you do not enter a phone number in the Call-Me field, when-
ever a Call-Me connection initiation process begins, a dialog will 
prompt you for the number.  The dialog also gives you the option 
of switching to a Meet-Me session or cancelling the connection.

7 Click OK.

To establish the telephone-computer connection manually:

1 Click Initiate Call-Me/Meet-Me in the Outlook toolbar.  

or

from the Inbox Tools menu, choose Initiate Call-Me/Meet-Me.

What happens next depends on what preferences you have set in 
the Unified Messaging tab, as described above. 

If Call-Me is set as the default, but no phone number is set in the 
Unified Messaging tab, the dialog shown in Figure 3-4 appears.
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Figure 3-4   Call-Me/Meet-Me Connection Dialog

2 To use Call-Me, select Call-Me, enter your phone number, then 
click OK.

or

to use Meet-Me, select Meet-Me, then click OK.

If you chose Call-Me, the dialog shown in Figure 3-5 appears. 
When your phone rings, pick up the telephone receiver.

Figure 3-5   Call-Me Connection Status Message

3 Click OK on the Call-Me Status dialog, as shown in Figure 3-6. 
The message opens.

Figure 3-6   Call-Me Connection Confirmation Message

4 If you chose Meet-Me, an initialization status window briefly 
appears, followed by the status window shown in Figure 3-7.  To 
complete the Meet-Me connection, dial the Message Center and 
log in to your mailbox.  When an on-screen confirmation mes-
sage appears, click OK.
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Figure 3-7   Meet-Me Status Window

Playing Audio Using Call-Me/Meet-Me

When you invoke Call-Me/Meet-Me and open a unified message that 
contains a voice attachment, the audio plays through your telephone. 
You can only play the audio through the telephone from QuickPick or 
the Unified Read Message form, not from the Inbox.  Messages 
played from the Inbox play through desktop media.

If auto-play is set as your preference in the Unified Messaging tab 
(see “Using QuickPick and Auto-play with Unified Messages” on 
page 91), the message begins playing immediately. 

If auto-play is not set, to play a voice attachment using Call-Me/
Meet-Me:

1 Open the message.

2 Double-click the voice attachment icon in the list, or select it and 
click Play in the toolbar. 

See “Creating Unified Messages” on page 91 for information on cre-
ating messages using Call-Me/Meet-Me.

Using the Unified Fax Printer with Call-Me/Meet-Me

A Call-Me/Meet-Me session does not automatically start when the 
Unified Fax Printer opens a New Unified Message form in the course 
of creating a fax.

To use a Call-Me/Meet-Me session to add a voice attachment to a 
message with a Unified Fax attachment:

1 Click Initiate Call-Me/Meet-Me to establish the combined com-
puter-telephone session

2 Create the fax, as described in “Creating Faxes” on page 128 in 
Chapter 5.  When the form opens with the fax attached, you can 
use the telephone as a surrogate microphone to record the voice 
attachment.  For details on recording, see “Creating Unified Mes-
sages” on page 91.
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Ending a Call-Me/Meet-Me Session

You can end a Call-Me or Meet-Me session in several ways:

• Click Terminate Call-Me/Meet-Me, the last button on the right 
end of the Outlook toolbar, next to Initiate Call-Me/Meet-Me.

• Choose Terminate Call-Me/Meet-Me from the Outlook Tools 
menu.

• Quit Outlook.

• Do nothing.  Your systems administrator will generally set up the 
Telephony Server so that Call-Me and Meet-Me sessions are can-
celled if there is no activity on the phone line within a certain 
time. 

CAUTION!  Do not simply hang up the telephone.  The PBX 
does not relay the hang-up to the Telephony Server, so the port 
stays open and is unavailable to other callers.

QuickPick and the Unified Read Message Form

In the Unified Messaging tab, you can choose whether QuickPick or 
the Unified Read Message form opens to display unified messages 
when you double-click a unified message in the Inbox list.  For infor-
mation on setting the default form type, see “Using QuickPick and the 
Read Message Form” on page 89.

The default condition is that QuickPick opens.  QuckPick, shown in 
Figure 3-8, is a small window that lists the message components, 
including any embedded thread of message replies and forwards 
(antecedents) and their components.  
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Figure 3-8   QuickPick Window

The QuickPick component list gives you direct access to any part of 
any message in the thread.  The icons represent the components, indi-
cated by type—text by the text icon, and so forth.  Note that the icons 
used to represent the voice attachments in the example are the stan-
dard icons used by Windows to represent “.wav” files.  The icon used 
by your system will be the one associated with your default “.wav” 
application.  Telephone icons may also appear, representing “.cvv” 
sound file format voice attachments recorded in previous versions of 
OnePoint Messenger.  For details on playing voice attachments, see 
“Playing Voice Messages” on page 74.

The Unified Read Message form, shown in Figure 3-9, combines 
most of the QuickPick elements with the elements of the standard 
Outlook Read Message form. 
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Figure 3-9   Unified Read Message Form 

Two benefits of the Unified Read Message form over QuickPick are:

• Text on the message body is displayed.  In QuickPick, to view the 
body text, you must either click Change Form Size to open the 
Unified Read Message form, or double-click the text icon, which 
displays the text in your default text editing application.

• Right-clicking an attachment icon in the message body opens a 
popup menu that provides attachment options, such as Quick 
View, print, or save.

QuickPick provides two benefits over the Unified Read Message 
form:

• The QuickPick window is usually smaller, preserving screen 
space.

• QuickPick displays the complete message component list.  The 
Unified Read Message form shows only five components, then 
adds a scroll bar to display any additional components.  The 
scroll bar is shown in Figure 3-9.

Interpreting the Message Sequence

The QuickPick form in Figure 3-8 shows a series of unified messages 
that are replies to or forwards of an original unified message, the one 
at the bottom of the list from Rebecca.  The two most recent messages 
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in the sequence—from Steve and Ben—contain both voice attach-
ments and text in the message body.

The Unified Read Message form in Figure 3-9 shows part of a mes-
sage sequence.  The most recent message contains fax, text, and voice 
components, plus the embedded previous message.  Each of the com-
ponents is represented by icons in the component list.  In the message 
body, each of the components is again represented by an icon, except 
for the text in the current message, which appears complete in the 
message body.

Message Form Components

Menus: The OnePoint Messenger commands added to the menus of 
the Inbox (and other folders) also appear in the standard Outlook 
Read Message form, QuickPick, and the Unified Read Message:

• On the Help menu, the Unified Messaging Help command

• Five commands on the Tools menu:

• New Unified Message

• Play Unified

• Reply Unified

• Reply All Unified

• Forward Unified

• Initiate Call-Me/Meet-Me

• Terminate Call-Me/Meet-Me

In addition, Change Form Size (to switch between QuickPick and the 
Unfied Read Message form) appears in the Tools menu of QuickPick 
and the Unified Read Message form.  The Compose menu (Action 
menu in Outlook 98 and Outlook 2000) in QuickPick and the Unified 
Read Message form contains three unified messaging commands:

• Reply Unified

• Reply All Unified

• Forward Unified

Top Pane: The top pane of QuickPick (page 84) differs from the Uni-
fied Read Message form (page 85):

• QuickPick adds “- QuickPick” after the message Subject in the 
window title bar.
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• The Unified Read Message form header contains an Options but-
ton that opens an Options tab containing the same fields as the 
Options tab on the standard Outlook message form.

• The Unified Read Message form header displays the From, To, 
Sent (date), Subject, and Cc fields.

• The Unified Read Message form displays the same reply chain 
and message part icons that QuickPick displays, but only a partial 
list with a scrollbar for a long list.

• The Unified Read Message form displays the message body.

Fields in the Message Components List: The QuickPick (page 84) 
and Unified Read Message form (page 85) message components lists 
display the following information about each message and message 
component in the reply chain of the selected message:

• Message type indicator icons appear in the leftmost field.  An 
open or closed envelope icon indicates whether a message is read 
or unread.  The envelope is closed in Figure 3-8, indicating that 
the recipient has not yet read the letter.

Indented from the envelope are the component icons.  The icons 
are those associated with the default application that you have 
assigned to the document type.  E-mail body text is represented 
by the icon of the default text application, such as Wordpad or 
Notepad.  Unified Fax attachments, by default, are represented by 
the Imaging for Windows application icon.

• The From field shows who sent the message.  If the sender is a 
telephone caller outside the OnePoint Messenger domain, the 
field lists “Outside Caller”.

• The Date field lists the date and time the message was sent.

• The Length field shows the length of a voice message in minutes.

• The Subject field shows the subject line of the message entered 
by the sender.  If the sender is a telephone caller, the subject is 
listed as “unified message” unless the caller is replying to or for-
warding a message.

The bottom pane of the Unified Read Message form (page 85) shows 
the body of the message, including text, graphics, and attachment 
icons.  The attachment icons represent the same objects as the attach-
ment icons in the list.  For example, the Unified Read Message form 
in Figure 3-9 displays these icons in the message body:
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• The telephone icon with the label “Unified Message 2” is a voice 
attachment added to the reply chain after one previous voice or 
fax attachment.

• The icon labelled UFAX4577.TIF represents the fax in the cur-
rent message.  The application generates the number in the label.   

• An envelope icon in the message body represents the previous 
message in the reply chain.  The label under the icon is the Sub-
ject of the message.  A telephone in front of the envelope indi-
cates that the previous message was a voice message.  A fax icon 
in front of the envelope indicates that the previous message was 
generated as a Unified Fax. 

QuickPick and Read Message Form Toolbar

The message buttons to the left of the Outlook Help button are the 
standard Outlook buttons that appear on the Outlook toolbar. 
OnePoint Messenger adds the following buttons to the toolbar in 
QuickPick and in the Unified Read Message form:

Change Form Size—Toggles between QuickPick and the Unified 
Read Message form, displaying the message selected in the Inbox.

The four new message buttons that also appear on the Outlook tool-
bar—New Unified Message, Reply Unified, Reply All Unified, and 
Forward Unified.   

Delete—Deletes the current unified message and opens the next uni-
fied message in the Inbox list. 

Previous Unified Message—Displays the previous unified message 
in the Inbox list.

Next Unified Message—Displays the next unified message in the 
Inbox list.

Unified Message Player Controls

The Unified Message Player control bar, shown in Figure 3-10, 
appears below the toolbar in QuickPick and the Unified Read Mes-
sage form.  In addition, when you double-click a voice attachment in 
the message body, the player appears in a separate window, staying 
on-screen for 10 seconds after the message has played.  You can keep 
it on-screen by clicking the controls.
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Figure 3-10   The Unified Message Player

Status Display indicates how many minutes and seconds have elapsed 
since the message began to play.  It can also display other status mes-
sages.  For example, when “No License” appears, it means that your 
Full Unified Message license is revoked or otherwise not available.

Progress Indicator numerical display shows the message length.  The 
slider shows proportionately how much of the message has played. 
To move around in the message, drag the slider bar, or click before or 
after the bar to jump back or ahead in five second increments. 

For more on setting multimedia controls, see Appendix A (page 205).

Using QuickPick and the Read Message Form

You have two choices for opening a unified message, opening in 
QuickPick or the Unified Read Message form. 

Set your message-opening preference in the Unified Messaging 
tab:

1 In the Inbox, choose Options from the Tools menu.

2 Select the Unified Messaging tab.  The tab appears, as shown in 
Figure 3-3.

3 To have QuickPick (the default) display unified messages when 
you open them, select Open with QuickPick.

Or, to have the Unified Read Message form display unified mes-
sages when you open them, deselect Open with QuickPick.

4 Click Apply or OK to accept changes and close the tab.

The change takes immediate effect.

In QuickPick, to view or play a message component:

1 Double-click the component in the QuickPick list. 

When you double-click a voice attachment, it begins to play. 

Alternatively, select a voice attachment, then click Play in the 
player toolbar.

Use the controls in the toolbar to control the playing, as described 
in “Unified Message Player Controls” on page 88.

Status Display           Play  Stop  Progress Indicator        Volume control
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2 Text, fax, and other components open in their default applica-
tions.  The default application for fax attachments is Imaging for 
Windows, described in “Viewing and Annotating Fax Messages” 
on page 133 in Chapter 5.

3 When you are finished viewing an attachment in its default appli-
cation, you can close the application or leave it open to view 
other attachments.  Each attachment invokes its own instance of 
its default application. 

To open the full Unified Read Message form from QuickPick:

Click Change Form Size in the QuickPick toolbar. 

To return to QuickPick from the Unified Read Message form:

Click Change Form Size in the Unified Read Message form. 

With QuickPick disabled, when you double-click a message in the 
Inbox, the Unified Read Message form opens, displaying the message 
body and a shorter version of the QuickPick attachment list. 

In the Unified Read Message form, you can double-click a compo-
nent icon in the list to open the component, as in QuickPick, or you 
can double-click some component icons in the message body. 

Antecedent unified messages are indicated on the message body by 
icons displaying a telephone or fax next to an envelope, depending on 
their creation method.

To open an antecedent message from the Unified Read Message 
form:

Double-click the antecedent icon to open the antecedent message.  If 
the antecedent message itself contains one or more replies or for-
warded messages, to open one down in the stack, you must double-
click down through the stack to reach it. 

One of the benefits of QuickPick is that it displays the complete com-
ponent list, so that you can quickly access a component that is buried 
in a stack. 

Why would you use the Read Message form instead of QuickPick? 
The Unified Read Message form displays the message body, so you 
can see text on the message body immediately.  QuickPick shows you 
only the text icon, requiring another step to view the text.
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Using QuickPick and Auto-play with Unified Messages

As discussed above (“QuickPick and the Unified Read Message 
Form” on page 83), QuickPick is an optional way to view unified 
messages.  Auto-play is another control option.  With auto-play set as 
your preference, the first voice attachment in the selected message 
begins to play when you open the message.  With auto-play on, even 
if the first voice attachment (most recent) is buried in an attached 
antecedent message, it plays automatically.

You can invoke QuickPick and auto-play independently.  Auto-play 
runs in either QuickPick or the Unified Read Message form.  Quick-
Pick and auto-play are on by default.  Use the Unified Messaging tab, 
as shown in Figure 3-3, to change one or both options.

To enable or disable QuickPick:

1 Open the Unified Messaging tab: From the Inbox Tools menu, 
choose Options, then select the tab.

2 Select Open with QuickPick to enable QuickPick, or deselect 
the setting to disable QuickPick. 

3 Click OK to accept the change and close the dialog.

To enable or disable Auto-play:

1 Open the Unified Messaging tab as above.

2 Select Auto-play voice messages to enable Auto-play, or dese-
lect the setting to disable Auto-play. 

3 Click OK to accept the change and close the dialog.

As soon as you select an option and click OK, it takes effect.

Creating Unified Messages

While you can continue to use the standard Outlook message form, 
OnePoint Messenger provides a new mail form—the New Unified 
Message—that enables you to add all of the media types that you can 
with the standard form, while giving you more options for adding 
voice and fax attachments.  Also, the recipient of a unified message 
has more options for accessing and managing messages.

The New Unified Message and standard Outlook message forms are 
interoperable.  In other words, you can reply to or forward either form 
with either message form.
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You can open a New Unified Message form from nearly every win-
dow—any folder, incoming message form, or QuickPick.  Use the 
toolbar buttons, as described in “OnePoint Messenger Buttons Added 
to the Outlook Toolbar” on page 65, or equivalent new unified mes-
sage commands from the Tools menus.

For details on creating fax messages using OnePoint Messenger, see 
“Creating Faxes” on page 128 in Chapter 5.

Recording a Voice Message

There are two basic ways to record a message that the Unified Mes-
sage Player can play—computer microphone or telephone.  For more 
on tuning desktop multimedia, see “Tuning Your Multimedia Setup” 
on page 205.

There are several ways to use a telephone to create voice messages. 
You can call yourself and leave a voice message for someone else, 
then, in Outlook, forward it or copy it to a new message addressed to 
that person.  You can use Call-Me or Meet-Me.  As discussed in 
“Choosing between Call-Me and Meet-Me” on page 78, there are sev-
eral ways to start Call-Me or Meet-Me.  If you set Call-Me or Meet-
Me as your default audio, a combined computer-telephone session is 
invoked when you open a New Unified Message form. 

or

From the Inbox, click Initiate Call-Me/Meet-Me.

NOTE: If you set Call-Me or Meet-Me as your default audio, a Call-
Me/Meet-Me session will not start automatically if you use either of 
these methods to compose a New Unified Message:

• Directly reference the Outlook File Templates by double-
clicking Unified.oft or Unified.Fax.oft in Windows Explorer. 

• Select the Unified Message form from the Organizational 
Forms library in Outlook

Recording a voice message and creating other message components is 
the same whether you record on the desktop or in a Call-Me/Meet-Me 
session.  The telephone is a substitute for a microphone and speakers.

If you reply to a message with a voice message, the antecedent mes-
sage is automatically attached to the reply form. 

To remove the antecedent message from the reply:

Click the attachment in the reply form, then press [Delete].
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To create a voice message:

1 Decide whether to record using a microphone or telephone. 

2 To record using the telephone, start a Call-Me/Meet-Me session. 
If your preferences are set so that a Call-Me/Meet-Me session 
does not start automatically when you open a unified message, 
from the Inbox, click Initiate Call-Me/Meet-Me.

3 Click a unified message button, either New Unified Message, 
Reply Unified, Reply All Unified, or Forward Unified, in any 
window.  To respond to or forward a message, select the mes-
sage, in the Inbox, QuickPick, or in the incoming message form, 
before opening a New Unified Message form.

A unified message form opens with the recorder control bar, 
which looks like the Unified Message Player with several more 
buttons, as shown in Figure 3-11.

NOTE: If a message contains antecedents, you can reply only to the 
current message from QuickPick.

Figure 3-11   OnePoint Messenger Recorder
.

4 You can assemble a message in any order—type text, add other 
attachments, record a voice message, and address it.

5 To record, click Record.  As you record, the volume indicator 
shows how loudly you are recording.  For information about the 
volume control utility included with Windows, see Appendix A.

6 Click Stop when you are finished.  The Display Window shows 
the length of the recording in minutes and seconds.  If it displays 
“No License”, contact your administrator.

7 To review your recorded message, click Play.  You have the 
same controls as in the Unified Message Player.  To stop and con-
tinue the message replay, click Stop, then Play.You can drag the 
Progress Indicator to replay a section or simply click to the left 
or right of the indicator to jump the message backward or forward 
five seconds.

Attach
Display Volume

control
 Mic.
 levelWindow

Play

 Stop
Delete

Record

Progress
Indicator

 voice
file
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8 To adjust your playback volume, use the Volume Control utility, 
the controls on your speakers, or click the Volume arrows on the 
Recorder toolbar.

9 To append to the end of the message, click Record.

10 To discard the recording, click Delete.  You can then re-record. 

11 If you want to attach another recording or file, click Attach to 
first attach the current recording.

12 Complete the recipient fields (To, Cc, Bcc), the Subject field, 
and the message body as you would a standard Outlook message.

13 Click Send to send the message.

Unified Message Attachment Icons and Labels

When you attach a file to a unified message, the attachment icon rep-
resents the associated application, just as on standard Outlook forms. 
When you record a voice message on a New Unified Message form, 
the voice attachment appears on the form represented by a “.wav” 
icon, as shown in Figure 3-12.

Figure 3-12   New Unified Message Form

The voice attachment label is “Unified Message” followed by a num-
ber that represents the total number of attachments in the message. 
For example, if you record a voice attachment to a message that 
already contains another attachment, your voice attachment label is 
“Unified Message 2.”

When you reply to or forward a unified message, that previous mes-
sage becomes an attachment to your message, represented by an icon 
that displays a telephone in front of an envelope.  Its label comes from 
the Subject field of the message.  The attached unified message may 
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itself contain a unified message antecedent, in which case opening it 
would also reveal the same icon.  The icon of the antecedent counts as 
one attachment, incrementing your voice response label number by 
one.

A unified message opened with the Unified Fax Printer, or one for-
warding a unified message made with the Unified Fax Printer, display 
fax icons, as described in “Viewing and Annotating Fax Messages” 
on page 133.

When you copy an attachment from a unified message to a standard 
Outlook form, including a forward or reply, the icons and labels are 
preserved.  The reverse is also true.

Considering your Recipient’s Messaging LImitations

In the not-quite-merged worlds of telephone and e-mail, you need to 
consider how your recipient accesses messages.  Issues include:

• Does your recipient generally access messages from an e-mail 
reader or from a telephone, and is one or the other unavailable?

• How well do the messaging systems that you and your recipient 
use communicate between each other?

• Does your recipient have full unified messaging, none at all, or 
some level in between?

If you know of, or are not sure of, limitations in communicating some 
forms of multimedia to your recipient, you should design your mes-
sage to conform to those limitations.

Sending Voice Attachments

The OnePoint Messenger 2.0 sound file format is a “wave” format 
with the extension “.wav”.  This is the most common format in the 
Windows world, so your Windows recipients will probably have a 
default player for it.  The older OnePoint Messenger sound format is 
the OKI format (“.cvv”  extension), which is not supported by many 
sound players.  For those older “.cvv” messages that you have stored 
that you want to forward to someone who might not have a player, 
you can include in your e-mail the Unified Message Player, which is a 
148k file labelled “ribbit.exe” in your \OnePoint Messenger\bin 
directory.  The same Unified Message Player can also play “wave” 
formats.



96 Chapter 3. Using OnePoint Messenger with Outlook

To use the Unified Message Player as a registered application:

1 The recipient of a unified message should first double-click the 
voice attachment to make sure that a player is not already regis-
tered for the “.cvv” extension.

2 If a player is not registered, save the sound file and ribbit.exe to a 
local directory.

a. On the Outlook message, right-click the file, then choose 
Save As from the popup menu.

b. In the Save Attachment dialog, navigate to the directory in 
which you want to save the file, then click Save.

3 In the local directory, double-click the sound file.  The Open 
With dialog appears.

4 Click Other, navigate in the dialog to ribbit.exe, then click Open.

You can double-click unified message voice attachments in Outlook 
to play them.  The player launches as an independent application.

Replying to Callers

With OnePoint Messenger on Outlook, you can reply directly to any 
e-mail address and to phone numbers within the OnePoint Messenger 
domain.  If you try to use Outlook to reply to a phone number outside 
the domain (the From field displays “Outside Caller”), an error mes-
sage appears.

Here are some options for replying to people outside the OnePoint 
Messenger domain:

• Of course, if you know the person’s e-mail address or phone 
number, you can simply send a message or call.

• You can create a text reply in Outlook, then use a telephone to 
call your mailbox and route the message to the caller’s fax 
machine.  See “Routing Fax and E-mail Messages to a Fax 
Machine” on page 147 in Chapter 5 for details.

• If you receive a phone message from an outside caller, in Outlook 
you can create a reply with the sender’s message attached by 
copying the call into a New Unified Message.

• After recording a caller’s message, the OnePoint Messenger Tele-
phone User Interface (TUI) prompts the caller to enter a callback 
phone number.  That number appears in the Subject line of the 
message, so that you can quickly see what number to call.
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To use Outlook to create a reply to a phone call from an “Outside 
Caller” with the caller’s message attached:

1 Open the message to which you want to reply in the Unified Read 
Message form.

2 Select the voice attachment, then press [Ctrl-c] to copy it.

3 Close the message.

4 Click the New Unified Message form button on the Outlook tool-
bar.

5 Enter your message.

6 Below your message in the message body, press [Ctrl-v] to paste 
the caller’s message.

Using Text in Unified Messages

Enter text on a New Unified Message form just as you do on a stan-
dard Outlook mail form.  You can enter text without adding voice, or 
before or after you record. 

You can relate text to attachments by adding the attachments and then 
adding text notes that relate to each attachment.  The text-attachment 
sequence is preserved by Outlook, but can get thrashed by other mail 
systems, so be aware of what mail system your recipient uses.

If your recipient has some degree of unified messaging and generally 
accesses messages from a telephone but does not have a text-to-
speech (TTS) option or an engine to convert e-mail into faxes, text 
that you send is not accessible from the telephone.

If your recipient is a OnePoint Messenger TTS user, consider these 
constraints:

• The TTS engine pronounces each letter of words entered in all 
capital letters, such as acronyms.  The exception is “TTS,” which 
it translates to “text-to-speech.”

• TTS analyzes context, so instead of speaking most punctuation 
marks, it renders them into their intended usage, such as 
upwardly inflecting a sentence that ends with a question mark. 
On the other hand, TTS pronounces some characters meant as 
punctuation.
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Addressing and Sending Unified Messages

Address and send a unified message as you would any Outlook mes-
sage.  You can address a unified message before or after you create it.

To enter a recipient address, you have the standard options:

• Reply messages are automatically addressed, except those that 
arrive from outside callers routed from your telephone.

• Enter enough of the recipient’s name in the address field of your 
message so that Outlook can recognize the intended addressee, 
then press [Ctrl-K] or click the Check Names button.  You can 
enter aliases in your own Contact and Personal address books that 
resolve more quickly to your favorite recipients.

• Copy senders’ addresses or their copied recipients’ addresses 
from the senders’ messages.

• To send a message to a VPIM address (a VPIM-compliant voice 
mail or e-mail system—see “Communicating with Users of Other 
Voice Mail Systems” on page 29 in Chapter 1 for an introduction 
to VPIM), enter the recipient’s VPIM address as it is known to 
the recipient’s mail system.  The standard VPIM addressing for-
mat is:

[VPIM:<recipient phone number>@.VPIM.<Internet 
domain>]

For example, to send a message to a user with the telephone num-
ber of (408) 555-1234 at myco.com, enter:

[VPIM:4085551234@VPIM.myco.com]

What must actually appear in the area occupied by “<recipient 
phone number>” depends on what address is entered on the recip-
ient’s own mail server.

If you have created an entry in your Contacts or Personal folder 
for your recipient’s VPIM address, or your Exchange administra-
tor has created a VPIM “Custom Recipient” (routing mailbox) for 
your recipient, you can enter your recipient’s Exchange alias, 
then have Exchange resolve the alias into the VPIM address.

• To send a unified message to a OnePoint Messenger user at 
another Exchange Site, you can preserve the unified message 
metadata by entering the address in the VPIM format or by using 
the recipient’s alias, as described above.
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• Address messages to distribution lists that you or your Exchange 
administrator creates.  A distribution list can contain both e-mail 
and VPIM addresses.

Sending your Message

All standard Outlook message options are available for unified mes-
sages, such as requesting a return receipt, Make Confidential, and 
Make Urgent.  To set addressing options, select the Options tab on 
the New Unified Message form.  For details, see your Outlook docu-
mentation.

After completing the recipient addresses and all desired fields on the 
message form, click Send at the left end of the message form tool-
bar.For details or addressing and sending, see your Outlook docu-
mentation.

NOTE:When you send a message that contains attachments to a 
voice mail system, generally that system will be unable to process 
some types of attachments.  Parts of the message may be delivered. 
Those that are not will generate non-delivery notices in your Inbox. 
For example, NuPoint Messenger accounts can render only the voice 
and fax components of VPIM messages.

Saving and Deleting Unified Messages

You can save and delete unified messages using all of the standard 
Outlook commands:

• When you send a message, it is saved by default in your Sent 
Items folder, in the Mail group in your Outlook Bar.  You can 
change that option using the Sending tab under Options in the 
Tools menu.  See your Outlook documentation.

• Use the Options tab on the New Unified Message form to choose 
where to save the current message in the same way as for a stan-
dard Outlook message

• To a draft without sending, from the form File menu, choose 
Move to Folder. 

If you are offline, you can place your new message in your Out-
box to send when you connect to the Exchange server. 

• You can save a draft or an annotated e-mail that you have 
received, by choosing Save from the File menu of either the mes-
sage form or the Inbox.  The message appears in your Inbox.
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To save a voice message as a separate file on your local disk:

1 Select the voice icon on the message form.

2 Right-click the icon, then choose Save As from the popup menu. 
The Save As dialog displays file name with a “.cvv” extension or 
“wav” extension, depending on the file type.  If you change the 
extension, it will no longer be opened by the Unified Message 
Player.

or

From the File menu, choose Save Attachments.

Deleting Messages

You can delete unified messages using all standard Outlook methods. 
In the read form or QuickPick, you have two choices:

• To delete the current message and replace it in the window with 
the next unified message, click Unified Delete on the toolbar.  

• To delete the current message and replace it in the window with 
the next message of any type, click the standard Delete button.

To discard a new unified message without sending it:

1 Press [Esc]. 

2 When the message “Do you want to save changes?” 
appears, click No. 

Printing Messages

With OnePoint Messenger in Outlook, you have the same print 
options that you have with standard Outlook.  You can print e-mail 
text and faxes from your PC on a printer.  When you send unified 
message that has a voice or other attachment to a printer, the icons are 
printed as they appear on the message body.

See Chapter 5 for details on printing faxes, see “Routing Fax and E-
mail Messages to a Fax Machine” on page 147 in Chapter 5.
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Where to Go from Here

• To use OnePoint Messenger on the World Wide Web with             
Internet Explorer™ and Netscape™ to receive and send voice 
messages, see Chapter 4, “Web Access to Exchange” on 
page 103.

• To use OnePoint Messenger to view, annotate, create, and send 
faxes via telephone or e-mail, see Chapter 5, “Using OnePoint 
Messenger Fax Features” on page 125.

• To use your PC to configure or modify the telephone user 
interface, such as recording your name and greeting announced 
on the telephone, see Chapter 6, “Setting Preferences” on 
page 153.

• To learn how to use the Telephone User Interface (TUI), see 
Chapter 7, “Using OnePoint Messenger from a Telephone” on 
page 165.

• To learn how to test your multimedia controls, see Appendix A, 
“Tuning Your Multimedia Setup” on page 205.

• To learn about standard Windows controls, which are used with 
Outlook, see Appendix B, “Standard Windows Controls” on 
page 209.

• To find a desired topic, see the Table of Contents or the index of 
this book.
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4.   Web Access to Exchange

This chapter discusses how to use OnePoint Messenger with Internet 
Explorer 4.01+ or Netscape 4+ to access and use your Exchange mail-
box.  It contains the following sections: 

NOTE: OnePoint Messenger adds the OnePoint Messenger Web Cli-
ent to Outlook Web Access only for Exchange 5.5.  “Web Client” in 
this guide refers to the combined interface of the OnePoint Messenger 
Web Client with Outlook Web Access.  Outlook Web Access is avail-
able for all Exchange users.  The Web Client is available to you if 
your site has the Web Client site license and you have Full Unified 
Messaging rights.

What You Can Do with the Web Client

If you site has the Web Client site license, you have the Full Unified 
Messaging user license, you can use the Web Client to perform many 
of the same functions that you can with OnePoint Messenger on Out-
look, including playing and creating voice messages.  To do this, use 
either Microsoft Internet Explorer 4.0+ or Netscape 4.0+ on a Win-
dows PC to connect to your Exchange Server website.  If you do not 
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have the Full Unified Messaging user license, you cannot create voice 
messages, but you can receive and play them.

Choosing between the Web Client and Outlook to Access 
Messages

The main purpose of using a Web browser instead of Outlook to 
access mail is that it gives you easy access from any computer with 
LAN or Internet access to your Exchange Web server.

Web Client advantages include: 

• Minimal software installation and no Exchange profile setup.

• Convenience: If you already have the browser running for 
another reason, you can also access your mailbox, datebook, and 
other Outlook folders.

• Fewer computer resources required than for Outlook, including 
less RAM and disk space used.

The Web Client has fewer features than Outlook, specifically:

• No access to the Outlook folders that you keep on your local PC, 
such as your Personal Address Book.

• Fewer views of your desktop than Outlook provides, such as My 
Computer, Favorites, and Personal.

• Limitations in the use of some Outlook folders, such as Notes, 
Journal, and Tasks.

• Fewer view control options, such as sorting options, filters, and 
message summary views.

• You cannot edit your spoken name and telephone greeting 
through the Web Client.

• If you connect remotely, download and upload times will proba-
bly be slower than on the LAN.  The Web Client shows you the 
file size of each message in the message summary, so you can 
choose which messages to download if you have a bandwidth 
constraint.

When playing a voice message through the Web Client, OnePoint 
Messenger reduces the fidelity of the message slightly to help in 
getting an uninterrupted message when using a smaller band-
width Internet connection.  The message remains in the original 
rich encoding on the Exchange server.

• Call-Me/Meet-Me is not available in the Web Client.
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Connecting to Your Mailbox through the Web

NOTE: In this chapter, regardless of whether the example screen 
images are from Internet Explorer or Netscape, the appearance of the 
Web Client is the same in both browsers.

To connect to your Exchange Server website:

1 From your Exchange administrator, obtain your logon ID 
(“alias”) and Exchange website URL (address).

You may use two forms of the URL—one that you will use from 
the company LAN and another for remote use.

Figure 4-1  Browser Logon Screen and Password Screen

2 In your browser Address edit box, enter the URL of your 
Exchange Server, as shown in Figure 4-1.

3 In the Logon field on your Exchange Microsoft Web Access 
Logon page, type your logon ID (“alias”), then press [Enter].

Typically, your alias is the name that you use to log on to the net-
work on your office computer, and your password is your Win-
dows network log-on password.

Address window
o

Logon window

Password Screen overlaid on Logon Screen
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4 If a Username and Password Required screen like that shown 
overlaid on Figure 4-1 above appears, type your alias and pass-
word in the appropriate fields.

If your Exchange Server is not the primary domain controller, 
you must enter both your network domain name and personal 
alias in the User Name field on the Username and Password 
Required screen in this form:

<domain>/<alias>

 For example, if your network domain name is “Building 4" and 
your alias is “fred,” type:

Building 4/fred

Typically, your password is your primary computer network 
logon password.

Errors on Logon

If you receive an error message when you attempt to log on, check:

• Did you attempt to link directly to your mailbox URL, rather than 
access it through the Logon screen?

• Did you enter your name, domain, or password incorrectly? 

• Is Exchange or the link with Exchange down, or too busy to pro-
vide you service? An error of this type may generate a screen 
with the text 

“error ASP 0115...Unexpected error.../exchange/USA/
logon.asp....”

• Do you have the correct browser; only Netscape 4.0+ and Internet 
Explorer 4.0+ are certified with OnePoint Messenger.

The Exchange Web server has a timeout setting.  If you do not 
actively use your Web Client session, Exchange disconnects you.  If 
that happens, or you receive an error message, restart your browser 
before logging in again.

Downloading Plug-ins

When you first log in to your mailbox using a Web browser from a 
PC on which OnePoint Messenger for Outlook is not installed, a plug-
in for playing voice messages is downloaded to your computer.
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Netscape Plug-in

Whether or not you have OnePoint Messenger for Outlook installed, 
when you first log in using Netscape, Exchange senses that you need 
the Voice Player plug-in for Netscape, providing the dialog shown in 
Figure 4-2.

Figure 4-2  Netscape Plug-in Download Start Dialog

To download the Netscape plug-in:

1 Click OK on the “Netscape Plug-in Download Start Dialog” dia-
log.  A page appears titled “OnePoint Messenger Player/Recorder 
Download Page.”

2 Click Download Plug-In Now.  A security screen appears, as 
shown in Figure 4-3.  If you have other applications open, it may 
not appear on top.  Minimize the other applications, or press [Alt-
Tab] to the plug-in screen.

Figure 4-3  Netscape Plugin Download Security Alert 

3 Click Grant.  The SmartUpdate: Unified Messaging Player/
Recorder Plug-in screen appears.

4 Click Install.  A JavaScript message screen appears displaying 
“The Unified Messaging player/recorder Plug-in is installed.” 
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5 Click OK.

6 On the screen labelled Unified Messaging Player/Recorder 
Download Page, click Login.

Introduction to the Web Interface

The Web Client Inbox is shown in Figure 4-4.

Figure 4-4  Web Client Main Screen.

Do not use your browser menus and buttons to control the Web Cli-
ent.  Use the “Web Client” toolbar, shown annotated in Figure 4-4.

Using Web Client Online Help

When the Web Client is open, there are three online help systems: 

• Browser Help: The Help menu in the top menu bar contains the 
online help for your browser, not for the Web Client.

• Outlook Web Access Help: For basic Outlook Web Access help, 
click the question mark button at the right end of the toolbar.  The 

Web Client HelpList page #Message Summary List Sort Options

Outlook Web Access HelpUnified message icon   Delete check box

Web Client toolbar
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Help buttons on the Options and Find Names pages also access 
Outlook Web Access help.

• Web Client Help: For help with the Web Client, click the ques-
tion mark/telephone icon.  Both the Outlook Web Access and the 
Web Client help systems are in HTML and load from Exchange.

Web Client Main Screen

The main screen, shown in Figure 4-4, contains a toolbar and three 
frames that you can size—the Inbox, Folder View, and the Outlook 
Bar.  Each contains a hyperlinked list.

The Web Client has fewer options than Outlook for organizing mes-
sages and folders.  You are able to create Inbox subfolders and move 
messages to them.  You cannot sort the Inbox list by clicking a col-
umn header.

Sorting the Message List

The “Message Summary List Sort Options” box in the middle of 
the toolbar in Figure 4-4 enables you to select from a list of several 
ways to sort your incoming messages.  You can sort by subject by 
selecting the “Subject” option in the Message Summary List Options 
list.  Voice messages using the default “Unified Message” subject will 
appear together in the list, as shown in Figure 4-4.

Figure 4-5  Message List Sort Options 

• Page #: The Web Client downloads one page of your Inbox mes-
sage list at a time.  Click the Next and Previous arrows to move 
between pages of the Inbox list.

To jump to a particular place in the list, type the page number, 
then click Page.  The Web Client lists the number of pages of 
entries, for example “Page 1 of 11." 

Inbox Toolbar Buttons

There is one change in functionality for the standard toolbar buttons.  
The Create New Message button opens a New Unified Message 
form.  That is the only new message form available.  For details, see 
“Creating Messages In the Web Client” on page 116.
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Below the right end of the toolbar is Compose New, another way to 
open a new message form.  The Compose New popup menu contains 
links to forms, including Mail Message, Custom Form, Appoint-
ment, Meeting Request, and Post to this Folder.

To choose an option from Compose New:

1 Click the down arrow.

2 Choose an option from the list.

3 Click Compose New to open the selected form.

The Inbox toolbar buttons are:

Hold the mouse over a button for ToolTips.

Inbox Message List

The Inbox message list contains fields equivalent to those in Out-
look—Message Urgency, Message Class Icon, Subject, and 
Received date.  Two fields are different from the default Outlook 
toolbar:

• The Delete check box at the left end of the message summary

• The File Size field at the right end of the message summary

Compose new message

Compose new post message

Check for new mail

Move/copy a folder

Delete selected messages

Create new folder

Delete selected folder

Empty deleted items folder

Update page address
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Knowing the file size helps you decide whether or not to down-
load a file.  If it is a large file, you might defer accessing it until 
you have a better connection.

The message class indicator icons that appear in the Web Inbox mes-
sage list are the same as those in Outlook.

• A telephone icon in the Inbox list means the message is a tele-
phone call or the sender created the message on a Unified Mes-
sage form.

• A fax icon appears when the message is generated by the Unified 
Fax Printer or when a telephone user sends a fax unaccompanied 
by a voice message.  A message with a telephone icon can con-
tain a fax, but does not display the fax icon unless created in one 
of these two ways.

• The standard Outlook paperclip icon appears in the attachment 
field of all unified messages that contain voice or fax attach-
ments.

You can use Web Client to read faxes, and you can attach files created 
by Unified Fax Printer to messages you create in Web Client.  How-
ever, Unified Fax Printer does not automatically open a form in Web 
Client with the fax attached, as it does with Outlook.

Other Folders

Just as in Outlook with Exchange 5.5, two lists of folders are avail-
able to you through your Web browser.

• The Outlook Bar is the vertical bar on the left edge of the screen.

• Folder View is the next column, showing an Explorer-like view 
of folders.

Each bar appears in a separate frame, so you can drag the Outlook Bar 
and Folder View borders to the sizes that you want.

Outlook Bar

The Outlook Bar has a single array of folders: Inbox, Calendar, Find 
Names, Public Folders, Options, and Log Off.  Web Client supports 
message creation from each of the folders.

The Options button provides access to the Out of Office Assistant 
and Calendar options.  Out of Office Assistant enables you to set up 
an automatic message response to incoming e-mail, typically to tell 
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your correspondents that you received their e-mail but will be away 
for a period of time and unable to respond.

Click the Log Off button at the bottom of the Outlook Bar before you 
leave the website, then close your browser to ensure that your mail-
box closes.

The Find Names button in the Outlook Bar is for directory searches.  
Use it to look up the address of intended recipients of your message 
before you open a New Message form.

If you are connected to Exchange 5.5, you can see all of your 
Exchange folders in the Folder View to the right of the Outlook Bar:  
Sent Items, Outbox, Deleted Items, Task List, Journal, and Notes.  In 
addition, you can create subfolders using the Web Client.

To access your private folders:

1 In Folder View (click the up arrow above “Inbox.” The Folder 
View changes to display a list under the heading “Mailbox.”

2 In Folder View, click a folder name.

3 To return to the Inbox, click the Inbox button on the Outlook Bar.

Public folders contain information needed by many people in your 
organization.  You have the same access to public folders through 
your Web browser as you do through Outlook.  You can send mes-
sages and files to public folders to which you have publishing permis-
sion by clicking Post to Folder on the main screen.  Unified 
messaging is not supported for public folders.

To access public folders:

• On the Logon screen, click Public Folders.  Only public folders 
that are available to everyone appear using this method.

• On the Outlook Bar or Folder View, click Public Folders to 
reach all the folders for which you have access permission.

Playing Voice Messages In the Web Client

Web Client presents messages somewhat differently from Outlook:

• Selecting the message (one click) opens the message form.

• There is no QuickPick or QuickPlay.

• Graphics placed ("embedded") on the message body do not dis-
play.
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• You cannot edit the Subject field in the Inbox list.

• Voice auto-play is always enabled.  One click on a message plays 
the first voice attachment.  Auto-play is activated only if there is 
no other attachment other than voice.

• When you open and close a message, the Unread status indicated 
by bold text in the Inbox list does not update until you click 
Update page address. 

A voice message is indicated on the Read Message form by the pres-
ence of the sound player and a file attachment with a “.cvv” or ".wav" 
label, depending on the source format, as shown in Figure 4-6 .  If 
there is no voice message, the player control bar does not display.

Figure 4-6  Web Client Read Message Form, Voice Message

To play a voice message:

Remember that the top menus are for your browser and do not control 
the Web Client.

1 In the Inbox list, click the sender’s name of the message that you 
want to open.  The message form opens and displays any body 
text and the voice attachment icon.  The first voice attachment 
plays automatically.

NOTE: Do not click the voice attachment on the message body, 
only the Play button on the player control bar.  Although the file 
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attachment type is listed as ".wav" or ".cvv", the attachment plays 
in a "streaming" proprietary format called TruSpeech.

2 Just as in Outlook, you can use the sound player controls to con-
trol the volume and the part of the message to replay, all or part.   
To play the message again, click Play.

If there two voice attachments on the form, two sound player con-
trol bars appear, along with two message icons in the message 
body, as shown in Figure 4-7.  The top player controls the most 
recent message, which plays automatically as the form opens.  To 
play the other message, click the Play button on the lower control 
bar.

Figure 4-7  Two Voice Messages on One Form

 
3 To save the voice attachment, right-click the file, then choose 

Save Link As.  The file is saved in wav format.

4 To close the Read Message form, click Close at the top of the 
form.

or

If you scroll down the form to view a long message, the Close 
button disappears from view, so click the Close box in the top 
right of the form.

or

Click Previous Message (up arrow) or Next Message (down 
arrow) on the form’s toolbar to access the message above or 
below the current message in the Inbox list.

A limitation of the Web Client is that it does not display non-voice 
content when combined in the same forwarded message with a voice 
attachment.  For example, if the forwarded message contains a voice 
attachment and body text, the Web Client displays an icon on the new 
message with a label representing the Subject of the forwarded mes-
sage.  The player will play the voice attachment, but the other content 
will be unavailable.  Clicking the icon of the forwarded message 
yields an error message in a separate window.
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Managing Messages In the Web Client

In the Web Client, you can sort messages, reply, forward, or delete 
them, create or move folders, add messages to folders, and other mes-
sage management functions.  Some functions are in the Inbox; others 
are in the Read Message form.  The toolbar buttons in the Read Mes-
sage form as shown in Table 4-1.

Table 4-1 Read (Incoming) Message Form Toolbar Buttons

Sorting Messages in the Web Client Inbox

You can sort your incoming messages in several ways.  The Inbox 
toolbar contains a list view options window providing these sort 
options: 

• Messages—Messages sorted by date.

• Unread Messages—Displays only unread messages.

• By Sender—Displays messages sorted by sender.

• By Subject—Displays messages sorted by subject header.

Reply to the sender of the selected message 

Reply to the sender and recipients of the selected 
message

Reply to a selected post in a folder

Forward the selected message

Move/copy a folder

Delete the selected message

Display the “previous” message (the message above 
the current one in the Inbox list)

Display the “next” message (the message below the 
current one in the Inbox list)

Display Outlook Web Access Online Help

Display the Web Client Online Help
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• By Conversation Topic—Displays indented list of messages 
sorted by subject.  The originating message is the top message.

• Unread by Conversation Topic—Displays indented list of 
unread messages sorted by conversation thread.

You can use the sort options in other folders, such as Sent Messages.  
The message preview option is not available in the Web Client.

Marking as Read or Unread

Messages that you have not read appear in bold in the Web Client.  
Viewing and closing the incoming message does not update the sta-
tus.  To update the Read/Unread status, click Check for New Mail on 
the main screen toolbar.

Deleting Incoming Messages

You can delete messages from the message summary on the main 
screen or from the Read Message form.

To delete messages from the message summary:

1 Click the Delete box to the left of the message that you want to 
delete, as shown in the message list sample in Figure 4-8.

Figure 4-8   Message Summary Delete Check Box 

2 To select several messages to delete, click the Delete boxes next 
to those messages.

3 To delete the selected messages, click Delete on the toolbar.

To delete a message in the Read Message form:

Click Delete on the Read Message form toolbar, shown in Table 4-1.  
The message form closes, returning you to the Inbox.

Creating Messages In the Web Client

You can use the Web Client to create messages with all content 
types—text, voice, fax, and other attachments—except embedded 
graphics.  Also, to attach a fax, you must attach it from a saved file, 
not using Unified Fax Printer to open a form.



Creating Messages In the Web Client 117

All New Message forms in the Web Client contain the recorder con-
trol bar, so you do not need to decide which kind of form you need to 
record voice.

Reply and Forward buttons are only available on the Read Message 
form, while the Compose New Message button is only available from 
the Inbox.

To create a new message:

On the main screen, click Compose New Message.

To reply to or forward a message:

1 In the Inbox list, click the message to which you want to reply to 
or forward.  The Read Message form opens.

2 Click the appropriate button (Reply, Reply to All, or Forward) 
at the left end of the incoming message form tool bar, as shown 
above in Table 4-1.  These are the same message buttons used in 
Outlook to create a text message, and they work the same as in 
Outlook, except that they open a message form that includes the 
Recorder toolbar.

When you reply to a message, your message does not automati-
cally include the attachments from the antecedent message.  The 
best way to automatically include the original message in a reply 
is to forward the message to the sender.

Clicking any of the new message buttons opens the message creation 
form shown in Figure 4-9.  As in Outlook, you can type text in the 
message body and send it without recording a voice message, text can 
accompany your voice recording, or you can simply record a voice 
message with no text.

To make a voice recording, use the recorder on the form.  The process 
is the same as in Outlook, except that you cannot use Call-Me or 
Meet-Me with the Web Client.

To add file attachments, see “Attaching Other Files To Your Mes-
sage” on page 119.
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Figure 4-9  Web Client New Unified Message Form

Recording Voice Messages

The voice recorder is the same as used in Outlook with a slightly 
modified control bar (a reminder above the bar to click Attach)

Figure 4-10  Voice Recorder.

To record a voice message:

1 Click Record  to begin recording.

2 Click Stop  to stop recording.

3 Click Play  to review your message.

Toolbar:
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2=File
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4=High Priority
5=
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4 To modify the recording, click Record again to append, or click 

Delete  to start over.  See also “Recording Multiple Voice 
Messages” on page 120.

5 Click Attach to attach the voice attachment to the message.  Wait 
until the word “SAVING” disappears from the Status Display 
window.  The voice file is attached as a ".wav" file that any Win-
dows or Macintosh computer can play.

An alert also appears below the recorder toolbar indicating the 
number of voice attachments.  For example, if there is one voice 
or fax attachment, the alert displays “1 Attached Voice Message”.

No attachment icon appears in the message body of the outgoing 
message.  Instead, the voice attachment appears in the list of 
attachments on the Attachments tab, shown below in 
Figure 4-11.

NOTE: You must have a sound card (or equivalent motherboard 
sound chip) and microphone on your PC.  To test the recording, you 
must have speakers on your PC.  Web Client does not support Call-
Me/Meet-Me.  For details on Call-Me/Meet-Me, see “Using Call-Me 
and Meet-Me” on page 79 in Chapter 3.

Attaching Other Files To Your Message

When creating a voice message, you are attaching the voice file.  You 
can include text along with your voice message, assembling the mes-
sage components in any order.  You can also attach other files.

You can attach a fax to a new message in the Web Client using Uni-
fied Fax Printer.  Open your document in an application with a print 
menu, then choose Unified Fax Printer from the print menu printer 
list to save the document as a fax image, as described in “Creating 
Faxes with Unified Fax Printer” on page 128 in Chapter 5.

To attach or unattach a file to your message:

1 Select the Attachments tab on the message creation form.  The 
Attachments tab appears, as in Figure 4-11.

2 Click Browse to find your file, or type its path.

3 Click Attach File.  The file name appears in the list.

4 To attach another file, repeat the steps.
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5 To delete an attached file, select the file, then click the button at 
the left end of the list summary bar.

Figure 4-11  Mail Form, Attachments Tab 

Recording Multiple Voice Messages

You may want to create several voice messages on one mail form.  
For example, you may want to annotate an incoming message in sev-
eral places in your reply.

To record multiple voice messages:

1 Record your message, as described above.

2 Click Attach to attach the message.

3 Record the next voice message.

4 Click Attach to attach that message.

5 Repeat the record-and-attach process for each voice message.
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Saving Draft Messages

To save an unfinished message you are creating:

1 Type a subject in the Subject field.  Otherwise, you will not be 
able to reopen it from your browser.

2 With the mail form open, click Save on the toolbar.  The mail 
form stays open and the message is saved in your Inbox with no 
sender listed.

3 You can close the message form and reopen it by clicking on the 
subject line in the main screen message list.  If you do not see it, 
try sorting by sender or click Update Mail. 

Addressing and Sending Messages

If you need an address, it is easiest to obtain it from your directory or 
message list before you open the new message form.  If you are not 
sure of the address or would rather copy and paste rather than type, 
see the next section, “Finding an Address in the Directory.“

To address and send your message:

1 Type or paste the full e-mail addresses of your recipients (use 
OnePoint Messenger domain or Internet SMTP forms of 
addresses) in the To and Cc fields.

To send a message to a VPIM-compliant voice mail system or to 
a OnePoint Messenger user at another Exchange Site to preserve 
the unified message metadata (see “Using Voice Profile for Inter-
net Mail (VPIM)” on page 28 in Chapter 1), enter the address in 
the same VPIM format as you would enter in Outlook:

[VPIM:<user mailbox number>@.VPIM.<Internet domain>

For example, to send a message to a user with the telephone num-
ber of (408) 555-1234 at myco.com, enter:

[VPIM:4085551234@VPIM.myco.com

2 To convert partial addresses to complete addresses, click Check 
Names

3 You can assign a High Importance or Low Importance flag to 
the message by choosing the appropriate button on the toolbar.

4 Click Send at the left end of the toolbar.  The message form 
closes and the main the Web Client screen appears.
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CAUTION! Clicking Close cancels the message.

If your message is undeliverable because the address is incorrect or 
has expired, you will receive an alert, but generally not immediately.

Finding an Address in the Directory

To find an address, check in your own mail stack, in a public folder, 
or in the company e-mail directory.

To find an address when you are in your mail creation form:

1 Press [Alt-Tab] to switch from the mail form to the Inbox win-
dow.

2 Click Find Names on the Outlook Bar on the main screen.  A 
search interface appears, with fields for last name, first name, and 
other search options.  If you need help using the interface, click 
Help on the Find Names form for context-sensitive help.

3 Select a field to search based on the text you enter.  For example, 
type the first few letters of a last name in the Last Name field.

4 Click Find.  Exchange lists names from the directory that include 
your text.

5 Select the name for which you want to open the address card.  

6 Triple-click the address listed on the address card of your recipi-
ent.  Copy it using [Ctrl-C] (or right-click, and choose Copy).

7 Click Close on the Address card and again on the Find Names 
window.

8 Press [Alt-Tab] to return to your mail form window.

9 Paste using [Ctrl-V] (or right-click and choose Paste) or type the 
address.

When you send a message that contains attachments to a voice mail 
system, generally that system will be unable to process some types of 
attachments.  For the parts of the message that cannot be delivered, 
non-delivery notices are sent to your Inbox.
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Where to Go from Here

• To use OnePoint Messenger to view, annotate, create, and send 
faxes via telephone or e-mail, see Chapter 5, “Using OnePoint 
Messenger Fax Features” on page 125.

• To use your PC to configure or modify the telephone user 
interface, such as recording your name and greeting announced 
on the telephone, see Chapter 6, “Setting Preferences” on 
page 153.

• To learn how to use the Telephone User Interface (TUI), see 
Chapter 7, “Using OnePoint Messenger from a Telephone” on 
page 165.

• To learn how to test your multimedia controls, see Appendix A, 
“Tuning Your Multimedia Setup” on page 205.

• To learn about standard Windows controls, which are used with 
Outlook, see Appendix B, “Standard Windows Controls” on 
page 209.

• To find a desired topic, see the Table of Contents or the index of 
this book.
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5.   Using OnePoint Messenger Fax 
Features

This chapter explains how to use OnePoint Messenger to view, anno-
tate, create, and send faxes using your PC and telephone.  It also 
describes how to download or forward combinations of fax and text 
e-mail to a fax machine.  It concludes with a discussion of Fax on 
Demand.  The main sections are: 

OnePoint Messenger Fax Options

OnePoint Messenger provides options to create, send, receive, view, 
and manage faxes.  You can create faxes from all four client inter-
faces—Outlook, Web Client, Unified Fax Printer/Image Maker, and a 
telephone.

The popularity of fax machines has diminished, but there are several 
reasons why OnePoint Messenger makes fax images more useful:

• You can send a softcopy of your document to someone who may 
not have software to view your document in its native form.

• You can send an uneditable softcopy of your document when you 
want to minimize the possibility that the recipient can edit it.

Section Page

OnePoint Messenger Fax Options 125

Creating Faxes 128

Sending Faxes through Outlook 131

Viewing and Annotating Fax Messages 133

Printing Faxes 142

Using A Telephone to Access Fax Features 143

Where to Go from Here 151
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• You can easily create an image of a Web page (or other 
document) to attach to a mail form and save in your own mailbox, 
so that you can send it and/or organize it in a project folder.

• E-mail a fax image with added voice or text notes.

• Send a hardcopy document through a fax machine to yourself (or 
others), so that you have it available from your Inbox.

• Send a document as a fax from your PC to your recipient’s fax 
machine or VPIM-compliant voice mail system (see Chapter 1 
“Using Voice Profile for Internet Mail (VPIM)” on page 28.)

• Download faxes and text e-mail to yourself or to others by calling 
your mailbox and directing the message to a fax machine (the 
Text-to-fax feature).

Other fax management features include:

• View and annotate an incoming fax message on your PC, then 
save it, or print to a printer or fax machine, or resend it.  See 
“Viewing and Annotating Fax Messages” on page 133 and 
“Printing Faxes” on page 142.

• Reply to a fax or voice message sent from another voice mail 
system.  Reply with voice, fax, or a combination of both.

• Simultaneously view a fax on your PC and listen to the attached 
voice message when you receive messages containing both voice 
and fax attachments.

• Send faxes from a fax machine to the mailbox of a OnePoint 
Messenger user.  See “Sending Faxes to a OnePoint Messenger 
User by Phone” on page 145.

• Route text and fax messages to your fax machine or forward them 
to someone else’s fax machine or mailbox.  See “Routing Fax and 
E-mail Messages to a Fax Machine” on page 147.

• Maintain a Fax on Demand (faxback) list (maintained by the 
Telephony Server administrator) for general access, such as for 
customers who want literature or forms.  See “Creating Faxes 
with the Fax on Demand Service” on page 133.
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Unified Fax Printer Overview

With the Unified Fax Printer feature of OnePoint Messenger 2.0, you 
can now send a fax through Outlook and Exchange directly to a fax 
machine or to any voice mail system that is VPIM-compliant (see 
Chapter 1, page 28).  Also, see “Sending Faxes through Outlook” on 
page 131.  Also, using Unified Fax Printer, you can turn a softcopy 
document into a fax to:

• Send directly to a fax machine.  This option is called QuickFax.  
See “Using QuickFax to Send a Fax to a Fax Machine” on 
page 129.

• Automatically open a New Unified Message form in Outlook 
with the fax attached.  See “Sending Faxes through Outlook” on 
page 131.

• Save a document or image in TIFF format.  As a file, the fax 
image is available at any time for printing and faxing or for 
attaching to a Web Client or Outlook message.  You can also edit 
the file in ImageMaker Viewer (included with OnePoint 
Messenger) or Imaging for Windows (bundled with Windows), 
then save it as a TIFF file, or use Unified Fax Printer within one 
of those programs to send the fax through QuickFax or Outlook.

Overview of Fax Options Using a Telephone

Using a telephone, of course you can dial a voice mail system or fax 
machine to deliver a fax, but OnePoint Messenger offers additional 
options.  You can direct a fax to any fax machine by calling your 
mailbox, accessing the message containing the fax, then forwarding it 
to the fax machine.  You can do the same with text components of 
messages that are in your Inbox.  See the next section, and see “Creat-
ing Unified Messages” on page 91 in Chapter 3 of this guide, and see 
“Routing Fax and E-mail Messages to a Fax Machine” on page 147.
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Creating Faxes

In addition to the standard methods of faxing printed documents from 
one fax machine to another, you can use OnePoint Messenger to gen-
erate faxes:

• As noted above, use the Unified Fax Printer feature to create 
faxes from any application, including from Web pages.  See 
“Creating Faxes with Unified Fax Printer” next.

• Convert text e-mail to faxes by routing the message to any fax 
machine.  See “Routing Fax and E-mail Messages to a Fax 
Machine” on page 147.

• Send a document through a fax machine to a OnePoint Messenger 
mailbox. See “Sending Faxes to a OnePoint Messenger User by 
Phone” on page 145.

• Forward a fax in a unified message.  See “Sending Faxes through 
Outlook” on page 131

• Send a document to your Telephony Server administrator to put 
on the Fax on Demand list.  See “Using Fax on Demand” on 
page 150.

NOTE:  You can annotate a received fax in ImageMaker Viewer or 
Imaging for Windows and resend it to people who have those view-
ers, but the annotation tools render the document unviewable to many 
other TIFF viewers.

Creating Faxes with Unified Fax Printer

As described above, Unified Fax Printer is a OnePoint Messenger 
print driver dialog that enables you to choose from several ways to 
create a fax from a document and route it to a fax machine, e-mail 
account, or disk file.

NOTE:  To use the Unified Fax Printer described in this chapter, you 
must install it, either separately or with the other OnePoint Messenger 
components, as described in Chapter 2 (page 43).  Also choose the 
Windows multimedia option from your Windows installation disk.

OnePoint Messenger installs Unified Fax Printer in the Windows 
printer resource list so you can create a fax image of a document in 
any application that has a print menu.  When creating the fax image, 
you can choose to save the image as a file, send the fax directly to a 
fax machine, or have Unified Fax Printer open a New Unified Mes-
sage form in Outlook and attach the fax image to it.



Creating Faxes 129

To create and send a fax using Unified Fax Printer:

1 Open an application that has a print menu.

2 Use the application to create (or import or open) the document of 
which you want to create a fax image.

3 Select Unified Fax Printer in the list of printer options, usually 
on the File menu under Print Setup, Page Setup, or Print.

4 Click OK (or the Print button equivalent) for the application.

5 Choose one of the options on the Unified Fax Printer dialog, as 
shown in Figure 5-1, to create a multi-page TIFF format fax 
image of your document.

Figure 5-1  Unified Fax Printer Dialog

• To send the document directly to a fax machine, you can use 
QuickFax or Outlook.  To use QuickFax, see “Using 
QuickFax to Send a Fax to a Fax Machine” on page 129.  To 
use Outlook, see “Sending Faxes through Outlook” on 
page 131.

Using QuickFax to Send a Fax to a Fax Machine

To deliver a fax from your computer to a fax machine, you can use 
Unified Fax Printer in two ways, as described above.  To skip the cre-
ation of a unified message in Outlook, select QuickFax on the Uni-
fied Fax Printer dialog.  The QuickFax option also gives you the 
ability to add a personal fax cover page.

To send a fax using QuickFax:

1 Open the Unified Fax Printer dialog, and select QuickFax, and,  
in the dialog that appears, enter the fax machine telephone num-
ber of your recipient as you would dial it, as described above.
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2 To add a personal cover page, click Create Cover Page, then 
click OK.  The Cover Page Generator dialog opens, as shown 
completed in Figure 5-2.

Figure 5-2  Personal Fax Cover Page Generator

3 Complete only as many of the fields as you want.  The data you 
enter and selections you make appear as defaults in the Cover 
Page Generator dialog the next time you open it, so you will not 
need to reenter static information.  You will probably only want 
to change the recipient data.

a. To select a different cover page form from the current 
default, click the Style down-arrow.  When installed, the 
form associated with "Sheet 1" contains a logo field at the top 
of the form.  The other two forms do not contain a logo field.

b. For the Logo and Signature fields, click their down-arrows 
to select one of the .pcx-format files installed in the 
\OnePoint Messenger\Fax directory.

c. To use a different image file in either field, replace one of the 
existing files with your file; delete an existing .pcx file in the 
\Fax directory, then save your file with the name of the 
deleted file.

• Logo: Logoact.pcx appears in the dialog as Logo1, logo-
sys.pcx as Logo 2, and logoxyz.pcx as Logo 3.

• Signature: Sigfred.pcx appears as Signature 1, sig-
tom.pcx as Signature 2, sighand.pcx as signature 3, and 
sigken.pcx as Signature 4.



Sending Faxes through Outlook 131

4 Click Preview to review the completed cover page, then click 
Create to send the fax.

NOTE:  If you do not select Create Cover Page, the mail server 
attaches your organization’s default cover page, substituting your 
name and the sending and recipient phone numbers.

Sending Faxes through Outlook

There are several ways that you might send a fax through Outlook:

• You can forward a fax that you have received in your Inbox.  You 
can do so with a standard Outlook form, or, to use a Unified 
Message form, select the message containing the fax, then click 
Forward Unified.

• You can attach a fax, saved on a disk drive, to a standard Outlook 
form, or, to use a Unified Message form, click New Unified 
Message, then, on the form, choose File from the Insert menu, 
navigate in the popup Insert File dialog to the fax file, and 
double-click it, or select it, and click Insert.

• As described in “Creating Faxes with Unified Fax Printer” on 
page 128, you can use Unified Fax Printer to create a fax 
attachment to a Unified Message form in Outlook.   Outlook does 
not need to be running when you create the fax.

In all three cases, you can then send the message to an e-mail recipi-
ent or to a fax machine. 

To send a fax from Outlook to an e-mail recipient:

1 With the document open tht you want to send as a fax (for exam-
ple, a document open in Microsoft Word), from the Print menu, 
select Unified Fax Printer from the list of printers, then click 
Print.

2 On the Unified Fax Printer dialog that opens, select Compose 
Fax Message.  A Unified Message form opens with the fax 
attached, as indicated by an icon with the label "UFAX" followed 
by a number.

3 Enter e-mail recipient addresses, a subject, and select delivery 
options as you would any standard e-mail message.  For details, 
see “Creating Unified Messages” on page 91 in Chapter 3.

4 Click Send.
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To send a fax from Outlook to a fax machine:

1 Follow the procedure above to create the fax, but recognize that 
only the fax and the text that you add to the body of the e-mail 
message are rendered in a fax.

enter the fax machine phone number in the To or Cc field in this 
form:

[FAX:<fax machine phone number>]

Enter the number just as you would in your office fax machine.  If 
you must normally dial a prefix digit to access an outside line, or 
if you normally must enter 1 before entering an area code, do so 
here also.  For example, if you must enter 9 for an outside line 
and 1 and the area code 408, when sending a fax to 333-4444 in 
that area code, enter:

[FAX:914083334444]

NOTE:  To send the fax using a VPIM address and in VPIM format 
to a VPIM-compliant voice mail account, address it using the recipi-
ent’s VPIM alias, or enter the recipient’s VPIM address, which is typ-
ically constructed in this form:

[VPIM:<user telephone number>@.VPIM.<Internet domain>

For details, see “Using Voice Profile for Internet Mail (VPIM)” 
on page 28 in Chapter 1.

Creating Faxes Offline

If you have an Exchange account, Unified Fax Printer, and Outlook, 
you can create a fax even if you are not connected to Exchange.  
Using Unified Fax Printer, you have two options:

• Select Print to File to save the document as a fax image in a file.  
You can then send it by attaching the file to a message in Outlook 
or Web Client.

• Choose Compose Fax Message to attach the document as a fax 
image to a Unified Message form in Outlook.  You can then save 
the message as a draft until you connect to your Exchange Server.

To save your fax draft in your Outlook Outbox:

1 From the File menu on the message form that contains your fax, 
choose Move to Folder.
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2 Select Outbox in the list of folders in the Move Item To dialog, 
then click OK.

3 When you are ready to finish preparing and sending your e-mail, 
select Outbox in the Mail group of the Outlook Bar.

4 Double-click the message in the Outbox list.

5 Add any voice, text, or attachments you want, then address and 
send the message as you would with any e-mail.  See “Sending 
Faxes through Outlook” on page 131 for details.

Creating Faxes with the Fax on Demand Service

Fax on Demand is a OnePoint Messenger service managed on the 
OnePoint Messenger Telephony Server by the Telephony Server 
administrator.  Fax on Demand, or “faxback,” means providing a list 
of faxable documents accessible by list number through a designated 
telephone number.  You can make a document available for general 
distribution by having your administrator add it to the Fax on 
Demand list.  For details on accessing the list, see “Using Fax on 
Demand” on page 150.

Viewing and Annotating Fax Messages

The Outlook Inbox can contain faxes that you receive from fax 
machines or as e-mail attachments.  It can also contain faxes that you 
create and save as attachments to New Unified Message forms.

When someone using an application other than OnePoint Messenger 
sends a fax as an attachment, the e-mail appears in the Inbox list rep-
resented by the standard Outlook envelope.  The fax attachment is 
indicated by the attachment paperclip icon in the list, and on the mes-
sage body by the icon of the graphic viewer associated with the file 
type extension used by the fax.

When a fax arrives that was created with Unified Fax Printer directly 
to a New Unified Message, the fax icon appears in the message sum-
mary.  In the message form, the symbol associated with your default 
TIF viewer represents the fax, along with a “UFAX<number>” label.  

When you use Unified Fax Printer to create the fax, then save it, then 
attach it from the saved file to a New Unified Message, a telephone 
icon appears in the Inbox message list.
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If someone uses a standard form to forward or reply to the fax, the 
Inbox list displays the standard closed envelope before you view it, 
and displays the standard open envelope after you view it.

When you open a standard e-mail containing a forwarded unified fax, 
the forward is represented on the message body of the standard form 
by a fax in front of an envelope.  The subject of the forwarded mes-
sage is below the icon.  When you double-click that icon, QuickPick 
or the Unified Read Message form opens and displays the fax attach-
ment icon and any other contents, as shown in Figure 5-3. 

Figure 5-3  Unified Read Message Form with Fax Attachment 

Organizing Faxes

To view a summary of received faxes, sort the Inbox list by message 
type, as shown next.  This will align messages by icon type.  Unified 
messages displaying the fax icon will align, but unified messages in 
which the fax was added as a second attachment will be in the group 
displaying telephone icons.

To sort the Inbox by message type:

Click the message type icon in the list control bar.  Figure 5-4 shows 
two messages in the Inbox list.  The top message displays the fax 
indicator icon.
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Figure 5-4  Inbox, Message Type Indicator Sort Button

Viewing the Fax

To select a fax message to view using the toolbar:

1 From the Inbox list, double-click the fax message you want to 
view.  Either QuickPick or the Unified Read Message form 
opens, depending on your set preferences.

2 Double-click the fax icon in the message form or QuickPick list 
to invoke ImageMaker Viewer or Imaging for Windows to view 
the fax image.  An example fax in Imaging for Windows appears 
in Figure 5-5.

3 When you are finished viewing and annotating the fax, choose 
Exit from the File menu to quit ImageMaker Viewer or Imaging 
for Windows.

4 In the Read Unified Message form or QuickPick, your options 
include clicking Next or Previous to view the next or previous 
message, Delete to delete the current message and open the next 
message (or Delete Unified for the next unified message), or 
opening a new message form.

5 To return to the Inbox from the message form or QuickPick, press 
[Esc] or choose Close from the File menu.

or

To return to QuickPick from the message form, click Change 
Form Size.

Using Imaging for Windows

Imaging for Windows is the default application included with 
Windows 95, 98, and NT for viewing and annotating multi-page uni-
fied faxes.  ImageMaker Viewer is a program with similar but smaller 
annotation toolbar.  When you double-click a Unified Fax Printer 
attachment to open it, whichever program is registered as your multi-
page TIFF viewer launches and displays the fax.  Imaging for Win-

message type sort button
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dows is shown in Figure 5-5.  Both programs have online help.  If you 
prefer, you can choose another TIFF viewer.

Figure 5-5  Fax Displayed in Imaging for Windows 

In both Imaging for Windows and ImageMaker Viewer, you can 
manipulate unified faxes in several ways:

• Flip or rotate the fax if it arrived upside down or sideways.

• Choose a magnification level to see details or an overview.

• Select a page to view from a multi-page fax.

• Use anti-aliasing features to enhance fax readability.

• Annotate the fax.
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Imaging for Windows also has thumbnail overviews of all pages, or 
you can see a combination of full page and thumbnail views.

Using the Imaging for Windows Toolbar

You can use the Imaging toolbar or find the same commands in the 
menus.  Except for the Scan button at the left end of the toolbar, those 
buttons invoke typical commands (New, Open, Save, Print, Select 
(area), Drag, and open Annotation Toolbox).

Figure 5-6 shows the buttons that appear at the right end of the Imag-
ing for Windows toolbar:

• The Rotation buttons turn the image 90 degrees in either 
direction.  To flip a page, from the Page menu, choose Flip.

• The Page selection buttons show the previous or next page, or 
you can designate a page to view by page number.

• Page scaling options are: 

• Zoom In, Zoom Out, and Zoom Selected (to the selected 
area)

• Full Page View, All Thumbnails View, and Page and 
Thumbnail View (combination of full page next to thumb-
nails, as shown in Figure 5-7).

Figure 5-6  Imaging for Windows Toolbar for Page Manipulation

Rotating a Fax

You may receive a fax that was sent upside down or sideways.  To 
compensate, you can flip or rotate your fax images in any 90-degree 
increment.  You can rotate individual pages or all the pages in your 
fax with a single command.  The left and right rotation tool buttons 
appear on the toolbar, shown in Figure 5-6.  The Page menu contains 
more options.

Using Thumbnail Views 

Figure 5-7 shows the fax from Figure 5-5 after clicking the combina-
tion Page and Thumbnail View.  A thumbnail image of each page of 
the fax appears to the left of the document.  Notice that the two 

Full page view
Thumbnail view

Page and 
Thumbnail

Rotation  Page select

View

    Zoom
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thumbnails indicate that the fax is two pages long.  The lower thumb-
nail has a larger border around it, indicating that it is the page being 
displayed.

A good way to get an overview of a large multi-page fax is to click 
All Thumbnails View, which shows thumbnails of all the pages 
arrayed across the whole display.  For example, you can use the All 
Thumbnails View to find a particular page, then select it and switch to 
Page view to view it.

Figure 5-7  Page and Thumbnail View

Zooming In and Out of a Fax

Use the zoom buttons on the toolbar or the more complete Zoom 
menu to zoom in to see detailed portions of a fax page or zoom out to 
see a thumbnail overview of the entire fax document.

Annotations               Annotation ToolboxPage thumbnails
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Annotating Faxes

You can annotate a fax before you send it or after you receive it.

The annotation toolbox is shown at the right side of the annotated 
document in Figure 5-7.  The Imaging for Windows Annotation 
menu contains equivalent commands.

In the example, a Web page has been annotated with lines, the hollow 
rectangle tool, and the text tool to note important news.

NOTE: The Imaging for Windows annotation tools render the docu-
ment unviewable to many other TIFF viewers.

You can annotate a fax in the following ways:

• Add notes by writing freeform or typing text using any available 
Windows font.

• Draw boxes, lines, and ellipses.

• Highlight or cover portions of a fax document with filled boxes 
and ellipses.

• Remove a header.

• Draw objects freehand.

• Erase portions of the fax.

• Undo and redo your editing actions.

• Move objects.

• Paste objects to and copy from the Windows Clipboard.

Using Imaging for Windows Annotation Tools

To display the Annotation Toolbox:

From the Annotation menu, choose Show Annotation Tools.

To specify tool characteristics before you start to annotate:

1 In the Annotation Toolbox, click the tool that you want to use.

2 Depress and release the right mouse button (a sustained right-
click) on the tool, then choose Properties from the popup menu 
(This will not work on low-resolution displays).

3 Properties available depend on the tool, presenting either font or 
graphics elements (e.g., line width and color).
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4 Put the cursor where you want to place the annotation, and click 
or hold the mouse down and drag the mouse pointer, depending 
on the type of annotation.

5 When entering text, type your text, then double-click the selec-
tion pointer.

To change the line width, color, or font of an existing annotation:

1 Click the Pointer tool in the annotation toolbox.

2 Click the annotation to select it.

3 Click the right mouse button, then Properties from the popup 
menu.

The Imaging for Windows annotation toolbox includes these tools:

Pointer—Click this, then select annotations for to delete, move, or 
change.  You can also click this to deselect the other annotation tools.

Text—To enter text, click the Text tool, move the cursor to the inser-
tion point, click the left mouse button, and begin typing.

Text from File—To insert text, select the tool, then click where you 
want to place the annotation.  In the dialog, select the text file to use, 
then click Open.  To adjust the position, font size, font color or other 
properties, click the selection pointer, then select the text.

Rubber Stamp—Click this and select a stamp from the list that 
appears (Approved, DRAFT, Received, Rejected).  Alternatively, you 
can choose Rubber Stamps from the Annotation menu and create 
your own stamp.  Point the cursor at the part of the fax where you 
want the stamp to appear, then click.

Select Region—Use this tool to select the region of a fax you want to 
copy or cut.  Place the top left corner slightly above and over the area 
you want to select, then drag the lower right corner down and to the 
right until the dashed box encloses the desired area.

To delete the selected area of the fax image and place it on the Clip-
board, from the Edit menu, choose Cut.

Freehand Pen—Use this tool to draw images freehand in the same 
way you use a pencil or a pen.  To draw an image, click the Pen tool, 
move the pointer to the place you want to start, hold down the left 
mouse button, and begin drawing.  To stop, release the mouse button.  
Use the Properties menu to set line width and color.
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Hollow Rectangle—Draws a hollow rectangle.  You can change the 
line width and the color of the outline, and specify whether the color 
is transparent or not.

Solid Rectangle—Draws a filled box.  Use the Properties menu to set 
the color.

Line Tool—Draw horizontal, vertical, or diagonal lines.  To draw a 
line, click the Line tool, move the pointer to the place you want to 
start, then hold down the left mouse button as you drag the pointer 
across the screen.  A thin line represents the line’s size and position.  
When the line is the length you want, release the left mouse button.  
Use the Properties menu to set line width and color.

Combining Documents

You can use Imaging for Windows to assemble a new fax from two or 
more documents.  You can insert pages from one document into, or 
append one to the other.  You can choose which pages from a multi-
page document to insert into or append one to the open document.

For example, you might receive a multi-page fax that contains one 
page that you want to replace with updated information.  You could 
annotate the existing page or replace it with a new page.

To use Unified Fax Printer to replace a page with a new page:

1 Open or create the document from which you want to extract 
information into the existing fax.

2 Print the document to a file using Unified Fax Printer.

3 In Imaging for Windows, select the page of the fax to replace.

4 From the Edit menu, choose Delete Page.

5 From the message box, click OK to confirm deletion.

6 From the Page menu, choose Insert, then Existing Page.

7 In the Insert dialog that appears, navigate to the document that 
you want to use, then choose Open.  The Insert dialog then offers 
two Range choices—All or selected Pages.

8 Select Pages, enter the page range in From and To.  Click OK.

Forwarding or Answering a Fax

If you have received a fax and have only viewed it without annotating 
it, you can resend it without recreating it.  Close the fax viewer, return 
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to Outlook or WEB Client, select the message with the fax, then 
choose one of the forwarding or reply options.

To send an annotated the fax, first print it to a new fax using the Uni-
fied Fax Printer.  For details, see “Creating Faxes with Unified Fax 
Printer” on page 128.

NOTE: Before sending, consider printing your annotated fax to 
proofread it.

Saving Faxes

You have two ways of saving an annotated fax:

• Create a new fax image from it.

• Save the revised image to a file on disk.

To save a document from Imaging for Windows to a file:

Click Save on the Image Maker Viewer or Imaging for Windows 
toolbar.  You may want to save often, because there is no Undo com-
mand.

Alternatively, from the File menu, choose Save or Save As:

• Save stores the TIFF image in your designated Temporary 
(TEMP) directory.

• Save As offers a choice of location and type (.ano or .cvr—
coverpage template—in Image Maker Viewer or BMP or TIFF in  
Imaging for Windows).  BMP is a single-page format, while TIFF 
supports multiple pages.

To open a saved fax document in Imaging for Windows:

Click Open on the toolbar or, from the File menu, choose Open.

NOTE:  Be sure to save your fax with its changes before forwarding 
or resending it.

Printing Faxes

In Outlook, in Web Client, and from a telephone, a fax appears in a 
unified message as an attachment.  In Outlook and Web Client, you 
can save the attachment to a disk, then open it in an imaging applica-
tion to print it, or you can select to open it from the form.  The imag-
ing application registered to view TIF images opens and displays the 
fax.  To print a fax from a telephone, you must direct it to a fax 
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machine.  For details, see “Routing Fax and E-mail Messages to a Fax 
Machine” on page 147.

To print a fax attachment:

1 Double-click the fax attachment icon in the QuickPick or Unified 
Read Message form list.  It opens in your chosen TIF viewer.

2 Click the Print button on the toolbar, or, from the File menu, 
choose Print.

3 In the Print dialog that appears, select the pages to print, the 
number of faxes per page, the number of copies, and the printer.

4 In Imaging for Windows, you can click Options to select the 
scaling option (Actual Size, Pixel to Pixel, or Fit Page) and select 
or clear Print displayed annotations.

5 Click OK.

Imaging for Windows proportionally scales a fax if it is too long 
to print on a standard 8.5 by 11 inch page.  If a fax page is longer 
than 14 inches, Imaging prints it on two pages.

6 Then use the Print menu command in that application.

When calling from your telephone, you can print e-mail text and 
faxes to a fax machine.  For details, see “Routing Fax and E-mail 
Messages to a Fax Machine” on page 147.

Using A Telephone to Access Fax Features

The following sections describe how to use your telephone to access 
OnePoint Messenger fax features:

• Setting Your Fax Delivery Number

• Sending Faxes to a OnePoint Messenger User by Phone

• Routing Fax and E-mail Messages to a Fax Machine

• Using Fax on Demand

Setting Your Fax Delivery Number

When you use a telephone to download faxes and text e-mail to a fax 
machine, you can direct the message to:

• The online fax machine (a fax machine attached to the phone 
number from which you are calling)
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• Any phone number that you enter that has a fax machine attached

• The default fax machine, as described next

Your system administrator sets a default fax delivery number for you 
in your user profile.  This allows you to call your mailbox and send 
faxes to that default fax machine without having to key in a phone 
number of a fax machine.  This capability is especially valuable when 
you are downloading many messages to a fax machine.

You can revise the default fax number through the Telephone User 
Interface (TUI).  Alternatively, ask your Exchange administrator to 
enter the new number in your profile.

To change your default fax number through the TUI:

NOTE:  References to TUI menus in procedures in this chapter are 
hyperlinks to the TUI menu descriptions provided in Chapter 7.

1 Call your mailbox by dialing your own number or calling the sys-
tem number and keying in your extension at the prompt.

2 From Menu B: Main, press [U] (the 8-key) to access Menu H: 
User Options.

3 From Menu H: User Options, press [A] (the 2-key) to access 
Menu I: Advanced Options.

4 From Menu I: Advanced Options, press [F] (the 3-key) to access 
Menu J: Fax Storage Options.

5 From Menu J: Fax Storage Options, press [N] (the 6-key) to 
access Menu K: Change Your Default Fax Number.

6 From Menu K: Change Your Default Fax Number, press [C] (the 
2-key) to access the prompt Change the Default Fax Number.

7 Enter the new fax telephone number to which to have faxes sent.

8 Press [K] (the 5-key) to choose Keep the Default Fax Number, 
or press [X] to exit to the previous menu, or just hang up.
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Sending Faxes to a OnePoint Messenger User by 
Phone

There are several ways for you to send a fax to a OnePoint Messenger 
user’s mailbox when you are calling from a fax machine that includes 
a telephone handset.  Five methods are described here.  With each of 
the first three methods, you can continue interacting with the TUI 
after you have sent the fax.

• Method 1: Send a hardcopy fax via the Message Center.

• Method 2: Send a hardcopy fax after you leave a voice 
message.

• Method 3: Send a fax message from your own mailbox.

• Method 4: Use the OnePoint Messenger Direct Inward Dial 
(DID) feature.

• Method 5: Send a walkaway fax via the Message Center.

You can also forward e-mail, including faxes, from your mailbox to 
other OnePoint Messenger users.  For details, see Menu K: Change 
Your Default Fax Number in Chapter 7.

Method 1: Send a hardcopy fax via the Message Center.

When you call the Message Center, you can connect directly to your 
recipient’s mailbox to send the fax without having your recipient hear 
fax noise.

To send a fax via the Message Center:

1 Dial the Message Center number.  At the prompt, dial the recipi-
ent’s mailbox number.

2 Listen to enough of the recipient’s greeting to be sure you have 
the correct mailbox, then press [L] (the 5-key).

3 The TUI prompts you: “To send your fax, press the Start button 
on your fax machine now.” Press the Start button on your fax 
machine.

4 After the fax is sent, you can hang up, or you can stay on the line 
to choose other options.  For details, “Learning to Use the TUI” 
on page 171 in Chapter 7.
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Method 2: Send a hardcopy fax after you leave a voice message.

When you have reached the prompt menus of a user's mailbox, as 
above or by calling the user’s unanswered telephone, you can first 
leave a voice message before sending the fax.

To send a fax after you leave a voice message:

1 Listen to the recipient’s greeting, then record your voice message.

2 Press [#] after you finish recording your voice message.

3 Press [L] (the 5-key).

4 When the TUI prompts you, press the Start button on your fax 
machine.

5 After the fax is sent, you can hang up, or you stay on the line to 
choose other options.

Method 3: Send a fax message from your own mailbox.

The process of sending a fax while logged into your own mailbox is 
similar to Method 1, sending a fax as a caller to a recipient’s mailbox.  
You have more options with this method—in creating the message, 
changing the recipient address list, addressin the fax to a distribution 
list, and other options.

When you are logged into your mailbox from a telephone, you can 
create and send messages to other OnePoint Messenger users in two 
ways.  You can send the fax from a fax machine, or you can forward a 
fax that is in your Inbox.

To send a fax from a fax machine while logged into your own 
mailbox:

1 Log in to your mailbox.

2 In the Main menu (see “Menu B: Main” on page 177), press [M] 
(the 6-key) to access Menu E: Make Message.

3 Enter the mailbox number of your recipient(s) (or the mailbox 
number of a distribution list, or use DBN (see “Dial by Name” on 
page 168).

4 If you want to record a voice message, you can do so before or 
after you send the fax.

5 Press [L] (the 5-key) to send the fax.  The TUI prompts you to 
press the Start button on the fax machine.

6 After the fax is sent, and the TUI confirms transmission, you can 
hang up, or you can use the prompt menu again.
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Method 4: Use the OnePoint Messenger Direct Inward Dial (DID) 
feature.

To use the OnePoint Messenger Direct Inward Dial (DID) feature, 
dial the user’s DID fax number (not the user’s voice phone number), 
then press the Start button on your fax machine without waiting for 
an answer.  A DID fax goes to the user’s Inbox or to a fax machine, 
depending on the PBX routing table.  When your fax machine is 
done, it will hang up.

Method 5: Send a walkaway fax via the Message Center.

Because OnePoint Messenger listens for the tone sent by your fax 
machine, you can send a fax to a recipient's mailbox without waiting 
for the prompts that tell you to start transmission.  This is quicker than 
Method 1 and completes the transmission unattended.  Because you 
do not wait to listen to the greeting, you do not hear confirmation that 
you have dialed the correct mailbox.

To send a “walkaway” fax via the Message Center:

1 Call the Message Center.

2 At the prompt, dial the recipient's mailbox number.

3 Press the Start button on the fax machine without waiting for an 
answer.  When your fax machine is done, it will hang up.

Routing Fax and E-mail Messages to a Fax Machine

If you have the Full Unified Messaging client license, you can call 
your mailbox and route text and fax messages to any fax machine.  
There are several reasons why you might want to do this:

• Your recipient needs a document sent to a fax machine, but you 
do not have good access to a fax machine yourself.  Use a 
telephone to call your mailbox and direct the document to the 
recipient’s fax machine.

• You are not presently able to log into your mailbox from a 
computer, so you call your mailbox and direct your fax and text 
messages to a convenient fax machine.

• You have Text-to-Speech (TTS) access to text messages from 
your telephone, but a message is too complicated to understand 
using TTS.  Route it to a fax machine so you can read it.

You can have faxes and e-mail messages sent from your mailbox to 
any fax machine.  Telephony Server converts the message header and 
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text body to a fax and delivers it to the number specified.  A message 
that contains text and fax components will be rendered into one fax.  
Other components, such as embedded images and attachments, will 
not be rendered.

OnePoint Messenger provides three ways for you to route text and fax 
messages from your mailbox to a fax machine:

• Routing Method 1: Route the message to your default fax 
phone number.

• Routing Method 2: Route the message to the online fax 
machine.

• Routing Method 3: Route the message to another fax 
machine.

For Routing Methods 2 and 3, Telephony Server creates a fax cover 
page, listing the sender, the recipient (it is always listed as you), and 
the destination fax number.  After prompting you to enter the tele-
phone number of the destination fax machine, the TUI offers you the 
option of specifying a hotel room number or extension number, to 
help identify the intended recipient of the fax.

You can use Routing Methods 2 and 3 to forward the message to 
someone else.  Your name is listed on the cover page as the intended 
recipient, but the hotel staff can use the room number to find your true 
recipient.

All three fax routing methods require this beginning sequence:

1 Call your mailbox.

2 When the TUI announces a message in your mailbox, press [P] 
(the 7-key) to go to Menu C: Play Message.

3 From Menu C: Play Message, press [T] (the 8-key) to go to Menu 
D: Fax Transmittal Options.

After arriving at Menu D: Fax Transmittal Options (see page 188 in 
Chapter 7), you can have the message sent:

• Directly to you (Routing Method 1)

• To your default fax number (Routing Method 2)

• To another fax machine (Routing Method 3)

After routing the fax, you are returned to Menu C: Message Playback 
(page 188), where you can choose other options, including forward 
the document to another mailbox.
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Routing Method 1: Route the message to your default fax phone 
number.

With this method you route a message from your mailbox to the fax 
machine identified in your Exchange profile as your default fax 
machine.  You can set its telephone number by calling your mailbox 
and using Menu J: Fax Storage Options (page 188), available from 
Menu K: Change Your Default Fax Number:

1 Perform the three steps in the beginning sequence of this section 
from a fax phone to reach Menu D: Fax Transmittal Options.

2 At Menu D: Fax Transmittal Options, press [D] (the 3-key).

3 At the prompt, press the Start button on your fax machine.

4 After the fax transmission is complete, either press the Stop but-
ton and continue to listen for additional mailbox option(s), or 
hang up.

Routing Method 2: Route the message to the online fax machine.

The online fax machine is at the phone number from which you are 
calling (the “online” phone).

If you have a fax machine that has a telephone handset, or have a 
phone connected to the same extension as the fax machine, you can 
call your mailbox from that phone and have a message delivered from 
your mailbox to that fax machine.

To retrieve a message at your online fax machine:

1 Perform the three steps in the beginning sequence of this section 
to reach Menu D: Fax Transmittal Options.

2 At Menu D: Fax Transmittal Options, press [R] (the 7-key) to 
send the fax to the default fax machine.

3 Choose other mailbox options or hang up.

NOTE: A fax cover page is delivered along with the message.
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Routing Method 3: Route the message to another fax machine.

To forward a fax or text message to any fax machine:

1 Perform the three steps in the beginning sequence of this section 
to reach Menu D: Fax Transmittal Options.

2 Press [I] (4-key).  The TUI prompts you for the phone number.

3 Enter the destination fax phone number.  If you are routing the 
document to a fax machine within your PBX domain, you can 
enter just the extension.  If dialing outside, add the outside dialing 
prefix.

4 After you enter the number, you can wait for the TUI to respond, 
or you can press [#] (the pound key) to alert the TUI to respond.

5 If you wait for the TUI to respond, the TUI repeats the number 
you entered for you to confirm it.  Press [A] (the 2-key), or press 
[I] (4-key) to repeat the sequence from Step 2.

6 After confirmation, the TUI prompts, “If you would like to enter 
a room or extension number, please enter the number followed by 
the pound key, or simply press [#] to have the fax sent.”  If 
desired, enter a room or extension number.

7 Press [#] to deliver the fax message.  The TUI replies “Your fax 
sent.”

8 You can now choose other mailbox options or hang up.

NOTE: A fax cover page is delivered along with the fax message.

Using Fax on Demand

The Fax on Demand feature is a service that sends documents on 
request.  Callers request documents by keying in a document number 
and a fax phone number, then Fax on Demand sends the document. 
The documents in the list can be in text or TIFF format.  Your admin-
istrator manages the list.

NOTE: If you call the Fax on Demand service to order a document, a 
fax cover page accompanies the fax message only if the fax is deliv-
ered to a number other than your default fax number.

The general user session to download documents is described next.
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To have a document sent from the Fax on Demand service to a 
fax machine:

1 Call the Fax on Demand phone number.  The TUI prompts you to 
press [1] to request the master index of the available fax docu-
ments, or press [2] to request specific documents.  You can have 
the TUI fax the master index to you, and then you can refer to this 
list when requesting specific document by index number.  The 
TUI alerts you if you enter a document number that is not on the 
list.

2 After choosing a document, you are prompted to enter the desti-
nation fax number.  Press [R] to retrieve to the number from 
which you are calling, or press [I] to enter another number.  Once 
you have entered your fax phone number, the TUI prompts you to 
request other fax documents without asking you again for your 
phone number.  You can request documents in one session up to 
the limit that the Telephony Server administrator sets.

3 If you retrieve fax documents directly to your online phone (the 
fax machine from which you are calling), listen for the fax tone, 
then press the Start button on your fax machine.

4 After the faxes are delivered, you can access other menu 
option(s).

Where to Go from Here

• To use your PC to configure or modify the telephone user 
interface, such as recording your name and greeting announced 
on the telephone, see Chapter 6, “Setting Preferences” on 
page 153.

• To learn how to use the Telephone User Interface (TUI), see 
Chapter 7, “Using OnePoint Messenger from a Telephone” on 
page 165.

• To learn how to test your multimedia controls, see Appendix A, 
“Tuning Your Multimedia Setup” on page 205.

• To learn about standard Windows controls, which are used with 
Outlook, see Appendix B, “Standard Windows Controls” on 
page 209.

• To find a desired topic, see the Table of Contents or the index of 
this book.
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6.   Setting Preferences

This chapter details the preferences that you can set in how your cli-
ent interfaces work.  It provides details on using Outlook to set your 
telephone preferences and setting up automated responses and alerts 
that support unified messaging.  It contains these sections:

NOTE:  To use a telephone to set preferences, see “Setting Tele-
phone User Interface Options” on page 196 in Chapter 7.

Preferences Overview

As described in “Setting OnePoint Messenger User Options” on 
page 34 in Chapter 1, the Microsoft Exchange administrator assigns 
one of three basic feature levels to your Exchange account, selects a 
Class of Service for you that sets privileges within those general fea-
ture levels, and sets default telephone numbers (extension, incoming 
and outgoing fax machine, and pager).

If you have the "Full Unified Messaging" feature level, you can use 
Outlook to set how Outlook handles unified messages and how the 
Telephone User Interface (TUI) presents your mailbox, as detailed 
below in “Setting Preferences on the Unified Messaging Tab”.  With 
both the Full Unified Messaging and Voice and Fax Mail feature lev-
els, you can use a telephone to manage telephone preferences (see 
page 196).  The telephone preferences that are available on the Uni-
fied Messaging tab in Outlook are also all available through the TUI.

Section Page

Setting Preferences on the Unified Messaging Tab 156

Recording and Setting Your Name and Greeting 157

Using the Out of Office Assistant to Alert Contacts 160

Creating a Telephone Message Alert 161

Where to Go from Here 163
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Telephone Settings Available on Your PC

In addition to accomplishing the following tasks from a telephone, 
you can use the Unified Messaging tab in Outlook to:

• Passcode: Change your mailbox log-in passcode that you enter 
from a telephone.

• Greetings: Record telephone greetings and set the active one.

• Spoken name: Record your name.  Your spoken name is used in 
several situations on the telephone:

• To identify your mailbox to you when you call the Message 
Center

• To identify your e-mail address to a OnePoint Messenger 
user in your organization when that person plays a message 
from you or replies to the message, or addresses an inten-
tional message to you

• To identify your mailbox to someone when you haven’t 
recorded a greeting when:

• The person calls your unanswered telephone and is 
routed to your mailbox.

• The person calls your mailbox directly to leave you an 
intentional message.

Greetings Overview

You can use the Unified Messaging tab in Outlook to record multiple 
greetings and select which of your greetings to be active.

There are four greeting categories:

• Conditional: The Conditional Greeting is set up as two greetings 
that play as a function of the following conditions:

• Busy Greeting: When you set the Conditional Greeting as 
your active greeting, the Busy Greeting plays when your tele-
phone is busy (when you are on another call).  Typically, for 
this greeting, you might record something like “I am on 
another call but will return your call as soon as I am free....”

• Ring-No-Answer Greeting: When you set the Conditional 
Greeting as your active greeting, the Ring-No-Answer greet-
ing plays at any time that you do not answer other than when 
the phone is busy.  For this greeting, you might say “I am 
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away from my desk at the moment, but I will return your call 
when I return.” 

• Primary Greeting: This is intended as a general condition greet-
ing, the one where you are not as specific in your reasons for not 
answering the call.  You might simply say “I am sorry I missed 
your call.  Please leave your name, phone number, and message, 
and I will return your call as soon as I can.”

• Out-of-Office: This greeting is intended to be the one you use to 
alert callers that you will be away for extended periods of time. 
Your greeting might include the number where you can be 
reached or the number of another contact in the office.

How the TUI Selects which Greeting to Play

An unanswered call to your telephone is routed by the telephone 
switch (PBX) to your Inbox .  If you have recorded a greeting, the 
system plays it and then prompts the caller to leave a voice message 
and/or send a fax, as described in “Menu Q: Outside Caller Messag-
ing” on page 182 in Chapter 7.

Which greeting plays depends on the greetings you have recorded, the 
greeting you enable, and on the conditions that activate the greeting.  
You can enable only one greeting—the Conditional greeting, the Out-
of-Office greeting, or the Primary greeting.  The enabled greeting 
plays to all of your unanswered calls.  Of course, in the case of the 
Conditional greeting, which is composed of two greetings, the greet-
ing that plays depends on whether your phone was busy or unan-
swered for another reason.

One of those other conditions might be that your PBX has a feature 
that allows you to transfer calls to your Inbox either manually or auto-
matically.  If you have your Conditional Greeting enabled, your caller 
has just talked to you, and you transfer him to your Inbox so he can 
deposit a fax, you could forewarn him that your Ring-No-Answer 
Greeting will play.

If you enable a greeting category for which you have not recorded a 
greeting, the TUI plays your Primary Greeting.  If you have not 
recorded a Primary Greeting, the TUI plays your recorded name, then 
plays "is not available".  Then, whether or not you record a greeting, 
the TUI prompts the caller to leave a message.  If you have not 
recorded your name, the TUI uses Text-to-Speech to render the text 
name assigned as the owner of your mailbox.
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Setting Preferences on the Unified Messaging Tab

The Unified Messaging tab added by OnePoint Messenger to Outlook 
contains your preferences for how to open and play unified messages 
in Outlook.  You can enable QuickPick, Auto-play, Call-Me, Meet-
Me, or desktop audio, as discussed in Chapter 3:

• To change your auto-play and QuickPick preference, see “Using 
QuickPick and Auto-play with Unified Messages” on page 91.

• To choose between desktop media, Call-Me, or Meet-Me to play 
and record voice messages, see “Choosing between Telephone 
and Desktop Audio” on page 76, then “Choosing between Call-
Me and Meet-Me” on page 78.

Also, you can use the Unified Messaging tab to review and record 
your name played to telephone callers, review, record, and set tele-
phone greetings, and change your telephone log-in passcode.

To set preferences on the Unified Messaging tab:

1 In the Inbox, choose Options from the Tools menu, then select 
the Unified Messaging tab, as shown in Figure 6-1, below.

2 Set preferences, then click Apply or OK.  Outlook preference 
changes take effect immediately.

Figure 6-1  Unified Messaging Tab
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Telephone greeting and name changes take up to ten minutes to take 
effect.

Recording and Setting Your Name and Greeting

If you do not record your name, Text-to-Speech (if it is activated) 
pronounces your name as entered in the name field of your mailbox.

The first time you call your mailbox from a telephone, you are 
prompted to record your name and a Primary greeting.  You can 
record them at that time or later by using the telephone.  You can also 
record or re-record your name and greeting on your PC from Outlook 
(if you have a microphone and sound card installed on your PC).

To record your spoken name from Outlook:

NOTE:  You cannot use Call-Me/Meet-Me to record your name or 
greetings.

1 Open the Unified Messaging tab, as described above 
(page 156— Tools>Options) The tab is shown in Figure 6-1.

2 To record or change your recorded name, select Name from the 
Name/Greeting list, then click Play/Record.  The player/recorder 
toolbar appears, as shown in Figure 6-2.  This is the recorder 
described in “Recording a Voice Message” on page 92 in 
Chapter 3, except that the Attach button is replaced here with 
Submit and Cancel buttons.

Figure 6-2  Recorder

3 To review your current spoken name, select Name, then click 
Play.  If you do not yet have something recorded for the name 
speech, the Play button is dimmed.

4 To record, click Record. Your name recording can be up to 10 
seconds long.

5 To stop the recording, click Stop. 

6 You can then append to the recording, review it, delete and start 
over, cancel the session without saving, or, if you are satisfied 
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with your recording, click Submit to accept your changes and 
quit the recording session.

NOTE: After you accept your changes, it may take 15 seconds, 
depending on traffic, for the recording to be saved on the server 
and for the recording dialog to close.

7 Click OK on the Unified Messaging tab.  It takes about ten min-
utes for the recording to become available to a caller.

To record a telephone greeting through Outlook:

1 Select the Unified Messaging tab, as described above (page 156).  
The tab appears in Figure 6-1.

2 To record or change a greeting, select the greeting, either Busy, 
Ring No Answer, Out-of-Office, or Primary, as described 
above, from the Name/Greeting list, then click Play/Record.

3 The player/recorder appears, as described above.  If you do not 
yet have something recorded for the selected greeting, the Play 
button is dimmed.

4 Follow the directions above (page 157) to record and control the 
playback review of your greeting.  Your greeting can be up to two 
minutes long.

5 To save your greeting, click Submit, or click Cancel to quit with-
out saving.  Click Delete to erase the recording and start over.  
Depending on the length of the greeting and the status of the net-
work and Exchange Server, it can take up to a minute for the 
recording to be transmitted and for the Recorder dialog to close.

6 To record another greeting, repeat the procedure to select it, 
review it, record it, and submit or cancel the changed greeting.

You do not need to record the greetings as they were intended.  For 
example, if you are out of the office a lot, you might use the Primary 
Greeting to say that you are generally out of the office, then give the 
caller an alternate phone number, or ask the caller to record a message 
that includes the best time to return the call the next day.

To change the active greeting:

1 Open the Unified Messaging tab if it is not already open.

2 Click the down-arrow by the Active Greeting field, then select 
the greeting to enable from the list.
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3 Click OK. It takes about ten minutes for the recording to become 
available to a caller..

For details on which greeting plays, see “How the TUI Selects which 
Greeting to Play” on page 155.  In summary, if you activate a greeting 
that you have not recorded, the Telephone User Interface plays your 
Primary greeting. In the case of the Conditional greeting, if you 
record just one part of it—Busy or Ring No Answer—and the call is 
routed to the recorded portion, it plays; if the call is routed to the 
unrecorded portion, the Primary greeting plays.  If you have not 
recorded your Primary greeting, the Telephone User Interface plays a 
system greeting that says you are unavailable, identifying you by 
either your spoken name or the Text-to-Speech version of it that is 
entered in your Exchange profile.

Changing your Telephone Passcode

How often have you forgotten your telephone passcode and had to 
ask your Exchange Server administrator to reset it?  The Unified 
Messaging tab provides you the ability to change that passcode with-
out having to remember and enter your old passcode first. The risk is 
that someone could use your PC to change your passcode.  However, 
if they can access your Outlook, then they already have access to your 
messages, so they do not have much to gain by changing your pass-
code, and doing so would alert you to the security breach.  At least the 
current passcode does not appear on the tab.

To change your telephone passcode:

1 On the Unified Messaging tab, enter a new passcode in the New 
Passcode field, then reenter it in the Re-type New Passcode 
field.

These key combinations are not allowed:

• Any sequence longer than 12 numbers.

• A passcode that is the same as the mailbox number.

• A passcode in either of these sequences: 123456 or 654321

• A passcode that is all the same number, such as 2222 or 3333

The Exchange administrator may also set a minimum and maxi-
mum passcode length.

2 Click Submit Passcode.

3 Click Apply or OK.
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Your new passcode should propagate to the Telephony Server in no 
more than 10 minutes.

NOTE:  For information on changing your passcode from the TUI, 
see “Changing your Telephone Passcode from the TUI” on page 197 
in Chapter 7.

Using the Out of Office Assistant to Alert Contacts

Outlook has an Out of Office Assistant feature that you can use to 
alert people who send you e-mail when you are unavailable.  The Out 
of Office Assistant configuration screen appears in Figure 6-3.  The 
Out of Office Assistant does not alert telephone callers.

Figure 6-3  Out of Office Assistant

To add the Out of Office Assistant and Inbox Assistant to the 
Tools menu:

1 Check to see if Inbox Assistant and Out of Office Assistant 
appear on the Tools menu on the Outlook main screen.

2 If not, choose Options from the Tools menu.

3 Select the General tab.

4 Click Add-in Manager. The Add-ins window appears.

5 Click Install. The Add-ins directory appears.

6 Select Emsuix.ecf. Click Open.  The Add-ins window reappears 
with Exchange Extensions added to the list. 
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7 Click OK to exit the Add-ins window, and OK again to exit the 
Options tab.

8 Check that Inbox Assistant and Out of Office Assistant appear 
on the Tools menu.

9 If not, quit Outlook and restart it. Check again.

NOTE:  If you install a new version of OnePoint Messenger, you 
may need to reinstall Emsuix.ecf.

To set the Out of Office Assistant:

1 From the Tools menu, choose Out of Office Assistant.

2 Type an out-of-office message in the Out of Office Assistant 
dialog. 

3 If you are ready to have Out of Office Assistant begin alerting e-
mail senders, select “I am currently out of the office.”

4 Click OK to close the Out of Office Assistant dialog.

Alternatively, you can use Web Client to configure Out of Office 
Assistant. In Web Client, click Options on the Outlook Bar.

Creating a Telephone Message Alert

In the Inbox Assistant in Outlook, you can set up automated pro-
cesses. For example, you can filter messages by subject and sender, 
deleting some types.  You can copy or move certain messages to spe-
cific subfolders, and send automated replies.

You can create a screen popup to alert you when a telephone message 
arrives.  This can be especially useful if you do not have a Message 
Waiting light on your telephone. Figure 6-4 shows a popup message 
listing several new telephone messages.
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Figure 6-4  Outlook Inbox Assistant Telephone Message Alert

To create a telephone message alert popup in Outlook 98 or 2000:

1 Choose Rules Wizard from the Tools menu on the Outlook main 
screen.

2 In the first Rules Wizard dialog window, select the “check mes-
sages when they arrive”.  Click Next.

3 Check the “with specific words in the Subject” checkbox. 

4 In the Rule description window at the bottom of the dialog, click 
the word “specific”.

5 In the dialog that appears, type “Unified Message” (“Uni-
fied Message” is what appears in the Subject field of telephone 
messages by default, except for replies or forwards of e-mail 
messages.)

6 Click Next.

7 In response to “What do you want to do with this message?”, 
check “notify me using a specific message.”

8 In the Rule Description window below, click “a specific mes-
sage”.

9 In the Notification Message dialog, type the notification message 
that you want, such as “You have a phone message.” 

10 Click OK.

11 In the Rules Wizard dialog, click Next.

12 In the Add any exceptions window, check any exceptions you 
want, such as “except where my name is in the Cc box.” Click 
Next.
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13 Under “Please specify a name for this rule”, type a name that 
reminds you what the function is, such as “phone message.” 
Click Finish.

14 Click OK. 

Where to Go from Here

• To learn how to use the Telephone User Interface (TUI), see 
Chapter 7, “Using OnePoint Messenger from a Telephone” on 
page 165.

• To learn how to test your multimedia controls, see Appendix A, 
“Tuning Your Multimedia Setup” on page 205.

• To learn about standard Windows controls, which are used with 
Outlook, see Appendix B, “Standard Windows Controls” on 
page 209.

• To find a desired topic, see the Table of Contents or the index of 
this book.
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7.   Using OnePoint Messenger 
from a Telephone

This chapter explains how to use OnePoint Messenger features with a 
telephone—calling your mailbox, sending messages to other 
OnePoint Messenger users, and setting your mailbox preferences 
through the Telephone User Interface.  This chapter also addresses 
faxing and paging.  It contains these sections: 

NOTE: This chapter does not cover Call-Me or Meet-Me, which use 
your telephone but not the telephone user interface.  For details, see 
“Choosing between Call-Me and Meet-Me” on page 78 in Chapter 3.

OnePoint Messenger 2.0 adds two features that you can use from a 
telephone:

• VPIM messaging: You can send exchange messages with users 
of other voice mail systems that conform to the VPIM protocol, 
as described in “Using Voice Profile for Internet Mail (VPIM)” 
on page 28 in Chapter 1 and “VPIM Messaging” on page 190.

• Multiple personal greetings: You can record and enable a 
choice of greetings.  For details, see “Changing your Name or 
Greeting from the TUI” on page 198 in this chapter.
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Overview of Telephone User Interface Functions

The Telephone User Interface (TUI) is the system of prompts and 
keypresses that you use when you use a telephone to call the 
OnePoint Messenger system.  Any standard touchtone telephone can 
be used with the TUI.  The TUI handles calls in these situations:

• Callers are forwarded to your mailbox when you do not answer 
your phone or you transfer them to your mailbox.

• Callers access Fax on Demand to retrieve fax documents.  For 
details, see “Using Fax on Demand” on page 150 in Chapter 5.

• Callers send faxes to fax reception numbers not attached to fax 
machines; see “Sending Faxes to a OnePoint Messenger User by 
Phone” on page 145 in Chapter 5.

• Callers reach the Automated Attendant or the Message Center 
(the “pilot number”).  See “Automated Attendant and Message 
Center” on page 166 in this chapter.

• OnePoint Messenger users call their own Exchange mailboxes to 
access messages or create intentional messages for other 
OnePoint Messenger users or to send to users on VPIM-compli-
ant voice mail systems.

• OnePoint Messenger users call other OnePoint Messenger users’ 
mailboxes to leave intentional messages.

When an unanswered call reaches the OnePoint Messenger system, 
OnePoint Messenger plays that user’s greeting, prompts the caller to 
leave a message, then sends the message to the Exchange Server for 
storage in the recipient’s mailbox.  The TUI offers several options 
while taking the message, such as to leave a fax.  For details, see 
“Making Messages from a Telephone” on page 189 in this chapter.

Automated Attendant and Message Center

The Automated Attendant (announced by the TUI as the Automated 
Receptionist) and the Message Center are similar OnePoint Messen-
ger services:

• Use the Automated Attendant to connect to the extension of a 
OnePoint Messenger user.

• Use the Message Center to connect to the mailbox of a OnePoint 
Messenger user.  Dialing a mailbox enables you to leave a mes-
sage without interrupting the recipient.
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Each service has its own phone number.  You can dial either service 
from inside or outside your organization, or reach one service from 
the other.

To access the Message Center from the Automated Attendant:

If the Automated Attendant is in service, it will answer:

“Welcome to the Automated Receptionist. Please 
enter an extension number.” 

Enter the Message Center extension.

NOTE:  If there is a live operator on duty, the Automated Attendant 
will also say:

 “or wait for assistance.”

To reach the live operator, Press [0].

To access the Automated Attendant from the Message Center:

Press [#].

After you have passed the “lobby” of the Message Center—in other 
words, you have entered a mailbox number—press [##] to access to 
Automated Attendant.

NOTE:  Depending on how your Telephony Server administrator 
configures the TUI, you can press [#] or [1] after a user’s greeting 
begins to play to interrupt the greeting so that you can leave a mes-
sage more quickly.

Note the difference in the Automated Attendant and the Message 
Center prompts to be sure you are where you want to be:

• The Automated Attendant (announced as the Automated Recep-
tionist) prompts you:

“Please enter an extension number...”

• The Message Center prompts you:

“Please enter a mailbox number....” 

When you log into your own mailbox through the Message Center, 
you have three general categories of functionality—handling incom-
ing messages, creating messages, and managing preferences.  See: 

• “Handling Incoming Messages from a Telephone” on page 183 

• “Making Messages from a Telephone” on page 189

• “Setting Telephone User Interface Options” on page 196



168 Chapter 7, Using OnePoint Messenger from a Telephone

Dial by Name

Dial by Name (DBN) is a OnePoint Messenger option for accessing a 
mailbox (or telephone, if you are at the Automated Attendant) by key-
ing in that person’s name.  You can access DBN when:

• You call the Message Center number, then use DBN to leave a 
message in another mailbox.

• You call the main number for your organization, then use DBN to 
access extensions.

• You call your mailbox and press [#] to switch to the Automated 
Attendant, then use DBN to access extensions.

In each of these situations, you are presented with a menu of options 
that may include DBN (if your organization has enabled the feature). 
DBN is useful when you do not know someone’s mailbox number. 
DBN also works with the names of distribution lists.

You have probably encountered the DBN feature before, and, in any 
case, there is a minimal learning curve.  The explanation here lets you 
know what to expect.

To access and use DBN from the Automated Attendant:

• If you have an operator on duty, your Telephony Server adminis-
trator will set the greeting to a version of

“Welcome to the Automated Attendant. Please 
enter an extension number or wait for assis-
tance.” 

Wait for the DBN prompt.

• If your organization has enabled the DBN feature, the TUI tells 
you what key sequence to dial to activate Dial by Name.  For 
example, the TUI may prompt:

“Enter 2* to dial by name.”

Press [2*] to activate DBN.

• After you press the DBN activation code, you can interrupt the 
following explanation provided by the TUI by entering the name 
of your intended recipient.  The TUI typically prompts:

“Enter the last name of the person you are call-
ing, followed by the first name. Press pound 
when finished entering name; Press zero at any 
time to exit Dial by Name”.
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{“Pound” means the #-key.}

“For the letter Q use the <key> key. For the let-
ter Z use the <key> key.”

(“<key>” is the key your OnePoint Messenger administrator 
chooses for keys to represent Q and Z.)

• As you press the keys on the telephone keypad that represent the 
name of your intended recipient, the TUI matches the letters (the 
telephone keys you press) against the names in the OnePoint 
Messenger database.  When only one name is left that matches 
the letters that you have entered, the TUI connects the mailbox, 
and the greeting plays.

• If you finish dialing the name before the TUI interrupts with a 
match, press [#].

• If you are unsure of the spelling of a name, press [#] after you 
have entered enough letters of the name so that you can get a 
short list of possibilities.

• If the TUI has more than one match, it prompts you: 

“There are <number of entries>. For <mailbox 
name>, press <a unique number>.” 

The TUI lists whatever number of matches are found (or a maxi-
mum number, depending on what your OnePoint Messenger 
administrator has configured).  It then gives you a unique number 
to enter for each one.  You can interrupt the list recitation as soon 
as you hear the number of the person you want to reach.

Example of Using Dial by Name

In this example, you are in your office and want to send a voice mes-
sage to Zubin Mehta at your organization.  You and Zubin both have 
OnePoint Messenger.  Your OnePoint Messenger system administra-
tor has set 2* as the DBN activation key sequence.

1 Dial your Message Center.  The TUI prompts “Please enter 
your password”, because your telephony administrator has set 
the PBX to recognize the phone number from which you are call-
ing as yours.  Otherwise, the prompt would be “Please enter 
a mailbox number or wait. Dial 2* to use Dial by 
Name.”
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2 You now have two choices.  You can access your mailbox and 
then create and send the intentional message, or you can dial 
Zubin’s mailbox directly.

3 To dial Zubin’s mailbox with DBN, press [2*].  The TUI prompts 
“Press the pound key to exit Dial by Name. Please 
enter the last name of the person, followed by 
the first name. Press pound when finished enter-
ing name. For the letters Q and Z, use the zero 
key.” 

4 Enter the keypad sequence for “MehtaZubin” by pressing 
[6348298246] and then [#] to signal that you are finished.  How-
ever, the TUI has probably interrupted you with an exact match. 
If the TUI finds more than one possible name for the sequence 
that you have entered, it lists each possible name, associated with 
a key to press to access that mailbox.  The TUI plays either the 
spoken name that Zubin Mehta recorded or, if he has not recorded 
a name, the TUI speaks the name typed in the Name field of his 
Exchange profile.

5 Press the key that the TUI has associated with Zubin Mehta.  The 
TUI reports the mailbox number of Zubin Mehta and plays his 
greeting.  The TUI tells you to record your message.

6 You are now on the Outside Caller menu. You can record a voice 
message and/or send a fax.  For details, see “Making Messages 
from a Telephone” on page 189.

Routing Calls in a Multi-site Organization

In a large organization, especially one with more than one office, it is 
normal practise for system administrators to set up more than one 
Exchange Server—one or more per office.  Mailbox information on 
each Exchange Server can be automatically replicated so that each 
has the global directory.  This gives you the ability to use a telephone 
to call the local Message Center and send a message to anyone in the 
directory.  For details on creating intentional messages, see “Making 
Messages from a Telephone” on page 189.  See the description of 
“Dial by Name” on page 168 for entering extensions and mailbox 
numbers.

Some system configurations allow you to call local numbers to reach 
offsite extensions.  In that case, the Dial by Name feature for the 
Automated Attendant recognizes names of offsite personnel and can 
connect you to the associated extensions.  It may also be possible, 
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then, when you are visiting another office in your organization, to log 
into your mailbox by calling the local Message Center.  If you try to 
log in to your mailbox when it is not accessible from the local Mes-
sage Center, the TUI responds “I’m sorry.  That is an invalid mailbox 
number.”

Faxing and Paging

You can set fax delivery and pager preferences through the Telephone 
User Interface (TUI).  See “Setting Advanced TUI Options (Menu I: 
Advanced Options)” on page 199 for details.  See also “OnePoint 
Messenger Fax Options” on page 125 in Chapter 5.

Learning to Use the TUI

The Telephone User Interface (TUI) is the set of menus and prompts 
that you use to access and create voice mail, and to use features such 
as Fax on Demand.  The TUI is easy to learn, because the key to press 
to invoke a command is often labelled with the first letter of the com-
mand (see the TUI menu diagram on page 174).  For example:

• “Play Message” uses [7], because [P] appears with the 7-key on 
the keypad.

• “Keep Message” is [K] (the 5-key).

• “Delete Message” (or “Discard Message”) is [D] (the 3-key).

• “Answer Message” is [A] (the 2-key).

• [AA] invokes “Answer All” (Reply to all recipients of the origi-
nal message).

The TUI provides other ease-of-use features:

• The TUI usually tells you all of the menu options for the menu 
that you are in, so you do not need to memorize anything.  At 
times, it does not do so immediately, such as after it enumerates 
your messages and says “Press P to play the first message.”  
However, if you wait, it repeats the prompt, and then lists the 
other options in the menu.

• To reach help for a menu, press [00].

• To back out to the previous menu, press [X] (for exit).

• You can type ahead one menu.  In other words, you can anticipate 
the available prompts and press the key for the option you want 
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before the TUI has completed speaking.  You can interrupt a 
greeting by pressing [#] or [1], depending on the administrator’s 
setting.

The Message Center TUI has three general functions to enable you to:

• Handle incoming messages (page 183).

• Create and send messages (page 189).

• Set preferences, such as greetings, fax number defaults, and the 
incoming message playback sequence (page 196).

The TUI menus in this section are presented in the sequence in which 
you might access them after dialing the Message Center.  The letters 
to the left of the menu headings provide an indication of the sequence 
in which you are likely to encounter each menu:

• Menu A: Incoming Call contains the three choices you have when 
you dial the Message Center (if the features are enabled).

• Menu B: Main is the first available menu after you access your 
mailbox and links you to the three main functions.

• Menu C: Play Message and Menu D: Fax Transmittal Options are 
the menus you use to get your messages.

• Menu E: Make Message, Menu F: Recipient Management, and 
Menu G: Message Addressing Options are for making messages 
from your mailbox.

• Menu H: User Options through Menu P: Pager Options manage 
user options.

• Menu Q: Outside Caller Messaging is the menu that a caller has 
when leaving a message for a OnePoint Messenger user who does 
not answer the telephone.

Scan the TUI list below to get a sense of what is available.  Then read 
the sections following the list for instructions on performing particu-
lar tasks.  Figure 7-1 shows the menu format.
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Figure 7-1  Menu Item Format Description

• The number to the left of the menu command is the key that you 
press to invoke the operation on the right.

• The highlighted underlined letter in the menu item correlates to 
the number/letter on the keypad that you should press.

• The statement in parentheses to the right of the menu command 
tells you what menu is accessed by pressing the key.

OnePoint Messenger TUI Diagram

Figure 7-2 is a diagram of the part of the OnePoint Messenger Tele-
phone User Interface (TUI) that controls access to the Message Cen-
ter.  Most of the menus are available only to a OnePoint Messenger 
user.  The “Outside Caller” menu is available to all callers.  The dia-
gram is organized by the three main functions: accessing mail from a 
user’s mailbox, creating messages, and changing personal options.

NOTE:  The behavior of both the Fax on Demand and Automated 
Attendant services is highly configuring, including prompts, greet-
ings, and menu options, including multiple nested menus, so it is not 
possible to describe the TUI for those services here.

(available from Menu A*)

6: Make Message (Go to Menu E: Make Message)

Target menu

, 
Referring menu and key pressed

Command

Key
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Figure 7-2  OnePoint Messenger Telephone User Interface
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List of TUI Menus 

There are 17 menus in the Message Center TUI, grouped by function.  
The first menu is the one that you reach by calling the Message Cen-
ter.  The following menus are those you use after you log in to your 
mailbox to get and send messages.  The next menus are those you use 
to set preferences.  The last two menus are for callers who have been 
forwarded to a another user’s mailbox in order to leave a message.

Enter the TUI in either of two ways: 

• Menu A: Incoming Call: You reach this menu when you dial the 
Message Center.

• Menu Q: Outside Caller Messaging: You reach this menu if you 
call someone who does not answer the phone.

Menu A: Incoming Call

NOTE: You reach the Incoming Call menu when you call the Mes-
sage Center.  How the TUI prompts you in this menu can vary 
greatly, depending on how the system is set up:

• Mailbox log-in prompt—If the system is set up to associate a 
call to the Message Center from a particular extension with a par-
ticular user, the TUI will say "Hello" then play the user’s name 
and prompt the user to log in.  So, if you call the Message Center 
from your own extension and want to log in, enter your passcode.  
After a successful log-in, you are at Menu B: Main.

• To access your mailbox from another phone set up this way, 
press [*] when the TUI prompts for a passcode.  When the 
TUI says "Welcome to the Message Center.  Please enter a 
mailbox number", enter your mailbox number and press [*].  
The TUI will say "Hello", play your name, and prompt you to 
enter your passcode.

NOTE:  For users who do not have physical telephone exten-
sions, this is how they would log in to their mailboxes,

Then, if you simply enter your mailbox number and forget to 
press [*], the TUI presumes you are a caller wishing to leave 
a message, so it plays your greeting and prompts you to leave 
a message.  If your greeting starts to play, you can still press 
[*].  The TUI interrupts the greeting and prompts you to enter 
your passcode.
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• To access a mailbox in which to leave a message, enter the 
mailbox number.  When the user’s greeting plays, you are at 
Menu Q: Outside Caller Messaging.

If you call the Message Center from a telephone that is not associ-
ated with a particular user, the TUI prompts you to enter a mail-
box number.

• To access your mailbox, enter your mailbox number, then 
press [*].  Enter your passcode at the prompt.

• To access another mailbox in which to leave a message, enter 
the mailbox number.

0: Operator—This option is available only if your administrator has 
enabled the link to a live operator.

#: Automated Attendant—This option is available only if your 
administrator has enabled the link to the Automated Attendant.

Menu B: Main

You reach this menu on a successful login to your mailbox from 
Menu A: Incoming Call.  The TUI enumerates your messages and 
offers to play the first one in your priority list.  You have these 
options:

6: Make Message (Go to “Menu E: Make Message”)

7: Play Message (Go to “Menu C: Play Message”)

8: User Options (Go to “Menu H: User Options”)

9: Exit Mailbox—The TUI enumerates your messages, then hangs up

0: Operator

#: Automated Attendant (You can also dial the Message Center num-
ber from the Automated Attendant.)

00: Help for this menu

Menu C: Play Message

(available from “Menu B: Main”)

2: Answer Message (press [22] for Answer All)

3: Discard Message

4: Give Message (Forward)

5: Keep Message
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6: Make Message

7: Play Message (and Replay Message)

77: Review Recipients

8: Fax Transmittal Options (Go to “Menu D: Fax Transmittal 
Options”)

9: Exit Mailbox

#: Skip Forward in the Message 5 seconds

#: Skip Back in the Message 5 seconds

8#:Skip Forward to the Next Message

8*:Skip Back to the Previous Message

0: Operator

00: Help on this menu

Menu D: Fax Transmittal Options

(available from “Menu C: Play Message”)

3: Send to Personal Default fax number

4: Input Fax Number

7: Receive Fax Online

9: Exit to previous menu

00: Help for this menu

Menu E: Make Message

(available from “Menu A: Incoming Call”)

1: Pause

2: Append to your recorded message

3: Discard and re-record your message

5: Leave a fax (“Press the Start button on your fax...”)

6: Message Addressing Options (Go to “Menu G: Message Address-
ing Options”)

7: Review your recorded message

77: Recipient Management (Go to “Menu F: Recipient Manage-
ment”)
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9: Exit to Main Menu

00: Help for this menu

Menu F: Recipient Management

(available from “Menu E: Make Message” [77])

2: Add Recipients

3: Delete Recipients

4: Add Cc Recipients

5: Add Bcc Recipients

7: Review Recipients 

9: Exit to previous menu

Menu G: Message Addressing Options

(reached from “Menu E: Make Message”)

2: Make Confidential (Press [2] again to cancel Confidential)

6: Manage Recipients

7: Request/Cancel Receipt (Press [7] again to cancel Request 
Receipt)

8: Make/Cancel Urgent (Press [8] again to cancel Make Urgent)

9: Exit

00: Help for this menu

Menu H: User Options

(available from “Menu B: Main” [8])

2: Advanced Options (Go to “Menu I: Advanced Options”)

4: Change Greeting (Go to “Menu M: Change Greeting”) 

6: Record Name (Go to “Menu L: Record Name”) 

7: Change Passcode 

9: Exit to previous menu

00: Help for this menu

Menu I: Advanced Options

(available from “Menu H: User Options”)

3: Fax Storage Options (Go to “Menu J: Fax Storage Options”)
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4: Inbox Options (Go to “Menu N: Inbox Options”)

7: Pager Options (Go to “Menu P: Pager Options”)

9: Exit to previous menu

Menu J: Fax Storage Options

(available from “Menu I: Advanced Options”)

6: Change Personal Default Fax Number (Go to “Menu K: Change 
Your Default Fax Number”)

9: Exit to previous menu 

00: Help for this menu

Menu K: Change Your Default Fax Number

(available from “Menu J: Fax Storage Options”)

2: Change Personal Default Fax Number

5: Keep Default Fax Number

9: Exit to the previous menu

00: Help for this menu

Menu L: Record Name

(available from “Menu H: User Options”)

5: Listen to name

7: Record name

9: Exit to the previous menu

Menu M: Change Greeting

(available from “Menu H: User Options”)

2: Change the Conditional greeting (goes to Menu MR)

3: Enable a greetng (goes to Menu ME)

6: Change the Out-of-Office greeting (goes to menu MR)

7: Change the Primary greeting (goes to menu MR)

9: Exit to the previous menu

Menu ME: Enable Greeting

(from menu M, choice 3, Enable a Greeting)

2: Enable the Conditional Greeting
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6: Enable the Out-of-Office Greeting

7: Enable the Primary Greeting

9: Exit to the previous menu

Menu MR: Record Greeting

(from menu M, choices 2, 6, or 7

5: Listen to greeting

7: Record greeting

9: Exit to the previous menu

Menu N: Inbox Options

(available from “Menu I: Advanced Options”)

1: Voice Messages only (See explanation for these options in “Setting 
Inbox Options (Menu N: Inbox Options)” on page 201.)

2: Voice then text messages

3: Play messages in order received

4: Text Playback Options (Go to “Menu O: Text Playback Options”)

9: Exit to previous menu

00: Help for this menu

Menu O: Text Playback Options

(available from “Menu N: Inbox Options”)

1: Play Headers Only

2: Play Message Body

9: Exit to previous menu

00: Help 

For details on the Text Playback Options menu, see “Text Playback 
Options (Menu O: Text Playback Options)” on page 202.

Menu P: Pager Options

(available from Menu I: Advanced Options) (Your administrator must 
give you pager permissions, then set your pager type and number.)

3: Disable/Enable Pager—Press [3] to toggle (enable or disable) pag-
ing.  If you enable paging, you are placed at the Enable Paging 
alert level menu:
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• Press [2] to be paged for all new voice and fax messages.

• Press [8] to be paged only for urgent messages.

• Press [X] to exit to the previous menu.

7: Review Pager configuration—The TUI announces your pager sta-
tus—enabled or disabled, and, if enabled, the level of paging.  If 
enabled, the TUI also announces your pager number.

9: Exit to previous menu

00: Help for this menu

Menu Q: Outside Caller Messaging

This menu is presented to anyone has been forwarded to voice mail in 
the OnePoint Messenger system.  It is presented to anyone who dials 
the Message Center, then enters the mailbox number of a OnePoint 
Messenger user in order to make an intentional message.

1: Pause (press [#] to resume recording)

2: Append to your recorded message

3: Discard and re-record your message

5: Leave a fax (“Press the Start button on your fax...”)

7: Review Message (your recorded message)

8: Make/cancel mark message as Urgent

9: Deliver the message and Exit the system

* (Enter your mailbox number, then press [*]) user login.

0 : Operator

00: Help for this menu

#: Automated Attendant.  The #-key has other functions, depending 
on the context:

• When you call the Message Center, press [#] to access the Auto-
mated Attendant, if the Automated Attendant is enabled.

• When you call the Automated Attendant, press [#] to access the 
Operator, if one is available.

• While recording a message, press [1] to pause the recording, then 
press [#] to continue recording.

• When you are finished recording, press [#] to stop recording.  The 
TUI repeats the Outside Caller choices.
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• While the TUI repeats the Outside Caller choices after you have 
recorded a message, press [#] to deliver the message and access 
the Automated Attendant.

Handling Incoming Messages from a Telephone

You can access your Exchange mailbox from any telephone.  The 
only messages available are in the root Inbox folder, not those you 
have moved to subfolders.  Any message that you have sent is also 
not available unless you send a copy to yourself and leave it in the 
root Inbox folder.

Message Waiting Indicator

If you have a Message Waiting Indicator (MWI) on your telephone, 
such as a light or a stutter dial tone, OnePoint Messenger turns the 
MWI on when you receive a unified message (a phone call or e-mail 
created with a Unified Message form), then turns it off after you have 
opened and saved or discarded the message.  After you use any of the 
three clients—Outlook, Web Client, or the TUI—to handle the mes-
sage, the MWI turns off.

The exception is if you listen to a message on the phone and then 
press [8#] (Skip Forward) without saving or discarding the message, 
the message is not marked as read, and MWI does not turn off.  Mark-
ing a message as unread in Outlook does not cause MWI to turn on, 
but does prevent it from being turned off until you play the message 
(and all other unread unified messages).

You can also use the Inbox Assistant in Outlook to alert you when 
you have a telephone call.  See Chapter 6, “Creating a Telephone 
Message Alert” on page 161, for details.

To access your mailbox:

Call your organization’s Message Center number (It is probably an 
extension, if you call from inside the office.) 

1 Dial the Message Center number.

2 If you call from an outside phone, the TUI prompts “Welcome 
to the Message Center. Please enter a mailbox 
number or wait (for assistance). Press 2 star to 
dial by name.” (Your administrator may disable Dial by Name 
or change its access code, or change the greeting.) Enter your 
mailbox number, followed immediately by [*].  The TUI plays 



184 Chapter 7, Using OnePoint Messenger from a Telephone

your recorded name, or, if you have not recorded your name, the 
TUI speaks the text version of your name that it finds in your 
Exchange profile.  It then asks you to enter your passcode.

If you do not press [*] immediately, your greeting plays, and you 
are prompted to leave yourself a message.  You can press [*] to 
interrupt the greeting and log in.

Alternatively, if you dial the Message Center from your office 
phone, the Message Center may be set up to assume that the 
caller is you, so the TUI plays your name, then prompts “Please 
enter your password.” 

3 Enter your passcode, then press [#] or wait for the timeout.

If Exchange is off-line, the TUI says “The system is experi-
encing technical difficulties. Please call again 
later.” 

NOTE:  This prompt also plays to callers attempting to leave mes-
sages for users when Exchange is off-line.

Accessing Your Messages from within Your Mailbox

After you log into your mailbox, the TUI announces (enumerates) 
how many messages you have of each type.

The types of messages that are announced is originally determined by 
what options are assigned to you by the administrator:

• If you are assigned “Full Unified Messaging”, the enumeration is 
in this order: total new messages, total new of each type (fax, then 
voice, then text), then total saved, then saved faxes.

• If you are assigned “Voice and Fax Only”, the TUI announces 
messages made only from a phone or with a unified message 
form.

To set what types and portions of messages play (and therefore are 
announced), see “Setting Inbox Options (Menu N: Inbox Options)” 
on page 201).

The length of the pause before the TUI enumerates your messages 
depends partly on how many new and saved messages you have in 
your main inbox.  The pause will probably be longer than that to 
which you are accustomed with standard voice mail systems, because 
the system must count both your voice and e-mail messages com-
bined in one mailbox.
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To reduce enumeration delay:

• Delete messages.

• Use Outlook to move messages to subfolders.

• Change your TUI Inbox options to play voice and fax only.

After the TUI enumerates your messages, it prompts you “Press 
[P] to play the first message.”  If you do not respond 
within a few seconds, the TUI repeats the prompt, then lists the other 
options in Menu B: Main Menu.

Menu B: Main Menu 

6: Make Message (Go to “Menu E: Make Message”)

7: Play Message (Go to “Menu C: Play Message”)

8: User Options (Go to “Menu H: User Options”)

9: Exit Mailbox 

0: Operator

#: Automated Attendant

00: Help for this menu

Message Play Order

When you press [P] (the 7-key) for Play, the message is played from 
“Menu C: Play Message”.  By default, messages play in this order:

1 Newest unread urgent to oldest unread urgent

2 Newest unread fax to oldest unread fax

3 Newest unread voice to oldest unread voice

4 Newest unread e-mail to oldest unread e-mail (if included in your 
preference list)

5 Saved messages in the above order

If there are no unread messages of one class, the TUI plays the first 
message of the next class of messages.

If a new message arrives while you are listening to messages, the TUI 
announces the new message and puts it in the queue ahead of all oth-
ers.  The next prompt that plays and the next command you enter per-
tains to the open message, not the new incoming one.  When you have 
handled the current message, the TUI plays the new message.
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To change the message playback order:

See “Setting Inbox Options (Menu N: Inbox Options)” on page 201.

Menu C: Message Playback

You reach this menu when you are on the Main menu and press [P] to 
play a message.  While the message plays, these are your control 
options: 

* If you set your text playback options to Play Headers Only (see 
“Menu O: Text Playback Options” on page175), the TUI announces 
only the sender and the message subject of a text message.  To render 
the text on the message body to speech, press [P] (Play) again.  The 
TUI renders only text in the message body.  It does not announce 
attachments other than voice or fax attachments.

**Notice in the menu list below that the 8-key by itself accesses Fax 
Transmittal Options.

NOTE:  To help you remember that the *-key means to skip back in 
the message, while the #-key means to skip forward, notice that the 
*-key is to the left (back) the 8-key on the keypad, while the
 #-key is to the right (forward) of the 8-key.

When you use the 8-key and * or # to jump to another message, the 
TUI does not mark the message as read.

After listening to the message, press:

2: Answer Message: If the message is from a OnePoint Messenger 
user, you can press this key to send an answer to that user’s mail-
box.  If the Voice Profile for Internet Mail (VPIM) service is operat-
ing, you can also press this key to replay to a message from another 
voicemail system.

Press Result

7 * Play full message if setting is Play Headers Only, or 
Replay the message.

1 Pause (stop message playing for 10 seconds or until you 
press [#] to resume; a soft beep signals five seconds)

* Skip back in the message five seconds 

8* **Go back to the previous message 

 # Skip forward in the message five seconds.

8# **Skip to the next message.
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3: Discard Message: The message moves to the Deleted Items folder 
of Outlook.

4: Forward Message: You can forward voice, fax, and e-mail to other 
OnePoint Messenger users by entering their mailbox numbers.

5: Keep Message: This option allows you to access the message again 
some other time, either from the TUI or the desktop.

6: Make Message: Create a new message to a new recipient.

7: Replay Message: Play the current message again.

77: Review Recipients: Plays the recorded names of recipients who 
are OnePoint Messenger users in the local OnePoint Messenger 
domain, and plays the text address of others.

8: Fax Transmittal Options (Go to “Menu D: Fax Transmittal 
Options” next) You can download messages to any fax machine.

9: Exit Mailbox

00: Help for this menu

0: Operator

In addition to the options in the Message Playback menu, you can 
Hang up.  The message you were listening to will remain listed as 
Unread.

If you set your text playback options to Play Headers Only (see 
“Menu O: Text Playback Options” on page 181), the TUI announces 
only the sender and the message subject of a text message.  To render 
the text on the message body to speech, press [P] (Play) again.  The 
TUI renders only text in the message body.  It does not announce 
attachments other than voice or fax attachments.

After you handle the message (discard, keep, forward, etc.), or if you 
skip the message, the TUI plays the next message in the queue.  When 
no unread messages remain, the TUI opens the most recent urgent 
saved message, and so forth, until there are no remaining saved mes-
sages to read, or you switch to the Make Message or User Options 
menus.

To stop the message playback:

Before the next message begins to play, you are in the Main menu. 
The menu options in the Main menu are the same as in the Message 
Playback menu, except for User Options (press [8]).
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If you skip the message, the message is kept as Unread, but is not 
played again.  This is useful if you want to call in again later to hear 
the message early in the queue or if you want to see it listed as Unread 
when you open your mailbox on your desktop.

To keep the current message in the Unread queue:

• Hang up

• Press [8#] to skip to the next message.

• Press [8*] to jump back to the previous message (if any).

• In Outlook, change the message status to Unread (select the mes-
sage, then select Unread

Menu D: Fax Transmittal Options

While in Menu C: Message Playback, to forward a text or fax mes-
sage to a fax machine, press [8] to enter this Fax Transmittal 
Options menu.

3: Send to personal Default fax number: This is the fax number 
entered in your Exchange user profile.  You can change this number 
by exiting to the User Options menu, then choosing Advanced 
Options, then Fax Storage Options.

4: Input Fax Number: You can enter any fax machine phone number 
here.  It can be another person’s fax number, but the cover sheet 
will list you as the recipient.

7: Receive Fax Online: “Online” means the phone from which you 
are calling.

9: Exit this menu.

00: Help for this menu
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Making Messages from a Telephone

Of course, the conventional way of leaving a message for someone is 
to call that person, then leave a message in his mailbox if he does not 
answer.

Call-back phone number: A new feature in OnePoint Messenger 2.0 
is an editable calling line information (CLI).  Normally, OnePoint 
Messenger displays the phone number from which the call is made in 
the Subject field of the message.  You as the caller may want another 
telephone number to appear there, typically when you are not calling 
from your office phone.  After you have recorded your message, the 
TUI offers you the chance to enter the other number.

In addition to simply calling someone’s telephone number and being 
routed to voice mail, there are several ways to send a telephone mes-
sage.  All involve calling the Message Center.

• From the Message Center, dial the mailbox number (or use DBN) 
of your intended message recipient, as described next.  You are in 
Menu Q: Outside Caller Messaging.  You can leave a voice and/
or a fax message.

• Log in to your mailbox, then create, address, and send the mes-
sage.  You can leave both a voice and fax message.  See “Making 
Messages from Your Mailbox” on page 191.

• Log in to your mailbox, then reply to or forward an incoming 
message from a OnePoint Messenger user or other VPIM-compli-
ant voice mail system.  In addition to forwarding all kinds of 
attachments, you can add voice and fax attachments.

• Log in to your mailbox, then route a message in your Inbox to 
your recipient’s fax machine.  See “Sending Faxes to a OnePoint 
Messenger User by Phone” on page 145 in Chapter 5.

To dial a person’s mailbox:

1 Call the Message Center number.

2 The TUI prompts you to enter a mailbox number.  Usually your 
Exchange administrator uses phone extensions as the basis for 
mailbox numbers, so you can dial a mailbox by entering the same 
number as the extension.

or

If Dial by Name is available, the TUI tells you what keys to press 
to access it.
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3 After dialing the person’s mailbox number (or using DBN to 
access it), the person’s greeting plays.  The TUI then prompts you 
to leave a message, and puts you on the Outside Caller Messag-
ing menu.

VPIM Messaging

You can create and send an intentional message to the voice mailbox 
of someone who uses a different voice mail system, which we call 
VPIM (see “Using Voice Profile for Internet Mail (VPIM)” on 
page 28 in Chapter 1.) 

On the telephone, it would be pretty difficult to enter the full address 
required by the VPIM protocol, so OnePoint Messenger allows the 
Telephony Server administrator to set a dialing prefix (the default is 
3) that you can press to signal the Telephony Server when you are 
about to enter a VPIM address.  Then, you simply enter the telephone 
number of your recipient, and your message is sent to the remote 
mailbox.

For example, if your VPIM access prefix is 3 and your recipient is in 
your area code at 555-1234, you would press [6] in the Main TUI 
menu, followed by 5551234.  Then record and send your message as 
you would any other intentional message.

If your Exchange Administrator sets up a routing mailbox to a person 
on another voice mail system, so you can use Dial by Name to enter 
that person’s VPIM address.

Menu Q: Outside Caller Messaging

The menu keys and associated commands in this menu are:

1: Pause the recording process.

2: Append to your recorded message.

3: Discard and re-record your message.

5: Leave a fax—The TUI prompts “Press the Start button on 
your fax...”

7: Review your recorded message.

8: Mark the message urgent.

9: Deliver the message and exit the system.

#: The #-key has different functions depending on context:
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• When you dial the Message Center, press [#] to access the 
Automated Attendant.

• While making a message, press [#] to stop recording and 
return to the menu.

• Pressing [#] again delivers the message and accesses the 
Automated Attendant.

*: The *-key has several functions:

• When you dial the Message Center, you can enter a mailbox 
number followed by [*] to log in to that mailbox.

• While leaving a message for someone, the *-key has the same 
function as the #-key: press [*] to stop recording and return to 
the menu.

• If you are at your office phone while leaving a message for 
another user, press the *-key again to send the message and 
access your own mailbox login.

0: Operator.  After completing your message and returning to the 
menu, the TUI prompts “Press 0 to deliver the message 
and return to the attendant.” If there is no operator avail-
able, the TUI says “I'm sorry. There is no attendant 
available. Goodbye.”

00: Help for this menu

Making Messages from Your Mailbox

When you call your own mailbox, you have several ways to create 
and send messages:

• Press [#] to access the Automated Attendant from the Main menu 
or the Play Message menu and dial a OnePoint Messenger user’s 
phone.  If the person does not answer, you are routed to voice 
mail at Menu Q: Outside Caller Messaging.

• From the Main menu of your Inbox, you can enter a user’s mail-
box number to record a message in that person’s Inbox.  You are 
routed to voice mail at Menu Q: Outside Caller Messaging.

• When you play your incoming messages, you can press [A] to 
answer the message, [AA] to Answer All, or [4] to forward the 
message.  The caller must be calling from a telephone associated 
with a mailbox on your Exchange Server.  To enable you to use a 
telephone to reply to a user of another VPIM-compliant voice 
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mail system (see “Using Voice Profile for Internet Mail (VPIM)” 
on page 28), your Exchange administrator must create a mailbox 
for that caller that routes your message to the caller’s mailbox on 
his or her own voice mail system.

• From Menu B: Main or Menu C: Message Playback, you can 
press [6] to make a new message on Menu E: Make Message.

To make a message on the Make Message menu:

1 Press [6] from either the Main menu or the Play Message menu.

NOTE: When you log in to your mailbox and enter your pass-
code, you can access the Make Message menu by pressing [6] 
even before the TUI has responded to your passcode.  Wait a few 
seconds after entering your passcode before pressing [6] so that 
the TUI does not interpret “6” as part of your passcode entry.

2 The TUI prompts you to enter the mailbox number of the person 
to whom you want to send the message.  After you enter the num-
ber, press [#] or wait for the TUI to prompt you “Please enter 
another mailbox number.”

If you pause after entering a recipient, a secondary menu allows 
you to delete the recipient from the list.

3 You can enter as many recipients as you want, including a num-
ber for a distribution list.  To enter a VPIM address, enter the 
Exchange routing mailbox number associated with your VPIM 
addressee.

Press [#] after each mailbox number, then press [#] again when 
you are finished.

If you enter a number that is already in the list, the TUI says 
“Already in list.”

4 When you have concluded entering addresses, the TUI prompts 
“Record a message at the tone.” Record your message 
after the beep.

5 After you make the message, you can press [#] to access the 
options in Menu E: Make Message—append, delete and re-
record, set delivery options (request receipt, set confidential, set 
urgent), or add a fax.

6 To cancel the message, press [D] for Delete, then hang up.
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7 To review or edit your delivery list, press [77] to access Menu F: 
Recipient Management.  You can also do this before you record 
your message.

8 To send the message, hang up, or to send and then return to the 
Main menu, press [#].

Menu E: Make Message

Available from Menu A: Incoming Call, the Make Message menu is 
almost the same as Menu Q: Outside Caller Messaging, shown above.  
Two options here are not on the Outside Caller Messaging menu—
Message Addressing Options (Menu G) and Recipient Management 
(Menu F), both shown below.

1: Pause your recording.

2: Append to your recorded message.

3: Discard and re-record your message.

5: Leave a fax.

6: Message Addressing Options (Go to “Message Addressing Options 
(Menu G)” below)

7: Review your recorded message

77: Recipient Management (Go to “Menu F: Recipient Management” 
below)

9: Exit to Main menu

00: Help for this menu

If you press [3] and hang up, your message is cancelled.  Alterna-
tively, you can just hang up to deliver it.

Message Addressing Options (Menu G)

Reached from “Menu E: Make Message”, the keys and associated 
commands in this menu are:

2: Make Confidential (Press [2] again to cancel Confidential)

7: Request Receipt (Press [7] again to cancel Request Receipt)

8: Make Urgent (Press [8] again to cancel Make Urgent)

9: Exit

00: Help for this menu
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Use the Message Addressing Options menu to set Confidential or 
Urgent flags on your outgoing message.  When you choose Request 
Receipt, the receiving server notes when the recipient has opened 
your message, and sends you a confirming notice.  You can select and 
then deselect any of these options by pressing the same key again.

After you set flags on the Message Addressing Options menu, return 
to the Make Message menu.  You can edit the recipient list, as shown 
below, or press [9] (the X-key) to exit the menu and return to the 
Main menu.  Exiting the Make Message menu sends the message.

To edit the recipient list for your outgoing message, press [77] from 
the Make Message menu to access the Recipient Management 
menu.

Recipient Management (Menu F)

Press [77] to access from Menu E.  The keys and associated com-
mands in this menu are:

2: Add Recipients

3: Delete Recipients

4: Add Cc Recipients

5: Add Bcc Recipients

7: Review Recipients 

9: Exit to previous menu

When you are finished working with the Recipient Management 
menu, press [9] to return to the Make Message menu.  When you are 
ready to send the message, press [9] (the X-key) to exit the menu 
return to the Main menu.  Exiting the Make Message menu sends the 
message.

Responding to a Message to You

In addition to calling someone directly, you can respond to messages 
with intentional messages.

1 After listening to a message, press either [A] (Answer the sender) 
or press [A] twice (Answer All) to send your answer to the sender 
and all recipients of the sender’s message.

2 Both the Answer and the Answer All commands access Menu E: 
Make Message, described above, on which you can record, re-
record, append, add a fax, review/revise the recipient list, and set 
the delivery priority and confidentiality.
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Sending Messages to Distribution Lists

Using the TUI, follow the same procedure to send a message to more 
than one person as you use for one person.  You have two ways to cre-
ate a recipient list:

• Add recipients one by one to the recipient list.  You can add both 
OnePoint Messenger users and VPIM addressees to the same list.

• Enter the number of a distribution list your Exchange administra-
tor has created (you cannot use distribution lists from your per-
sonal address book.)

You can create a recipient list that combines individuals and distribu-
tion lists.  In either case, you can use Dial by Name (DBN).  For 
example, if your Exchange administrator has created a distribution 
list named “Sales”, you would access DBN (page 168), then press the 
letters for “Sales.”

No matter how you create the recipient list, you follow the same pro-
cedure that you use to create and send a message to an individual.  
You can even forward e-mail messages that include attachments to 
distribution lists.

Before you begin to create your message, the TUI prompts you to 
enter one or more mailbox numbers to which to address your mes-
sage.  You can then make your message, and then press [77] to go to 
the Recipient Management menu to edit the recipient list.  You can 
review the list, and add or delete To, Cc, and Bcc recipients.  Your 
recipients can include distribution lists created by the Exchange 
Administrator.

Record your message, then press [#] to send the message, just as you 
would for an individual.  OnePoint Messenger automatically distrib-
utes the message to the individual mailboxes of the group.

One of the benefits of creating an intentional message is this ability to 
send the message to more than one person at the same time.  Another 
benefit is that the message you send is saved in your Sent Messages 
folder, so you have a record of to whom your voice message went, 
when you sent the message, and the subject.
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Setting Telephone User Interface Options

You can set several Telephone User Interface (TUI) preferences from 
the TUI.  You can set your:

• Greetings and name (record greetings and name and select your 
active greeting): See “Changing your Name or Greeting from the 
TUI” on page 198 and “Menu H: User Options” on page 179.

• Default fax number: See “Setting Fax Options” on page 199 and 
“Menu I: Advanced Options” on page 179.

• Message playback options (message order and text access 
level): See “Menu N: Inbox Options” on page 181.

• Passcode: See “Changing your Telephone Passcode from the 
TUI” on page 197 and  “Menu H: User Options” on page 179.

• Pager (on/off and alert level): See “Setting Pager Options” on 
page 199 and “Menu I: Advanced Options”.

Your systems administrator must set your basic level of access to uni-
fied messaging and then set feature levels within those basic usage 
categories, as described in “Setting OnePoint Messenger User 
Options” on page 34 in Chapter 1.  TUI settings that your systems 
administrator must enter include:

• Whether to play the TUI tutorial the first time you log in to your 
mailbox from a telephone

• The language you want your mailbox prompts to use and the lan-
guage used by the system outside your mailbox

• Your pager type and number

Set preferences by progressing through the following menu tree, as 
described here and shown in Figure 7-2.

1 From Menu B: Main, press [8] Menu H: User Options.

2 From Menu H: User Options, to change:

• Fax, Inbox, and pager options, press [2] (Menu I: Advanced 
Options).  See “Setting Advanced TUI Options (Menu I: 
Advanced Options)” on page 199.

• Your greeting, press [4] (Menu M: Change Greeting).

• Your spoken name, press [6] (Menu L: Record Name).

• Your passcode, press [7].
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If you select a menu option, and the TUI responds “I'm sorry. 
You do not have authorization to access this fea-
ture”, it means that the administrator has not enabled the option for 
you.  The blocked access is can occur in the paging, text access, and 
faxing options.

For each preference, when you change the preference, the TUI either 
immediately reports to you the new setting or offers you a menu 
choice that affords you the chance to hear the new setting.  In some 
menus, the TUI reports to you the current setting as soon as you 
choose the menu.  For any change that you make, the change is imme-
diate.  For example, if you change the TTS level from Headers Only 
to Headers and Message Body, then go to the Play Message menu, the 
TUI will use the new preference, speaking the full message.

Changing your Telephone Passcode from the TUI

In setting up your mailbox in Microsoft Exchange, your Exchange 
administrator enters a telephone passcode for you that you use the 
first time you call your mailbox.  Your Exchange administrator can 
also invoke a tutorial that, when you first log in, guides you through 
changing your passcode and recording your name and greeting.

To change your telephone passcode, you can do so from Outlook or a 
telephone.  When you do so from a telephone, you must first enter 
your current passcode to access your mailbox, a sort of Catch-22 if 
you have forgotten it.  If you forget your passcode, use Outlook to 
change it (see “Changing your Telephone Passcode” on page 159 in 
Chapter 6), or ask your Exchange administrator to reset it to the 
default passcode.

To set your passcode:

1 In the User Options menu, press [7].  The TUI prompts you to 
enter from one to ten digits for your passcode.

These key combinations are not allowed:

• A passcode that is the same as the mailbox number.

• A passcode in either of these sequences: 123456 or 654321

• A passcode that is all the same number, such as 2222 or 3333

The administrator may also set a minimum and maximum pass-
code length.

2 After entering the new passcode, wait for a timeout or press [#].
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3 Press [X] (the 9-key) to return to the previous menu.

NOTE:  For information on changing your passcode from Outlook, 
see “Changing your Telephone Passcode” on page 159.

Changing your Name or Greeting from the TUI

You can use the TUI or Outlook to record your name (as spoken to 
announce your mailbox) or greetings, or enable a different greeting. 
For an explanation of the types of greetings, see “Greetings Over-
view” on page 154 in Chapter 6.

To record or enable a new greeting:

1 From the Main menu, press 8 for Menu H, User Options (“Menu 
H: User Options” on page 179).

2 On the User Options menu, press 4 to reach Menu M (see “Menu 
M: Change Greeting” on page 180)

3 On Menu M, press: 

• 2 to change your Conditional greeting, which includes both 
the Busy Greeting and the Ring-No-Answer Greeting

• 6 to the change your Out-of-Office greeting

• 7 to change your Primary greeting.

Each greeting can be up to two minutes long.

If a greeting that you re-record is already enabled, you do not 
need to enable it again for the changed greeting to take effect.

4 To enable a new greeting type (e.g., to switch from Primary to 
Conditional), first be sure you have recorded the greeting to 
which you are switching, then press 3 in Menu M.

5 On the Enable Greeting menu (Menu ME), press 2 to enable the 
Conditional greeting, 6 to enable the Out-of-Office greeting, or 7 
to enable the Primary greeting.

To record your name:

NOTE:  In addtion to being able to record your name from Outlook, 
typically the TUI tutorial runs and has you record your name when 
you first call into your mailbox.

1 From the Main menu, press 8 for Menu H, User Options (“Menu 
H: User Options” on page 179).
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2 On the User Options menu, press 6 to reach Menu L (see “Menu 
L: Record Name” on page 180).

3 In the Change Name menu,  press 5 to listen to your currently 
recorded name.  Press 7 to record your name.  Your name record-
ing can be up to 10 seconds long.

4 Press 9 to return to the User Options menu, and 9 again to return 
to the Main menu.

Setting Advanced TUI Options (Menu I: Advanced 
Options)

To reach the Advanced Options menu, press [2] on “Menu H: User 
Options”.  The menu gives you access to menus for changing your 
fax, pager, and Inbox options:

3: Fax Storage Options (Go to “Menu J: Fax Storage Options” on 
page 180): Change your personal default fax number.

4: Inbox Options (Go to “Menu N: Inbox Options” on page 181): (see 
below)

7: Pager Options (Go to “Menu P: Pager Options” on page 181): 
Change and test your pager number.

9: Exit to previous menu

Setting Fax Options

The Fax Storage Options menu allows you to choose your default fax 
number, to which, if enabled, you can quickly download e-mail and 
faxes that are sent to you.  Press [3] in the Advanced Options menu 
(above) to reach this menu.

When you are listening to incoming messages and want to download 
a message to a fax machine, press [6] in the Play Message menu to 
access the Fax Transmittal Options menu (see “Menu D: Fax Trans-
mittal Options” on page 188.)

Setting Pager Options

OnePoint Messenger can alert your pager when you receive a unified 
message (a telephone call or an e-mail that uses the unified message 
form).  OnePoint Messenger supports several types of paging, includ-
ing direct access, PIN access, and e-mail pagers.  Your Exchange 
administrator must set your pager type, pager phone number, and 
access code (if there is one).
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Your Exchange administrator chooses the default paging level from:

• All unified messages

• Only unified messages marked Urgent 

• No paging

If your Exchange Administrator has enabled paging for you, you can 
use the TUI to change the paging level.

To edit your paging preferences:

1 Call the Message Center and open your mailbox.

2 From the Main menu, press [8] for Menu H: User Options.

3 Press [2] for Menu I: Advanced Options.

4 Press [7] for Menu P: Pager Options.

5 Press [3] to toggle Enable/Disable paging.  If you enable paging, 
the TUI then prompts you to enter the message alert level that you 
want.

• Press [2] for All unified messages.

• Press [8] for Urgent unified messages only.

Or, press [X] to cancel and exit to Menu P: Pager Options.

6 In Menu P: Pager Options, press [7] to review the pager setting.  
The TUI announces your pager status—enabled or disabled—and 
the level of paging and your pager number.  If the Exchange 
administrator has not entered your pager number, the TUI 
announces that your pager number is “oh-oh-oh”.  In that case, 
setting your paging level has no effect.

7 Press [9] to return to each previous menu.

Message Delivery Paging

Message delivery paging is not a call to a pager but an automated 
voice alert to a telephone that you use away from the office.  Your 
Exchange administrator enters the number in your profile, so that 
when a message arrives in your Inbox that conforms to your paging 
alert level preference, the TUI calls you on your designated telephone 
and, when you answer, gives you three choices:

• Play message: The system will prompt you to log in to your mail-
box.
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• Call back: Have the TUI call back in 30 minutes.

• Wrong number: Whoever receives the call indicates that the 
alert has been sent to the wrong number.  The TUI disables pag-
ing for you and reports an error.  Your administrator will note the 
error and verify your alert telephone number.

Message delivery is especially valuable if you want to be alerted on a 
cell phone when you are on the road.

Setting Inbox Options (Menu N: Inbox Options)

To reach the Inbox Options menu:

1 Press [8] on “Menu B: Main”.  Menu H: User Options plays.

2 Press [2].  “Menu I: Advanced Options” plays.

3 Press [4].  “Menu N: Inbox Options” plays.

The Inbox Options menu allows you to choose the order in which 
your messages play through the TUI, and to reach the menu that con-
trols how much of each message to play:

1: Voice Messages Only—If your Exchange profile is set to “Full 
Unified Messaging”, and there is a Text-to-Speech resource avail-
able, both the voice and text components of unified messages play, 
but text e-mail messages do not play.  You have access through a 
fax machine to fax attachments and text on the message body.

If your profile is set to “Voice and Fax Mail” only, just the voice 
content in unified messages play.  You have access through a fax 
machine only to fax attachments.

2: Voice then Text Messages—This option is available only if you 
have Full Unified Messaging.  As with the previous option, a 
“voice” message in this context means all unified messages”—in 
other words, phone messages or e-mail messages made with the 
New Unified Message form.  “Text messages” are messages not 
made with the New Unified Message form.

3: Play messages in order received

4: Text Playback Options (shown below)

9: Exit to previous menu

00: Help for this menu
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The second and third options on the Inbox Options menu allow you 
to specify the order in which you want voice and text messages to 
play. These options are only relevant to you if two conditions are true:

• Your organization has its OnePoint Messenger Telephony Server 
set up to convert e-mail text to voice using Text-to-Speech.  If 
not, the TUI announces for a text message that you try to play:

“I'm sorry, there are no e-mail reading resources 
available.”

• Your Exchange administrator gave you the Text-to-Speech 
option in your profile.  If not, the TUI announces for a text mes-
sage that you try to play:

“This message has text components that cannot be 
played, because you do not have text reading privi-
leges.”

If either of the two conditions are not true, choosing any one of the 
three options will have the same effect—only voice messages play.

Text Playback Options (Menu O: Text Playback 
Options)

You reach the Text Playback Options menu by pressing [4] in 
“Menu N: Inbox Options”. The Text Playback Options menu contains 

1: Play Headers Only

2: Play Message Body

9: Exit to previous menu

00: Help for this menu

On the Text Playback Options menu, you choose how much of the 
text portions of the message to convert to speech through the Text-to-
Speech converter—only the message header or all of the e-mail text. 
Other kinds of attachments are not rendered by the TUI, but you are 
told when the message has an attachment.

Text will not be converted to speech if:

• You do not have text-to-speech access and the Full Unified Mes-
saging option.

• When all text-to-speech resources on the Telephony Server are 
temporarily in use.  In that case, and you have the text-to-speech 
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option and preferences set, the TUI says that there are no 
resources currently available to read your message.

If you press [2] for Play Headers Only, the TUI announces the 
sender and subject, as it does for Play Message Body.  What happens 
next depends on whether the message contains voice or text.  If it con-
tains voice and text, the TUI plays both the voice and text compo-
nents.  If the message contains only text, the TUI says “end of 
message.”

To have the TUI render the text to speech:

When you have your text options set to Play Headers Only, and the 
TUI announces only the header, press [P] twice.

Where to Go from Here

• To learn how to test your multimedia controls, see Appendix A, 
“Tuning Your Multimedia Setup” on page 205.

• To learn about standard Windows controls, see Appendix B, 
“Standard Windows Controls” on page 209.

• To find a desired topic, see the Table of Contents or the index of 
this book.

In addition to this guide, see the OnePoint Messenger online help for 
Outlook and Unified Fax Printer, as described in “Getting Online 
Help” on page 62 in Chapter 3.  OnePoint Messenger online help for 
Web Client is available as downloaded HTML pages from the Web 
Client Help button on the Web Client toolbar.
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A.   Tuning Your Multimedia Setup

This appendix gives tips on testing and adjusting your PC speaker 
volume by using the Windows Media Player and Volume Control util-
ities.  It contains two sections.

Testing Your PC Sound Setup and Volume Levels

Make sure your sound card and the volume controls are set up prop-
erly.  Refer to your sound card documentation for instructions about 
how to set up your sound card.

Test the volume controls on your speakers to assure that they are 
active.  Typically, speakers have a light that indicates if the speakers 
are getting power.  If the light is not on, check the On/Off button and 
the power connection.

You can test your sound system installation and volume controls by 
playing one of the sound files included with Windows through Media 
Player

To test sound levels in Media Player:

1. On your speakers, turn the volume control knob down.

2. From the Windows Start button, choose Programs, then Acces-
sories, Multimedia, and Windows Media Player.

3. Repeat the sequence to start Volume Control.

4. In Windows Media Player, from the File menu, choose Open.

5. Browse the directory tree for a “.wav” system sound file such as 
“The Microsoft Sound.wav” typically in the \\Windows\Media 
directory.

6. Click Play.

7. Use the physical speaker volume control and the software volume 
controls in Windows Media Player and Volume Control to adjust 
the sound level, balance, and quality.
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Both Media Player and Volume Control have many options that you 
can learn about through their online help.

Setting Playback and Recording Volumes

First test the controls on your speakers by using a sound file, as 
described above.  If you have a volume control knob on your speak-
ers, using that knob is probably the easiest way to set playback vol-
umes.  With the physical speaker volume control set at mid-range, use 
the Windows Volume Control utility to adjust volume and balance for 
various sound file types.  Then, when you receive a voice attachment 
that is abnormally above or below the standard decibel level, you can 
quickly adjust the sound level up or down with the speaker volume 
control knob.

To adjust playback sound volume:

1. If you have a volume control knob on your speakers, turn it to the 
midpoint.

2. From the Windows Start button, choose Programs, then Acces-
sories, Multimedia, and Volume Control.

3. From the Options menu, choose Properties, then select Play-
back in the “Adjust Volume for” group.

4. Select the appropriate devices in the “Show the following volume 
controls” field.  For OnePoint Messenger, select Volume Con-
trol.

5. Click OK.  The Volume Control panel appears.

6. Move the slider up in Volume Control to increase sound levels.  
If the Mute All box is checked, deselect it.

7. To change the balance between the left and right speakers, drag 
the Balance slider.

8. To close Volume Control, choose Exit from the Options menu.

Of course, to set the recording level, the easiest thing you can do is to 
speak more loudly or softly or move the microphone closer or farther 
away.  You can also adjust the recording level in software.

To adjust the recording level on your microphone:

1. Open Volume Control, as described above.
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2. From the Options menu, choose Properties, then select Record-
ing in the “Adjust Volume for” group.

3. Select the appropriate devices in the “Show the following volume 
controls” field.  For OnePoint Messenger, select Microphone.

4. Set volume levels by dragging the slider.

5. To close Volume Control, choose Exit from the Options menu.

Troubleshooting Playback

If audio plays from your internal speakers rather than external ones, 
you might have a device auto-sense problem that simply requires 
rebooting the system so that your external speakers can be detected.  
If that does not work, select the appropriate audio device in the Mul-
timedia applet in Control Panel, as shown in Figure A-1.

Figure A-1  Control Panel, Multimedia Properties

Troubleshooting Recording

If you cannot record a message using the OnePoint Messenger 
recorder when using a microphone, first raise the recording and play-
back levels, as described above.  When recording, look at the micro-
phone recording level indicator on the recorder control bar.  It should 
display green lines high in the indicator.  A red line displayed at the 
top indicates distortion. 
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You can isolate the source of the problem by creating a test recording 
with Windows Sound Recorder.  Start Sound Recorder from the same 
Multimedia program group as Volume Control, above.  If your micro-
phone does not work with Sound Recorder either, suspect a hardware 
problem.  Check the physical connection of the microphone to the 
sound card.  If possible, test another microphone on your PC.

OnePoint Messenger provides the Call-Me/Meet-Me telephone alter-
native to recording with a microphone.  For details, see “Using Call-
Me and Meet-Me” on page 79 in Chapter 3.  If you cannot make a 
recording by using the Call-Me/Meet-Me telephone alternative, rein-
stall the OnePoint Messenger Outlook client.
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B.   Standard Windows Controls

This appendix describes parts of Outlook and OnePoint Messenger 
that are standard Windows controls.  You can skip this appendix if 
you are familiar with Windows.  It contains these two sections:

Windows Controls

All windows contain sizing controls at the top left, top right, right 
side, bottom, and bottom right.  The top right corner contains three 
controls—Minimize (dash), Close (X), and a middle button that 
alternates between Maximize and Restore (restore to the window 
size that you set) depending on which state it is currently.

To resize the window:

1. Click Restore.

2. Place the mouse over the edge of the screen until the cursor 
changes to double arrows.

3. Drag the edge of the screen to the size you want.  Dragging the 
bottom right corner allows you to resize in two directions at once.

Scrolling

If a window contains more information than will fit on the window 
vertically, a scroll bar appears on the right edge.  When there is too 
much information to fit on the screen horizontally, a scroll bar 
appears at the bottom of the window.  For example, using Outlook, if 
your message list contains more messages than will fit on your 
screen, use the scroll bar or press the up arrow or down arrow on the 
keyboard to find the desired message.

Section Page

Windows Controls 209

Title Bar, Menu Bar, and Toolbar 210

Using Windows WinHelp for Online Help 212
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Title Bar, Menu Bar, and Toolbar

The title bar initially displays the application name.  Outlook displays 
"Microsoft Outlook" followed by the name of the open folder, such as 
the Inbox, which is automatically displayed at startup, unless you set 
your preference for a different folder.  The title bar changes, however, 
as you work within the application.  For example, when you select 
another folder in Outlook, the title bar will display the name of that 
folder.  When you reduce the Inbox, by tiling or cascading your Inbox 
and folders, the title bar no longer displays any folder name, only 
Outlook.

The menu bar lists the menus available in Outlook.  The menus listed 
on the menu bar contain commands that let you perform actions or set 
preferences.

The toolbar consists of various buttons, which are small symbols that 
are used as shortcuts for executing commands.

All the commands that are available by using the buttons in the Out-
look toolbar are also available from the Outlook menus.

Using Toolbar Buttons

Use the buttons on the toolbar as an alternative to using menus or key 
equivalents to display windows or choose commands.

To use a toolbar button, select the desired button.  To view what a par-
ticular toolbar button does, place the cursor over the button and read 
the ToolTip description that appears.

Status Bar

The status bar at the bottom of the application window tells how 
many items there are in the current view.

Control Menu

The button at the left end of the Outlook title bar invokes the window 
Control menu.  The Control menu contains the commands used to 
move, resize, or close the Outlook application window or to switch 
between windows.

Other Outlook/OnePoint Messenger windows and dialog boxes also 
have a Control Menu button to let you display commands used to 
move or close the active window.
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To access the Control menu:

Click the Control menu button or press Alt+spacebar.  Keyboard 
commands are especially useful when the title bar or other borders are 
not visible.

Restore, Maximize, and Minimize Boxes

When Outlook starts, the Outlook window appears in the same place 
and at the same size that it was when you closed Outlook.  The default 
folder is displayed, which, unless you change it, is the Inbox.  When 
you open a message, the window is the size of the last message win-
dow that you had open.

To enlarge a window to the full size of the screen:

Click the middle button on the top right of the title bar, as shown here.

Alternatively, open the Control menu, as described above, then 
choose Maximize, either with the left mouse button or with the down 
arrow and Enter key on the keyboard.

The left button of the three is Minimize, which reduces the window to 
its title bar at the bottom of the screen or application window.

The "x" button on the right closes the window or application.

When the window is at full size, the buttons change, as shown here.

To restore the window from full size to the previous size:

Click the middle button.

Displaying Menus

To display the commands on a menu:

Select the menu name with the left mouse button 

or:

1. Press and release [Alt] or [F10] to activate the menu bar.

2. Press the left arrow or right arrow until the desired menu is high-
lighted.

3. Press [Enter] or the down arrow to highlight a menu item.

For example, you can display the commands in the OnePoint Messen-
ger application window’s Control menu by either clicking on its Con-
trol Menu icon or by pressing [Alt], the [left arrow], and then [Enter].
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To close the menu and remain in the menu bar:

Press [Esc] or click the menu name.

To close the menu and return to the workspace:

Press [Esc] twice, or press [Alt] or [F10].

Choosing Commands from Menus

Like most Windows applications, the Outlook and OnePoint 
Messenger commands may or may not be available and may operate 
differently in different contexts.  Commands that are not available 
appear dimmed.

To choose a command or menu item from a menu:

1. Select the menu with the mouse or [Alt] key, as above.

2. Type the underlined letter in the command or item name

or

• Press the up arrow or down arrow until the item you want is high-
lighted.

3. Press [Enter].

Moving Around in Dialog Boxes

A dialog box, usually simply called a dialog in this guide, is a win-
dow that opens as a subsidiary window to the main screen.  It does not 
have pulldown menus.  Instead, it has radio buttons and check boxes 
to make selections, and edit boxes where you type text.

To move between fields in a dialog box:

Use the mouse to move the cursor to the text box you want and click 
the left mouse button.

or

Press [Tab] repeatedly until the cursor is in the text box you want.

or

Press [Shift]+[Tab] to move backward in the dialog box.

Using Windows WinHelp for Online Help

To get help for Outlook and OnePoint Messenger, you can press [F1] 
in Outlook to reach the Outlook Assistant, or choose an option from 
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the Help menu on the main or message form screens.  The Outlook 
Help menu contains six options, as shown in Figure B-1.

Figure B-1  Outlook Help Menu

• Microsoft Outlook Help is the Outlook Assistant.

• Unified Messaging Help provides help for the OnePoint 
Messenger components, such as unified messaging buttons, 
Unified Fax Printer, and QuickPick.

• Contents and Index provides the Outlook Help contents.

• What’s This? Choose this menu item and then click a button 
or menu item in Outlook to get augmented ToolTips, includ-
ing those for OnePoint Messenger additions.

• Microsoft on the Web provides Web links to Outlook infor-
mation on the Microsoft website.

• About Microsoft Outlook provides version level, licensing, 
system information, and Technical Support links.

To get help for OnePoint Messenger using the Outlook Help 
menu:

1. From the Outlook Help menu, choose Unified Messaging Help. 
There are three tabs—Contents, Index, and Find.  Index 
displays a list of topics, shown in Figure B-2.

2. To find help for a topic you want, type search words in the top 
field of the Index tab, or scroll either the Contents or Index lists.

3. To open the topic, double-click the topic item in the list, or select 
(click) the topic, then click Display.

4. To return to the Help Contents window, click Help Topics.

or

Click Back to return to the last topic detail page that you viewed.
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5. To return to the application, choose Exit from the File menu of 
the topic detail window.

or

Click Cancel in the Help Index or Contents lists.

Figure B-2  Help Index

The Find tab allows you to build a detailed word index of the Help 
document.  Use the Find tab if you cannot find what you need by 
using the Contents or Index tabs.
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